
Manuals for This Printer

G058-8600  Printed in Japan

UE    USA

GB     EE

The following manuals describe the operational procedures and maintenance of this machine.
 To ensure safe and efficient operation of this printer, all users should read and follow the instructions
carefully.

Manuals on CD-ROM labeled "Operating Instructions".

Printed Manuals
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Setup Guide
Provides the same information as that in the printed Setup Guide.

Note
❒ There are two CD-ROMs that come with this printer. One is labeled " Operating Instructions" and

the other "Drivers and Utilities".
❒ Use Acrobat Reader included on the CD-ROM labeled "Drivers and Utilities" to read the PDF files.

PDF Files

Quick Installation Guide
Describes how to install the printer.

Setup Guide
Provides information about setting up the printer and its options.

Draft 2000/09/13

Printer Reference
Provides information about using the printer and its options.

Network Interface Board  Operating Instructions
Provides information about setting up and using the printer in a
network environment.

PostScript3 Operating Instructions Supplement
Describes the menus and features for the PostScript3 printer driver.

UNIX Operating Instructions Supplement
Provides information about setting up and using  the printer in a
UNIX.





Setup Guide
Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.



Introduction
This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.
Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Notes:
The actual names of the following applications do not appear on the following pages. Check the model
name of the printer before reading this manual.

Descriptions without the note for identifying the type of the printer are common for both models. Certain
types might not be available in some countries. For more information, please contact your local dealer.
The actual names of the following applications do not appear on the following pages. Confirm which
applications you will be using before reading this manual.

Consumable:

Power Source
RICOH LASER AP2600: 120 V, 60 Hz, 8.4 A or more
RICOH LASER AP2600N: 120 V, 60 Hz, 8.4 A or more
Please be sure to connect the power cord to a power source as above.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Operator Safety:
This machine is considered a CDRH class I laser device, safe for office/ EDP use. The machine con-
tains 5-milliwatt, 760 - 800 nanometer wavelength, GaAIAs laser diode. Direct (or indirect reflected) eye
contact with the laser beam might cause serious eye damage. Safety precautions and interlock mech-
anisms have been designed to prevent any possible laser beam exposure to the operator. 

Laser Safety:
The Center for Devices and Radiological Health (CDRH) prohibits the repair of laser-based optical unit
in the field. The optical housing unit can only be repaired in a factory or at a location with the requisite
equipment. The laser subsystem is replaceable in the field by a qualified Customer Engineer. The laser
chassis is not repairable in the field. Customer engineers are therefore directed to return all chassis and
laser subsystems to the factory or service depot when replacement or the optical subsystem is required.

Important
Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Caution:
Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Do not attempt any maintenance or troubleshooting other than that mentioned in this manual. This printer
contains a laser beam generator and direct exposure to laser beams can cause permanent eye damage.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good copy quality, Ricoh recommends that you use genuine Ricoh toner.

Ricoh shall not be responsible for any damage or expense that might result from the use of parts other
than genuine Ricoh parts in your Ricoh office product. 

Descriptions in this manual Model name
Type 1 Printer RICOH LASER AP2600
Type 2 Printer RICOH LASER AP2600N

Descriptions in this manual Application
PRINTER MANAGER FOR ADMINISTRATOR Aficio Manager for Admin
PRINTER MANAGER FOR CLIENT Aficio Manager for Client

Consumable Name
Toner RICOH LP TONER CARTRIDGE Type 

100 BLACK

Consumable Compornents
MAINTENANCE KIT Type2600 Friction Pads, Paper Feed Rollers, 

Transfer Roller, Fusing Unit



Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Micro-
soft Corporation in the United States and/or other countries.
Novell, Netware, NDS are registered trademarks or Novell, Inc.
PostScript® is a registered trademark of Adobe Systems, Incorporated.
PCL® is a registered trademark of Hewlett-Packard Company.
AppleTalk, Apple, Macintosh, TrueType and LaserWriter are registered trade-
marks of Apple Computer, Incorporated.
IPS-PRINT™ Printer Language Emulation© Copyright 1999-2000, XIONICS
DOCUMENT TECHNOLOGIES, INC., All Rights Reserved.
Ethernet® is a registered trademark of Xerox Corporation.
Other product names used herein are for identification purposes only and might
be trademarks of their respective companies. We disclaim any and all rights in
those marks.

Notes:

Some illustrations might be slightly different from your machine.
Certain options might not be available in some countries. For details, please con-
tact your local dealer.

Note

The proper names of the Windows operating systems are as follows:
• Microsoft® Windows® 95 operating system
• Microsoft® Windows® 98 operating system
• Microsoft® Windows ® 2000 Professional
• Microsoft® Windows ® 2000 Server
• Microsoft® Windows NT® Server operating system Version 4.0
• Microsoft® Windows NT® Workstation operating system Version 4.0
• Microsoft® Windows® Millenium Edition (Windows Me)
i
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Safety Information

When using your printer, the following safety precautions should always be fol-
lowed.

Safety During Operation

In this manual, the following important symbols are used: 

R WARNING:

 

R WARNING:
Indicates a potentially hazardous situation which, if instructions 
are not followed, could result in death or serious injury.

R CAUTION:
Indicates a potentially hazardous situation which, if instructions are 
not followed, may result in minor or moderate injury or damage to 
property.

• Connect the power cord directly into a wall outlet and never use an ex-
tension cord.

• Disconnect the power plug (by pulling the plug, not the cable) if the 
power cable or plug becomes frayed or otherwise damaged.

• To avoid hazardous electric shock or laser radiation exposure, do not 
remove any covers or screws other than those specified in this man-
ual.

• Turn off the power and disconnect the power plug (by pulling the plug, 
not the cable) if any of the following conditions exists:

• You spill something into the equipment.

• You suspect that your equipment needs service or repair.

• Your equipment's cover has been damaged.

• Do not incinerate spilled toner or used toner. Toner dust might ignite 
when exposed to an open flame.

• Disposal can take place at our authorized dealer or at appropriate col-
lection sites.

• Dispose of the used toner cartridge in accordance with the local reg-
ulation.



R CAUTION:

 
• Protect the equipment from dampness or wet weather, such as rain, snow, 

and so on.

• Unplug the power cord from the wall outlet before you move the equipment. 
While moving the equipment, you should take care that the power cord will 
not be damaged under the equipment.

• When you disconnect the power plug from the wall outlet, always pull  the 
plug (not the cable).

• Do not allow paper clips, staples, or other small metallic objects to fall inside 
the equipment.

• Keep toner (used or unused) and toner cartridge out of the reach of chil-
dren.

• For environmental reasons, do not dispose of the equipment or expended 
supply waste at household waste collection points. Disposal can take place 
at an authorized dealer or at appropriate collection sites.

• The inside of the machine could be very hot. Do not touch the parts with a 
label indicating the “hot surface”. Otherwise it could cause a personal burn.

• Our products are engineered to meet high standards of quality and function-
ality, and we recommend that you only use the expendable supplies avail-
able at an authorized dealer.
iii
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ENERGY STAR Program

• Energy Saver mode
This printer automatically lowers its power consumption 15 minutes after the
last operation has been completed. To exit Energy Saver mode, press any key
on the operation panel. To change the setting of the Energy Saver mode, see
“System Settings Menu” in the Printer Reference provided as a PDF file on the
CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Specifications

----Recycled Paper
In accordance with the ENERGY STAR Program, we recommend use of recycled
paper which is environment friendly. Please contact your sales representative
for recommended paper.

As an ENERGY STAR Partner, we have determined 
that this machine model meets the ENERGY STAR 
Guidelines for energy efficiency.

The ENERGY STAR Guidelines intend to establish an international energy-saving system for 
developing and introducing energy-efficient office equipment to deal with environmental is-
sues, such as global warming.

When a product meets the ENERGY STAR Guidelines for energy efficiency, the Partner shall 
place the ENERGY STAR logo onto the machine model.

This product was designed to reduce the environmental impact associated with office equip-
ment by means of energy-saving features, such as Low-power mode.

Energy Saver mode Power Consumption 17 W

Default Time 30 minutes
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Manuals for This Printer

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this printer, all users should read and
follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide  (this manual)
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

❖❖❖❖ Printer Reference
Provides information about using the printer and its options. This manual
provided as a PDF file on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Network Interface Board Operating Instructions
Provides information about setting up and using the printer in a network en-
vironment. This manual provided as a PDF file on the CD-ROM labeled “Op-
erating Instructions”.

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features for the PostScript 3 printer driver. This
manual provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions”.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

Note
❒ There are two CD-ROMs that come with this printer. One is labeled "Operat-

ing Instructions" and the other is "Drivers and Utilities".
v
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.
Keys on the computer's keyboard.
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1. Getting Started
Features of This Printer

This printer is designed especially for office workgroups, both for shared usage
within a network environment, and for one-to-one usage by being connected di-
rectly to the computer.

❖❖❖❖ Time Saving
Superior features save time on print tasks.
• Continuous Printing Speed : 26 ppm.

A4 L, 81/2" × 11" L, maximum printing speed from a standard paper tray.
• All Front Operation: From the front, you can replace the toner cartridge,

check indicators, and clear a paper misfeed if it occurs.

❖❖❖❖ Compact Body
Its compact body requires minimum space to place it on your desk or desk
side.

❖❖❖❖ Network Connectivity
This printer is network ready with two versions. One is a printer with a stand-
ard Network Interface Board, and the other is a printer with an optional Net-
work Interface Board Type 2600.

❖❖❖❖ Major Specifications

Note
❒ The “K” symbol means short-edge feed direction.
❒ The ”L” symbol means long-edge feed direction.

Printing Speed 26 pages per minute (A4L, 81/2" × 11"L)

Maximum Print Quality True 1200 × 1200 dpi resolutions (PCL 6, RPCS, PS3)

Printer Language PCL 6 , PCL 5e, RPCS, PostScript 3

Maximum Input Paper Size Paper Tray and Bypass Tray:

A3K, 11" × 17"K

Standard Memory Size 32MB

Maximum Memory Size 
with Optional Memory

96MB
1
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Printer Drivers for This Printer

Printing requires installation of a printer driver for your operating system. The
following drivers are included on the CD-ROM that comes with this printer.

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millenium edition operating system
*4 Microsoft Windows 2000 professional

Microsoft Windows 2000 Server
*5 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT

Workstation operating system version 4.0 in a computer using x86 processors.
*6 Required version is 7.6.1 or later operating system.
*7 Requires Service Pack 4 or later.
*8 The Adobe PostScript printer drivers and PostScript Printer Description (PPD) files

are included on the CD-ROM that comes with this printer.

❖❖❖❖ PCL printer drivers
Printer drivers allow the computer to communicate with the printer via a
printer language. Two kinds of PCL printer drivers, PCL 6 and PCL 5e, are
provided with this printer. We recommend PCL 6 as your first choice. 

Note
❒ Some of your applications might require the installation of the PCL 5e

printer driver. In this case, you can install PCL 5e in addition to PCL 6.
⇒  P.46 “Windows 95/98/Me - Installing the PCL 6/5e Printer Driver”
⇒  P.47 “Windows 2000 - Installing the PCL 6/5e Printer Driver”
⇒  P.49 “Windows NT 4.0 - Installing the PCL 6/5e Printer Driver”

❖❖❖❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer via
a printer language. The preset type user interface is provided in addition to
the conventional one.
⇒  P.51 “Windows 95/98/Me - Installing the RPCS Printer Driver”
⇒  P.52 “Windows 2000 - Installing the RPCS Printer Driver”
⇒  P.54 “Windows NT 4.0 - Installing the RPCS Printer Driver”

Printer Language PCL 6 PCL 5e RPCS PostScript3

Operating system

Windows 95 *1 √ √ √ √ *8 

Windows 98 *2 √ √ √ √ *8 

Windows Me *3 √ √ √ √ *8 

Windows 2000 *4 √ √ √ √ *8 

Windows NT 4.0 *5 √ √ √ √ *7  *8 

Mac OS *6 √ *8 
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❖❖❖❖ Adobe PostScript Printer Drivers and PPD files
The Adobe Postscript printer drivers and the PPD files are included on the
CD-ROM that comes with this printer. Adobe PostScript printer driver allows
the computer to communicate with the printer via a printer language. The
PPD files allow the printer driver to enable the printer specific functions.
⇒  P.55 “Windows 95/98/Me - Installing the PostScript Printer Driver”
⇒  P.57 “Windows 2000 - Installing the PostScript Printer Driver”
⇒  P.59 “Windows NT 4.0 - Installing the PostScript Printer Driver”
⇒  P.63 “Macintosh”
3
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Software and Utilities Included on the CD-
ROM

There are two CD-ROMs that comes with this printer. One is labeled “Operating
Instructions” and the other is “Drivers and Utilities”. The following items are in-
cluded on the two CD-ROMs separately.

❖❖❖❖ Agfa Font Manager
Helps you to install new screen fonts, or organize and manage fonts already
installed on the system. This manual provided as a PDF file on the CD-ROM
labeled “Drivers and Utilities”.

❖❖❖❖ PRINTER MANAGER FOR ADMINISTRATOR
A utility for the system administrator to manage printers on the network. This
manual provided as a PDF file on the CD-ROM labeled “Drivers and Utili-
ties”.

Reference
For the actual name of PRINTER MANAGER FOR ADMINISTRATOR ap-
plication, see the inside of front cover of this manual.
See PRINTER MANAGER FOR ADMINISTRATOR online Help for more
information about using PRINTER MANAGER FOR ADMINISTRATOR.

❖❖❖❖ PRINTER MANAGER FOR CLIENT
A utility for users to manage their own print status on the network. This man-
ual provided as a PDF file on the CD-ROM labeled “Drivers and Utilities”.

Reference
For the actual name of PRINTER MANAGER FOR CLIENT application,
see the inside of front cover of this manual.
See PRINTER MANAGER FOR CLIENT online Help for more information
about using PRINTER MANAGER FOR CLIENT.

❖❖❖❖ Multidirect Print
A utility for printing on a “peer to peer” network. This manual provided as a
PDF file on the CD-ROM labeled “Drivers and Utilities”.

Reference
For more information about Multidirect Print, see the Network Interface
Board Operating Instructions provided as a PDF file on the CD-ROM la-
beled “Operating Instructions”.
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❖❖❖❖ PortNavi
A utility that helps you to use the network printer effectively. It is useful in
environments where two or more network printers are used. This manual
provided as a PDF file on the CD-ROM labeled “Drivers and Utilities”.

Reference
For more information about PortNavi, see the Network Interface Board
Operating Instructions provided as a PDF file on the CD-ROM labeled
“Operating Instructions”.

❖❖❖❖ Acrobat Reader
A utility that allows you to read PDF (Portable Document Format). This man-
ual provided as a PDF file on the CD-ROM labeled “Operating Instructions”.

Note
❒ Documentation about using the printer is included on the CD-ROM in PDF

format. See Acrobat Reader online Help for more information about using
Acrobat Reader.

Important
❒ If you upgrade to Windows 2000 from Windows 95/98/Me or Windows NT

4.0, the software and utilities must be uninstalled prior to installing Windows
2000. Then reinstall them in a Windows 2000 environment.
5
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Guide to This Printer

Mainframe

❖❖❖❖ Exterior

1. Paper Size Dial
Adjust this dial to match the size and
feed direction of the paper loaded in
the paper tray.

2. Bypass Tray Extension
Pull out this extension to load paper
into the bypass tray when its length is
longer than A4 L or 81/2” x 11”L.

3. Bypass Tray
Use to print onto thick paper, OHP
transparencies, adhesive labels, cus-
tom size paper, envelopes as well as
plain paper. When printing on custom
paper size, printer driver settings are
required.
Up to 100 sheets of plain paper (80 g/
m2, 20 lb) can be loaded.
See “Paper and Other Media Supported
by this Printer” and “ Loading Paper in
the Bypass Tray” in the Printer Refer-
ence provided as a PDF file on the CD-
ROM labeled "Operating Instruc-
tions".

ZCEH141N.eps
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4. Output Tray Extension
Pull out this extension when printing
on long paper.

5. Operation Panel
Contains keys for the printer opera-
tion and a panel display that shows
the printer status.

6. Output Tray (Standard Tray)
Printed output is stacked here with
the print side facing down.

7. Upper Cover
Remove to install the optional 1-bin
Shift Sort Tray or optional the Mail-
box.

8. Paper Exit Cover
Open this cover to remove misfed pa-
per.

9. Ventilator
These holes help to keep components
inside the printer from overheating.

Important
❒ Do not block or obstruct the

ventilator. A malfunction may
occur due to overheating.

10. Front Cover Release Button
Use this button to open the front cov-
er.

11. Power Switch
Use this switch to turn the printer
power on and off.

12. Paper Tray (Tray 1)
Loads up to 250 sheets of plain paper
(80 g/m2, 20 lb) into this tray for print-
ing. 
See “Paper and Other Media Supported
by this Printer” in the Printer Reference
provided as a PDF file on the CD-
ROM labeled "Operating Instruc-
tions".

Note
❒ Paper Tray is displayed “Tray 1”

on the panel display.

13. Rear Cover
Remove to install the optional Duplex
Unit or to replace the Fusing Unit.

14. Power Cord
Plug this cord into a wall outlet.

15. Ventilators
These holes help to keep components
inside the printer from overheating.

Important
❒ Do not block or obstruct the

ventilators. A malfunction may
occur due to overheating.

16. Controller Board
Slide it out to install some options. At-
tach the interface cable, the network
interface cable or the 1394 interface ca-
ble to the board.
7
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❖❖❖❖ Interior

1. Toner Cartridge
Includes toner and a photoconductor
unit.
When “Replace Toner Cartridge” ap-
pears on the panel display, replace
this unit.

2. Front Cover
Open this cover when accessing the
inside of the printer.

3. Guide Board
Open this board to remove misfed pa-
per.

4. Registration Roller
Feeds the paper. If it becomes dirty,
clean it.
See “Cleaning the Registration Roller” in
the Printer Reference provided as a
PDF file on the CD-ROM labeled "Op-
erating Instructions".

5. Transfer Roller Cover
Open this cover when replacing a
transfer roller.

6. Transfer Roller
When “Replace Maintenance Kit” ap-
pears on the panel display, replace
this roller.

7. Fusing Unit Lock Levers
Lift these levers when replacing the
fusing unit.

8. Fusing Unit
Fuses the image onto paper. 
When “Replace Maintenance Kit” ap-
pears on the panel display, replace
this unit.

Zceh230j.eps
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Operation Panel

1. Panel display
Shows the current status of the printer
and error messages.
See “Error & Status Messages on the Opera-
tion Panel” in the Printer Reference pro-
vided as a PDF file on the CD-ROM
labeled "Operating Instructions".

2. Power indicator
Is on while the printer power is on.
Is off when the power is turned off or
while the printer is in Energy Saver
mode.

3. Error indicator
Blinks or lights up whenever any printer
error occurs. A message describing the
cause of the error also appears on the
panel display.
See “Error & Status Messages on the Opera-
tion Panel” in the Printer Reference pro-
vided as a PDF file on the CD-ROM
labeled "Operating Instructions".

4. Data In indicator
Blinks while the printer is receiving data
from a computer.
Is on if there is data to be printed.

5. {{{{Online}}}} key
Press this key to switch the printer be-
tween online and offline.

6. {{{{Job Reset}}}} key
When the printer is online, press this key
to cancel any ongoing print job.
See “Canceling a Print job” in the Printer
Reference provided as a PDF file on the
CD-ROM labeled "Operating Instruc-
tions".

7. {{{{Form Feed}}}} key
If the printer is offline, press this key to
print all the data left in the printer's input
buffer.

Note
❒ This does not work if the printer is on-

line.

8. {{{{Menu}}}} key
Press this key to make and check the cur-
rent printer settings.
See “Making Printer Settings with the Oper-
ation Panel” in the Printer Reference pro-
vided as a PDF file on the CD-ROM
labeled "Operating Instructions".

EnterForm Feed

Job Reset

On Line

Escape

Menu

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

KirKey-US.eps
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9. {{{{Escape}}}} key
Press this key to return to the previous
condition on the panel display.

10. {{{{Enter #}}}} key
Press this key to execute menu items se-
lected on the panel display.
Press this key to clear some errors.
See “Troubleshooting” in the Printer Refer-
ence provided as a PDF file on the CD-
ROM labeled "Operating Instructions".

11. {{{{UUUU}}}} {{{{TTTT}}}} keys
Use these keys to increase or decrease
values on the panel display when making
settings.



2. Installing Options
R CAUTION:

Important
❒ Rating voltage of the connector for options ; Max. DC24V.

❖❖❖❖  Option List

Note
❒ See the inside front cover of this manual to confirm which printer (Type 1

or Type 2) you have.

❍  : This option can be installed.
*1 You can install any combination of these units. Up to two Paper Feed Units can be

installed to the printer at the same time.
*2 The Envelope Feeder Unit requires the installation of the Paper Feed Unit.
*3 The Network Interface Board and the 1394 Interface Unit cannot be installed to the

printer at the same time.
*4 The 1-bin Shift Sort Tray and the Mailbox cannot be installed to the printer at the

same time.

• Be sure to turn off the printer and wait for about an hour before installing 
options. Not waiting for the printer to cool down can result in a burn.

• When lifting the printer, use the inset grips on both sides of the printer, oth-
erwise the printer might fall and cause personal injury.

• When you move the printer, unplug the power cord from the wall outlet to 
avoid a fire or an electric shock.

Type 1 Printer Type 2 Printer

Paper Feed Unit Type 2600 *1 ❍ ❍

Envelope Feeder Type 2600 *2 ❍ ❍

1-bin Shift Sort Tray Type 2600 *4 ❍ ❍

CS380 (Mailbox) *4 ❍ ❍

AD410 (Duplex Unit) ❍ ❍

Memory Unit TypeB 64MB ❍ ❍

Hard Disk Drive Type 2600 ❍ ❍

Network Interface Board Type 2600 *3 ❍

1394 Interface Unit Type 2600 *3 ❍ ❍
11
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Available Options

The following options can be installed to the printer.

❖❖❖❖ Exterior

1. Paper Feed Unit Type 2600 (Tray 2
or Tray 3)

You can load up to 500 sheets (60-
105g/m2, 16-28Ib) of plain paper into
the tray.

Note
❒ Do not install more than two Paper

Feed Units to the printer at the
same time.

❒ Top-most optional Paper Feed Unit
is displayed “Tray 2” and bottom-
most is displayed “Tray 3” on the
panel display.

2. Envelope Feeder Type 2600
You can load up to 60 envelopes (72-
90g/m2, 19-24Ib) into the tray.

Note
❒ The Envelope Feeder is a tray that

slides into the optional Paper Feed
Unit. Without the optional Paper
Feed Unit, the Envelope Feeder
cannot be used.

❒ The Printer can have two optional
Paper Feed Units installed at the
same time. However the Envelope
Feeder should be used in the top-
most optional Paper Feed Unit
(tray 2). It cannot be used in the
bottom-most Paper Feed Unit (tray
3).

3. AD410 (Duplex Unit)
You can print on both sides of paper.

Zceh150j.eps
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4. 1-bin Shift Sort Tray Type 2600
You can shift and sort the printings.

Note
❒ The 1-bin Shift Sort Tray and the

Mailbox cannot be installed to the
printer at the same time.

5. CS380 (Mailbox)
You can sort the printings and also de-
liver them to each tray separately.

Note
❒ The 1-bin Shift Sort Tray and the

Mailbox cannot be installed to the
printer at the same time.

❖❖❖❖ Type 1 Printer : Interior

Note
❒ See the inside front cover of this manual to confirm which printer (Type 1

or Type 2) you have.

1. Memory Unit TypeB 64MB
You can increase the amount of mem-
ory up to 96MB.

2. Network Interface Board Type
2600

You can perform the print job on the
network environment.

Note
❒ The Network Interface Board and

the 1394 Interface Unit cannot be
installed to the printer at the same
time.

3. 1394 Interface Unit Type 2600
You can perform the print job on the
IEEE 1394 environment.

Note
❒ The 1394 Interface Unit and the

Network Interface Board cannot be
installed to the printer at the same
time.

4. Hard Disk Drive Type 2600
You can use the “Collate”, the “Sam-
ple Print” and the “Protected Print”
functions.

ZDDP221E.eps
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❖❖❖❖ Type 2 Printer : Interior

Note
❒ See the inside front cover of this manual to confirm which printer (Type 1

or Type 2) you have.

1. Memory Unit TypeB 64MB
You can increase the amount of mem-
ory up to 96MB.

2. 1394 Interface Unit Type 2600
You can perform the print job on the
IEEE1394 environment.

Note
❒ The 1394 Interface Unit and the

Network Interface Board cannot be
installed to the printer at the same
time.

3. Hard Disk Drive Type 2600
You can use the “Collate”, the “Sam-
ple Print” and the “Protected Print”
functions.

ZDDP220E.eps
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Installing Options

Installing Paper Feed Unit 
Type 2600

Important
❒ Do not slide more than one paper

tray out at the same time. Having
more than one paper tray filled
with paper in a fully extended po-
sition could cause the machine to
fall down.

❒ Do not install more than two Paper
Feed Units in your printer at the
same time.

❒ Check the printer nameplate to
confirm the model code.

A Check the contents of the box for
the following items:
• Paper Feed Unit (including a

paper tray)

• Installation Guide

B Be sure to check the following
points:
• The power switch is turned off.

• The power cord is unplugged
from the wall outlet.

• The interface cable is un-
plugged from the printer.

C Remove the adhesive tape from
the Paper Feed Unit.

Note
❒ If you install two Paper Feed

Units at the same time, stack
them up in advance.

D There are three pins on the top of
the Paper Feed Unit that point
straight up. On the bottom of the
printer there are three holes.
Align the holes over the pins and
lower the printer gently onto the
Paper Feed Unit.

R CAUTION:
• When lifting the machine, use 

the inset grips on both sides. 
Otherwise the printer could 
break or cause injury if 
dropped.

Zcex390j.eps
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E Attach the interface cable to the
printer.

F Plug the printer's power cord
back into the wall outlet and turn
on the power switch.

Note
❒ After installing the last option that

you want, print a configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing a
configuration page, see "Printing a
Configuration Page" in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".

Reference
For information about loading pa-
per, see "Loading Paper in the Op-
tional Paper Tray" in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".

Installing Envelope Feeder 
Type 2600

Note
❒ This unit is a tray that slides into

the optional Paper Feed Unit.
Without the optional Paper Feed
Unit, this Envelope Feeder cannot
be used.

❒ Your printer can have two optional
Paper Feed Units. However, the
Envelope Feeder must be used in
the top-most optional Paper Feed
Unit (tray 2). It cannot be used in
the bottom-most optional Paper
Feed Unit (tray 3).

Important
❒ Do not slide more than one paper

tray out at the same time. Having
more than one paper tray filled
with paper in a fully extended po-
sition could cause the machine to
fall down.

A Check the contents of the box for
the following items:

• Envelope Feeder

• Installation Guide

B Pull out the second paper tray
(tray 2) of the optional Paper Feed
Unit until it stops. After that, lift
it slightly, and then pull it out.

ZDDH052N.eps
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Important
❒ The Envelope Feeder must be

used in the top-most optional
Paper Feed Unit (tray 2).

❒ The tray of the top-most option-
al Paper Feed Unit is beneath
the paper tray.

Note
❒ Keep the paper tray with paper

in a cool dark place.

CWhile lifting the front side of the
Envelope Feeder, place the feeder
into the printer. Then slide it into
the printer until it stops.

Reference
For information about loading pa-
per, see "Loading Envelopes" in the
Printer Reference provided as a
PDF file on the CD-ROM labeled
"Operating Instructions".

Installing 1-bin Shift Sort Tray 
Type 2600

Important
❒ If you install the 1-bin Shift Sort

Tray and the Paper Feed Unit, the
Paper Feed Unit must be installed
prior to installing the 1-bin Shift
Sort Tray.

❒ The 1-bin Shift Sort Tray and the
Mailbox cannot be installed to the
printer at the same time.

❒ Check the printer nameplate to
confirm the model code.

A Check the contents of the box for
the following items:

• 1-bin Shift Sort Tray
• Upper Tray

• Installation Guide

B Be sure to check the following
points:

• The power switch is turned off.

• The power cord is unplugged
from the wall outlet.

• The interface cable is un-
plugged from the printer.

C Remove the adhesive tapes and
the packing material.

Zddp340e.eps
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D Remove the upper cover of the
printer.

Note
❒ The upper cover that is re-

moved, is not used when in-
stalling the 1-bin Shift Sort Tray.

E Holding the 1-bin Shift Sort Tray
on both sides, align the catches
with the holes on the printer and
insert.

R CAUTION:

F Slide the upper tray into the 1-bin
Shift Sort Tray.

G Attach the interface cable to the
printer.

H Plug the printer's power cord
back into the wall outlet and turn
on the power switch.

Note
❒ After installing the last option that

you want, print a configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing a
configuration page, see "Printing a
Configuration Page" in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".

• When lifting the 1-bin Shift 
Sort Tray, hold it on both 
sides. Holding under neath 
the 1-bin Shift Sort Tray may 
cause injury to the hands if 
caught between the 1-bin 
Shift Sort Tray and the printer.
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Installing CS380 (Mailbox)

Important
❒ If you install the Mailbox and the

Paper Feed Unit, the Paper Feed
Unit must be installed prior to in-
stalling the Mailbox.

❒ The Mailbox and the 1-bin Shift
Sort Tray cannot be installed to the
printer at the same time.

❒ Check the printer nameplate to
confirm the model code.

A Check the contents of the box for
the following items:
• Mailbox

• Output trays (4pcs)

• Output tray number seal
• Installation Guide

B Be sure to check the following
points:

• The power switch is turned off.

• The power cord is unplugged
from the wall outlet.

• The interface cable is un-
plugged from the printer.

C Remove the adhesive tapes and
the packing materials.

D Remove the upper cover of the
printer.

Note
❒ The upper cover that is re-

moved, is not used when in-
stalling the Mailbox.

E Holding the Mailbox on both
sides, align the catches with the
holes on the printer and insert.

R CAUTION:

Zcex450j.eps

• When lifting Mailbox, hold it 
on both sides. Holding under 
neath the Mailbox may cause 
injury to the hands if the Mail-
box and the printer.
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F Slide the output tray into the low-
er side of the Mailbox first.

G Slide the other output trays into
the Mailbox.

H Attach the interface cable to the
printer.

I Plug the printer's power cord
back into the wall outlet and turn
on the power switch.

Note
❒ After installing the last option that

you want, print a configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing a
configuration page, see "Printing a
Configuration Page" in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".

Installing AD410 (Duplex Unit)

Important
❒ If you install the Duplex Unit and

the Paper Feed Unit, the Paper
Feed Unit must be installed prior
to installing the Duplex Unit.

❒ Check the printer nameplate to
confirm the model code.

A Check the contents of the box for
the following items:

• Duplex Unit

• Installation Guide

B Be sure to check the following
points:
• The power switch is turned off.

• The power cord is unplugged
from the wall outlet.

• The interface cable is un-
plugged from the printer.

C Remove the adhesive tapes.
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D Open the rear cover by pushing
the two knobs as shown in the il-
lustration.

E Remove the rear cover in the hor-
izontal direction.

Note
❒ The rear cover of the printer is

not used when installing the
Duplex Unit.

FWhile aligning the power cord to
the left side groove of the Duplex
Unit, slide it in until it is connect-
ed to the printer.

G Attach the interface cable to the
printer.

H Plug the printer's power cord
back into the wall outlet and turn
on the power switch.

Note
❒ After installing the last option that

you want, print a configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing a
configuration page, see "Printing a
Configuration Page" in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".
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Installing Memory Unit TypeB 
64MB

Important
❒ The Memory Unit can be damaged

by small amount of static electrici-
ty. You should touch some metal
to discharge static electricity.

A Check the contents of the box for
the following items:

• Memory Unit

• Installation Guide

B Be sure to check the following
points:
• The power switch is turned off.

• The power cord is unplugged
from the wall outlet.

• The interface cable is un-
plugged from the printer.

Note
❒ If the Duplex Unit is not in-

stalled, go to step D.

C If the Duplex Unit is installed,
push down the lever on right side
(AAAA) and pull it out until the Du-
plex Unit stops (BBBB).

D Use a coin to remove the two
screws.

Note
❒ The removed screws are re-

quired in step K.

E Pull out the handle of the control-
ler board.

F Pull the handle and slide the con-
troller board out.

G Place the controller board on a flat
surface.
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H Tilt the Memory Unit as shown in
the illustration to the slot (AAAA),
and push it forward (BBBB). It should
make click into place.

I Set the controller board to the "{{{{"
position, and then slide it into the
printer slowly until it stops.

J Push the handle of the controller
board until it clicks.

K Fasten the controller board with
the two screws to the printer.

Note
❒ If the Duplex Unit is not in-

stalled, go to step N.

LWhile aligning the power cord to
the left side groove of the Duplex
Unit, slide it in until it is connect-
ed to the printer.

M Attach the interface cable to the
printer.
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N Plug the printer's power cord
back into the wall outlet and turn
on the power switch.

O Print a configuration page to con-
firm that the Memory Unit is
properly installed.

Important
❒ If you use a Windows operating

system, you should set up the
Memory Unit with the printer
driver to make the printer recog-
nizes the installation. See a de-
scription of Windows 95/98/Me,
Windows 2000 and Windows NT
4.0 on P.43 “Installing the Printer
Driver and Software”.

Note
❒ After installing the last option that

you want, print a configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing a
configuration page, see "Printing a
Configuration Page" in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".

Installing Hard Disk Drive Type 
2600

Important
❒ The Hard Disk Drive can be dam-

aged by small amount of static
electricity. You should touch some
metal to discharge static electricity.

A Check the contents of the box for
the following items:

• Hard Disk Drive

• Installation Guide

B Be sure to check the following
points:
• The power switch is turned off.

• The power cord is unplugged
from the wall outlet.

• The interface cable is un-
plugged from the printer.

C Use a coin to remove the two
screws, and then remove the cov-
er.

Note
❒ The screws and cover are not

need when installing the Hard
Disk Drive.
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D Slowly insert the Hard Disk
Drive while aligning it with the
top and bottom rails in the print-
er, until it stops.

E Use the two screws to fasten the
Hard Disk Drive.

F Attach the interface cable to the
printer.

G Plug the printer's power cord
back into the wall outlet and turn
on the power switch.

The following message appears on
the panel display.

  HDD error

  initialize?

H Press {{{{Enter qqqq}}}}. The Hard Disk
Drive is formatted. Wait for a
while.

Important
❒ Do not turn off the printer while

formatting the Hard Disk Drive.
Turning off the printer while
formatting the Hard Disk Drive
can damage the Hard Disk
Drive.

If you successfully format the
Hard Disk Drive, the following
message appears on the panel dis-
play.

  HDDinitialize

  finish:OK

I Press {{{{Online}}}}.

“Ready” message appears on the
panel display.

  Ready

  

ZCEX151J.eps
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Important
❒ If you use a Windows operating

system, you should set up the
Hard Disk Drive with the printer
driver to make the printer recog-
nizes the installation. See a de-
scription of Windows 95/98/Me,
Windows 2000 and Windows NT
4.0 on P.43 “Installing the Printer
Driver and Software”.

Note
❒ After installing the last option that

you want, print a configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing a
configuration page, see "Printing a
Configuration Page" in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".

Reference
See “Making Printer Settings with
the Operation Panel” in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".

Formatting Hard Disk Drive Type 2600

If you are formatting the Hard Disk
Drive for the first time, follow the
procedures below using the opera-
tion panel.

A Press {{{{Menu}}}}.
“Menu” appears on the panel dis-
play.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Maintenance” menu.

  Menu:

   Maintenance

C Press {{{{Enter qqqq}}}}.
The following message appears on
the panel display.

  Menu:

   Image Density

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “HDD
Format”.

  Menu:

   HDD Format

E Press {{{{Enter qqqq}}}}.
The following message appears on
the panel display.

  HDD Format:

  Press# To Start
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F Press {{{{Enter qqqq}}}}.

Important
❒ Do not turn off the printer while

formatting the Hard Disk Drive.
Turning off the printer while
formatting the Hard Disk Drive
can damage the Hard Disk
Drive.

If you successfully format the
Hard Disk Drive, the following
message appears on the panel dis-
play.

  Format Completed

  Restart Printer

Note
❒ If you fail, see “Troubleshooting”

in the Printer Reference provid-
ed as a PDF file on the CD-ROM
labeled "Operating Instruc-
tions".

G Turn off the power switch, and
then turn it back on.

Installing Network Interface 
Board Type 2600

Note
❒ See the inside front cover of this

manual to confirm which printer
(Type 1 or Type 2) you have.

❒ The Network Interface Board and
the 1394 Interface Unit cannot be
installed to the printer at the same
time.

Important
❒ The Network Interface Board can

be damaged by small amount of
static electricity. You should touch
some metal to discharge static elec-
tricity.

❒ Use the shielded twisted-pair
(STP) network interface cable.

Installing the Network Interface Board

A Check the contents of the box for
the following items:

• Network Interface Board
• Ferrite Core

• Installation Guide

B Be sure to check the following
points:

• The power switch is turned off.
• The power cord is unplugged

from the wall outlet.
• The interface cable is un-

plugged from the printer.

Note
❒ The interface cable is not includ-

ed in the box. Make sure that the
interface cable you use, is ap-
propriate for your computer.

❒ If the Duplex Unit is not in-
stalled, go to step D.
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C If the Duplex Unit is installed,
push down the lever on right side
(AAAA) and pull it out until the Du-
plex Unit stops (BBBB). 

D Use a coin to remove the two
screws.

Note
❒ These screws are used again in

step M.

E Pull out the handle of the control-
ler board.

F Pull the handle and slide the con-
troller board out.

G Place the controller board on a flat
surface.

H Use a coin to remove the two
screws, and then remove the cov-
er.

Note
❒ These screws are used again in

step J.
❒ The removed cover is not re-

quired to install the Network In-
terface Board.
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I Attach the positioning peg of the
Network Interface Board to the
hole of the controller board.

J Use the two screws to fasten the
Network Interface Board to the
controller board.

K Set the controller board to the "{{{{"
position, and then slide it into the
printer slowly until it stops.

L Push in the handle of the control-
ler board until it clicks.

M Fasten the controller board with
the two screws to the printer.

Note
❒ If the Duplex Unit is not in-

stalled, go to step O.

Zcex420j.eps

Zcex430j.eps

Zcex440j.eps

ZCEX250J.eps

ZCEX380J.eps

ZCEX270J.eps
29



Installing Options

30

2

NWhile aligning the power cord to
the left side groove of the Duplex
Unit, slide it in until it is connect-
ed to the printer. 

O Plug the printer's power cord
back into the wall outlet and turn
on the power switch.

Connecting the network interface cable 
to the network

A Turn off the power switch.

B Loop the network interface cable
and attach the ferrite core.

Note
❒ The network interface cable

loop should be about 15 cm (6")
(A) from the end of the cable
(on the end closet to the print-
er). The ferrite core at the end of
the cable should be a ring type
ferrite core.

C Attach the network interface ca-
ble to the jack on the board.

D Connect the other end of the net-
work interface cable to the net-
work.
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E Turn on the power switch.

Note
❒ If the Network Interface Board is

installed correctly, the information
about network settings (e.g. IP ad-
dress) is listed in the configuration
page. See "Printing a Configuration
Page" in the Printer Reference pro-
vided as a PDF file on the CD-
ROM labeled "Operating Instruc-
tions".

Reference
For more information, see P.37
“Configuring the Printer for the Net-
work”.

Installing 1394 Interface Unit 
Type 2600

Note
❒ See the inside front cover of this

manual to confirm which printer
(Type 1 or Type 2) you have.

❒ The 1394 Interface Unit and the
Network Interface Board cannot be
installed to the printer at the same
time.

Important
❒ In Windows 2000, the 1394 Inter-

face Unit can only be used with
Service Pack 1 or later. If the Serv-
ice Pack is not installed, the con-
nectable number of device in a
1394 bus is only one, and the client
cannot access the 1394 Interface
Unit without using an account has
the Administrators permission.

❒ The optional 1394 Interface Unit is
not supported by Windows 95/
98/Me. If the "plug and play" func-
tion starts, click [Cancel] in the [New
Hardware Found] or [New Device Wiz-
ard] dialog box.

❒ The 1394 Interface Unit can be
damaged by small amount of static
electricity. You should touch some
metal to discharge static electricity.

❒ Use the 1394 interface cable that
comes with this printer.

❒ Do not plug or unplug the 1394 in-
terface cable while installing the
printer driver.

❒ Do not turn off or on the device
while installing the printer driver.

❒ When the 1394 Interface Unit is in-
stalled, uninstall the printer driver
after the 1394 interface cable is un-
plugged.
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Installing the 1394 Interface Unit

A Check the contents of the box for
the following items:
• 1394 Interface Unit 

• 1394 interface cable (6 pin x 4
pin)

• 1394 interface cable (6 pin x 6
pin)

• Installation Guide

B Be sure to check the following
points:

• The power switch is turned off.
• The power cord is unplugged

from the wall outlet.
• The interface cable is un-

plugged from the printer.

Note
❒ If the Duplex Unit is not in-

stalled, go to step D.

C If the Duplex Unit is installed,
push down the lever on right side
(AAAA) and pull it out until the Du-
plex Unit stops (BBBB). 

D Use a coin to remove the two
screws.

Note
❒ These screws are used again in

step N.

E Pull out the handle of the control-
ler board.

F Pull the handle and slide the con-
troller board out.

G Place the controller board on a flat
surface.
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H Use a coin to remove the two
screws, and then remove the cover.

Note
❒ These screws are used again in

step K.

I To uninstall the Network Inter-
face Board, pinch and push the
positioning peg. If the Network
Interface Board is not installed,
go to step JJJJ.

Important
❒ When you uninstall the Net-

work Interface Board, be careful
not to damage the controller
board.

J Attach the 1394 Interface Unit to
the Slot until it clicks.

K Use the two screws to fasten the
1394 Interface Unit to the control-
ler board.

L Set the controller board to the "{{{{"
position, and then slide it into the
printer slowly until it stops.
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M Push in the handle of the control-
ler board until it clicks.

N Fasten the controller board with
the two screws to the printer.

Note
❒ If the Duplex Unit is not in-

stalled, go to step P.

OWhile aligning the power cord to
the left side groove of the Duplex
Unit, slide it in until it is connect-
ed to the printer. 

P Plug the printer's power cord
back into the wall outlet and turn
on the power switch.
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Connecting the 1394 interface cable to 
the printer

A Attach the 1394 interface cable to
the jack on the board.

Both jacks are available.

B Connect the other end of the 1394
interface cable to the computer or
the other IEEE 1394 node.

Note
❒ The 1394 Interface Unit could not re-

ceive data from more than one PC at
the same time. In this case, an error
message appears. The printer can
accept data sent from other PCs, af-
ter the first print job has finished.

❒ The bidirectional transmissions
are not supported by the 1394 In-
terface Unit.

❒ When the 1394 Interface Unit is in-
stalled successfully, the printer icon
automatically changes from "Use
Printer Offline" to "Ready", accord-
ing to the 1394 interface cable plug.

❒ After installing the last option that
you want, print a configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing a
configuration page, see "Printing a
Configuration Page" in the Printer
Reference provided as a PDF file
on the CD-ROM labeled "Operat-
ing Instructions".

----1394 Interface Unit 
specification

❖❖❖❖ Interface Connector:
IEEE 1394 (6 pin × 2)

❖❖❖❖ Required cable:
1394 interface cable (6 pin x 4 pin, 6
pin x 6 pin)

Important
❒ You cannot plug devices togeth-

er so as to create loops.
❒ Do not use a cable more than 4.5

meters (14.8 feet) long.

❖❖❖❖ Connectable number of device in a
bus
Maximum 63

❖❖❖❖ Allowed cable hops in a bus
Maximum 16

❖❖❖❖ Power supply
Non power supply

ZDDP290E.eps
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3. Configuring the Printer for
the Network
Configuring the Printer for the Network 
with the Operation Panel 

After installing the optional Network
Interface Board, configure it for the
network using the printer's operation
panel.
Configure the printer for the network
using the printer's operation panel.
The following table shows the opera-
tion panel settings and their default
settings. These are included in the
”Host Interface” menu.

Reference
For information about configuring
the computer for the network, see
the Network Interface Board Oper-
ating Instructions provided as a
PDF file on the CD-ROM labeled
“Operating Instructions”.
For information about “Host Inter-
face” menu, see “Host Interface
Menu” in the Printer Reference
provided as a PDF file on the CD-
ROM labeled “Operating Instruc-
tions”. *1 ❍  means that this protocol is active.

A Press {{{{Menu}}}}.

“Menu” appears on the panel dis-
play.

Setting Name Value

IP Address 000.000.000.000

Subnet Mask 000.000.000.000

Gateway Address 000.000.000.000

Access Control

(Access Control 
Address)

000.000.000.000

Access Mask

(Access Control 
Mask)

000.000.000.000

Network Boot None

Frame Type (NW)

(Frame type NetWare)
Auto Select

Active Protocol TCP/IP ❍  *1 

NetWare ❍  *1 

NetBEUI ❍  *1 

AppleTalk ❍  *1 

Ethernet Auto

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

Zdds020N.eps
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B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Host
Interface” menu.

  Menu:

   Host Interface

C Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Host Interface:

   I/O Buffer

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Net-
work Setup”.

  Host Interface:

   Network Setup

E Press {{{{Enter #}}}}.
The following message appears on
the panel display.

  Network Setup:

   IP Address

F Select the protocol you want to
use.

Note
❒ Do not select protocols that are

not used on your network.
A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display

“Active Protocol”.

  Network Setup:

   Active Protocol

B Press {{{{Enter #}}}}.
The current setting appears on
the panel display.

  Active Protocol:

   TCP/IP

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
protocol you want to use.

D Press {{{{Enter #}}}}.
The actual procedure may differ
depending on the protocol you
use. Follow the appropriate
procedure.

G If you use TCP/IP, you should as-
sign the IP address to the printer.

Note
❒ To get the IP address for the

printer, contact your network
administrator.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} until the fol-
lowing message appears.

  Network Setup:

   IP Address

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

ZDDS021N.eps
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B Press {{{{Enter #}}}}.
The current IP address appears
on the panel display.

  IP Address:

   000.000.000.000

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
leftmost entry field of the IP
address.

  IP Address:

   011.000.000.000

D Press {{{{Enter #}}}}.
The pointer (k) moves to the
next entry field automatically.

  IP Address:

   011.00k.000.000

Note
❒ You can return the pointer

(k) to the previous (left) entry
field by pressing {Escape}.

❒ If you press {Escape} when
the pointer (k) is on the left-
most position, the selected IP
address is reset.

E Repeat steps CCCC and DDDD to enter
the IP address.

  IP Address:

   011.022.033.044

Check if the pointer (k) is at the
rightmost position, and press
{Enter #} to register the IP ad-
dress you selected.

  Network Setup:

   IP Address

H If you use TCP/IP, you should as-
sign “Subnet Mask” and “Gate-
way Address” following the same
procedure for entering the IP ad-
dress.

I If you use TCP/IP, set the “Access
Control” and “Access Mask” fol-
lowing the same procedure for
entering the IP address, if neces-
sary.

J If you use TCP/IP, you can make
settings for “Network Boot”. 

You can select how to assign the
printer's address using the compu-
ter. Select one of the items below if
necessary.
• None (Default)
• DHCP
A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display

“Network Boot”.

  Network Setup:

   Network Boot

B Press {{{{Enter #}}}}.
The current setting appears on
the panel display.

  Network Boot:

  *None

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
method you want to use.

D Press {{{{Enter #}}}}.
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K If you use NetWare, select the
frame type for NetWare.

Select one of items below if neces-
sary.
• Auto (Default)
• Ethernet 802.3
• Ethernet 802.2
• Ethernet II
• EthernetSNAP

Note
❒ Usually, use the default setting

(“Auto”). When if you first se-
lect “Auto”, the frame type de-
tected by the printer is adopted.
If your network can use more
than two frame types, the print-
er may fail to select the correct
frame type if “Auto” is selected.
In this case, select the appropri-
ate frame type.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Frame Type (NW)”.

  Network Setup:

   Auto

B Press {{{{Enter #}}}}.
The current setting appears on
the panel display.

  Auto:

  *Auto

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
frame type you want to use.

D Press {{{{Enter #}}}}.

L Reset the printer to apply the set-
tings.

A Press {{{{Online}}}} to enter the “Of-
fline” condition.

The Online indicator turns off.
B Press {{{{Job Reset}}}}.

M Print the configuration page to
check settings you have made.
A Press {{{{Menu}}}}.
B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display

”List/Test Print” menu.

C After confirming that “Config.
Page” is on the display, press
{{{{Enter #}}}}.

D Press {{{{Enter #}}}}.
The configuration page is now
printed. Check the contents of
the configuration page.

E Press {{{{Online}}}}.
“Ready” message appears on
the panel display.

  Ready

 

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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----Address

❖❖❖❖ Subnet Mask
A number used to mathematically
“mask” or hide an IP address on
the network by eliminating those
parts of the address that are alike
for all the machines on the net-
work.

❖❖❖❖ Gateway Address
A gateway is a connection or inter-
change point that connects two
networks. A gateway address is for
the router or host computer used
as a gateway.

Note
❒ To get the addresses, contact

your network administrator.

❖❖❖❖ Access Control Address and Access
Control Mask
The Access Control Address and
Access Control Mask are used to
control the IP addresses that have
access to the computer used for
printing. If it is not necessary for
you to control the access rights, se-
lect “000.000.000.000”.

Note
❒ When the Access Control Ad-

dress settings coincide with the
masked result of the IP address
of the computer, print jobs from
that IP address can be accepted
by the Network Interface Board.

❒ For example, if you assign
192.168.15.16 as the Access Con-
trol Address to the Network In-
terface Board, the combination
of the Access Control Mask and
IP address that can have access
are as follows. (xxx : for any nu-
merical value)

Access Control 
Mask

IP Addresses that 
have access

000.000.000.000 xxx.xxx.xxx.xxx

255.000.000.000 192.xxx.xxx.xxx

255.255.000.000 192.168.xxx.xxx

255.255.255.000 192.168. 15.xxx

255.255.255.255 192.168. 15. 16
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4. Installing the Printer Driver
and Software
This manual assumes that you are familiar with general Windows procedures
and practices. If you are not, see the documentation that comes with Windows
for details.

Installation Method

The following table shows how to install the printer drivers and software.

*1 Available operating systems are as follows: Windows 95/98/Me, Windows 2000,
Windows NT 4.0

*2 Recommended for most users.
*3 Recommended for network printing users.
*4 Recommended for expert users.

Reference
For more information about the printer drivers, see P.2 “Printer Drivers for
This Printer”. For installing the printer drivers, see P.46 “Installing the PCL 6/
5e Printer Driver”, P.51 “Installing the RPCS Printer Driver” or P.55 “Installing
the PostScript Printer Driver”.
For more information about the software and utilities, see P.4 “Software and
Utilities Included on the CD-ROM”.

Important
❒ Before starting this installation, close all documents and applications. In a net-

work environment, confirm that users who are logged on are disconnected.
Be sure to do this when it will create the least interference with other users. 

❒ After installing a printer driver, you must restart the computer. 

Auto Run *1 
Add Printer 

WizardTypical *2 Network *3 Custom *4 

PCL 6 printer driver ❍ ❍ ❍

PCL 5e printer driver ❍

RPCS printer driver ❍ ❍ ❍

PostScript printer driver ❍

Agfa Font Manager ❍

PRINTER MANAGER FOR 
ADMINISTRATOR

❍

PRINTER MANAGER FOR 
CLIENT

❍ ❍

PortNavi ❍ ❍

Multidirect Print ❍
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Note
❒ If the "plug and play" function is started, click [Cancel] in the [New Hardware

Found], [Device Driver Wizard] or [Found New Hardware Wizard] dialog box, and
then insert the CD-ROM. The [New Hardware Found], [Device Driver Wizard] or
[Found New Hardware Wizard] dialog box appears depending on the system ver-
sion of the Windows 95/98/Me or Windows 2000. 

❒ The appropriate language name is used for the CD-ROM folder: ENGLISH
(English), DEUTSCH (German), FRANCAIS (French), ITALIANO (Italian),
ESPANOL (Span-ish), NEDRLNDS (Dutch), NORSK (Norwegian), DANSK
(Danish), SVENSKA (Swedish), POLSKI (Polish), PORTUGUS (Portuguese),
SUOMI (Finnish), MAGYAR (Hungarian), CESKY (Czech)
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Installing by Auto Run

You can install the PCL and the RPCS printer drivers and software, and set them
up easily by using Auto Run.
Follow these steps to install the PCL and the RPCS printer drivers and software
on Windows 95/98/Me, Windows 2000, Windows NT 4.0.

Limitation
❒ If your system is Windows 2000 or Windows NT 4.0, installing a printer driv-

er by Auto Run requires Administrators permission. When you install a print-
er driver by Auto Run, log on using an account that has Administrators
permission.

Note
❒ Auto Run might not automatically work with certain OS settings. In this case,

launch "INSTTOOL.EXE" located on the CD-ROM root directory.
❒ If you want to cancel Auto Run, hold down the {SHIFT} key (when your sys-

tem is Windows 2000, hold down the left {SHIFT} key) while inserting the CD-
ROM. Keep the {SHIFT} key held down until the computer has finished ac-
cessing the CD-ROM.

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

C Follow the instructions on the screen.

D Restart the computer after installation is complete.

E Set up the options with the printer driver.
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Installing the PCL 6/5e Printer Driver

Windows 95/98/Me - Installing the PCL 6/5e Printer Driver

Installing the printer driver

The following instructions explain how to install the PCL6/5e printer driver. See
P.45 “Installing by Auto Run” .
Two kinds of PCL printer driver, PCL 6 and PCL 5e, are provided with this
printer. We recommend PCL 6 as your first choice.

Note
❒ Some of your applications might require the installation of the PCL 5e printer

driver. In this case, you can install PCL 5e by using custom installation.

Setting up options

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

Note
❒ When setting up options, you should access the [Printer Properties] dialog box

from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Accessories] tab.

D Select options you have installed from the [Options] group.

E Click [OK] .
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Windows 2000 - Installing the PCL 6/5e Printer Driver

Installing the printer driver

Install the driver in accordance with the steps explained. See P.45 “Installing by
Auto Run”.
Two kinds of PCL printer driver, PCL 6 and PCL 5e, are provided with this
printer. We recommend PCL 6 as your first choice.

Note
❒ Some of your applications might require the installation of the PCL 5e printer

driver. In this case, you can install PCL 5e by using custom installation.

Limitation
❒ Installing a printer driver by Auto Run requires Administrators permission.

When you install a printer driver by Auto Run, log on using an account that
has Administrators permission.

Note
❒ During installation, the [Digital Signature Not Found] dialog box appears. In this

case, click [Yes] to continue the installation.
When prompted for the Windows 95/98/Me alternate printer driver location,
select one of the following folders on the CD-ROM:
• PCL 6

\DRIVERS\PCL6\WIN95_98\(Language)\DISK1\
• PCL 5e

\DRIVERS\PCL5E\WIN95_98\(Language)\DISK1\
When prompted for the Windows NT 4.0 alternate driver location, select one of
the following folders on the CD-ROM:
• PCL 6

\DRIVERS\PCL6\NT4\(Language)\DISK1\
• PCL 5e

\DRIVERS\PCL5E\NT4\(Language)\DISK1\
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Setting up options

Limitation
❒ Changing the printer settings requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

Note
❒ When setting up options, you should access the [Printer Properties] dialog box

from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Accessories] tab.

D Select options you have installed from the [Options] group.

E Click [OK] .
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Windows NT 4.0 - Installing the PCL 6/5e Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver by Auto Run requires Administrators

permission, when you install a printer driver by Auto Run, log on using an
account that has Administrators permission.

Install the driver in accordance with the steps explained. See P.45 “Installing by
Auto Run”.
Two kinds of PCL printer driver, PCL 6 and PCL 5e, are provided with this
printer. We recommend PCL 6 as your first choice.

Note
❒ Some of your applications might require the installation of the PCL 5e printer

driver. In this case, you can install PCL 5e by using custom installation.
When prompted for the Windows 95/98/Me alternate printer driver location,
select one of the following folders on the CD-ROM:
• PCL 6

\DRIVERS\PCL6\WIN95_98\(Language)\DISK1\
• PCL 5e

\DRIVERS\PCL5E\WIN95_98\(Language)\DISK1\
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Setting up options

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

Note
❒ When setting up options, you should access the [Printer Properties] dialog box

from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Accessories] tab.

D Select options you have installed from the [Options] group.

E Click [OK] .
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Installing the RPCS Printer Driver

Windows 95/98/Me - Installing the RPCS Printer Driver

Installing the printer driver

Install the driver in accordance with the steps explained. See P.45 “Installing by
Auto Run” .

Setting up options

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.
❒ You must set the correct paper size and feed direction that matches tray set-

tings on the printer driver.

Note
❒ When setting up options, you should access the [Printer Properties] dialog box

from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Print Settings] tab.

D Click [Printer Configuration...].

E Click [Change Accessories...].

F Select options you have installed from the [Select Printer Options:] box.

GMake settings and click [OK].

H Click [OK] to close the [Printer Configuration] dialog box.

I Click [OK] to start printing.
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Windows 2000 - Installing the RPCS Printer Driver

Installing the printer driver

The following instructions explain how to install the RPCS printer driver. See
P.45 “Installing by Auto Run”.

Limitation
❒ Installing a printer driver by Auto Run requires Administrators permission.

When you install a printer driver by Auto Run, log on using an account that
has Administrators permission.

Note
❒ During installation, the [Digital Signature Not Found] dialog box appears. Click

[Yes] to continue the installation.
When prompted for the Windows 95/98/Me alternate printer driver location,
select the following folder on the CD-ROM.
\DRIVERS\RPCS\WIN95_98\(Language)\DISK1\
When prompted for the Windows NT 4.0 alternate driver location, select the fol-
lowing folder on the CD-ROM.
\DRIVERS\RPCS\NT4\(Language)\DISK1\

Setting up options

Limitation
❒ Changing the printer settings requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.
❒ You must set the correct paper size and feed direction that matches tray set-

tings on the printer driver.

Note
❒ When setting up options, you should access the [Printer Properties] dialog box

from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.
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B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Accessories] tab.

D Select options you have installed from the [Options] group.

E Click [OK] .
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Windows NT 4.0 - Installing the RPCS Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver by Auto Run requires Administrators permission.

When you install a printer driver by Auto Run, log on using on account that
has Administrators permission.

Install the driver in accordance with the steps explained. ⇒  P.45 “Installing by
Auto Run” 
When prompted for the Windows 95/98/Me alternate printer driver location,
select the following folder on the CD-ROM.
\DRIVERS\RPCS\WIN95_98\(Language)\DISK1\

Setting up options

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.
❒ You must set the correct paper size and feed direction that matches tray set-

tings on the printer driver.

Note
❒ When setting up options, you should access the [Printer Properties] dialog box

from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Change Accessories] tab.

D Select options you have installed from the [Select Printer Options:] box.

E Click [OK] .
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Installing the PostScript Printer Driver

This section describes basic instructions for installing the printer driver. The ac-
tual procedure may differ depending on the operating system. Follow one of the
appropriate procedures below.

Important
❒ When updating the printer driver by installing the latest version, you should

uninstall that of former version if any. See “Uninstalling the Printer Driver and
Software” in the Printer Reference provided as a PDF file on the CD-ROM la-
beled "Operating Instructions".

Windows 95/98/Me - Installing the PostScript Printer Driver

Installing the printer driver

Important
❒ Be sure to install the PPD file for Windows 95/98/Me. Do not accidentally in-

stall the PPD file for Windows 2000 or Windows NT 4.0.

A Close all applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

C Double-click the [Add Printers] icon.

[Add Printer Wizard] starts.

D Click [Next].

E Check [Local Printer] and click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

F Click [Have Disk].

A dialog box for installing the printer driver from a disk appears.

G Hold down the {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM
drive. Keep the {{{{SHIFT}}}} key held down until the computer has finished ac-
cessing the CD-ROM.

If the Auto Run program starts, click [Cancel].

H Click [Browse].

I Use the [Drives:] list box to select the CD-ROM drive.
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J In the [Folders:] box, double-click [DRIVERS], [PS], [WIN95_98]. Then double-
click the folder of the appropriate language for the operating system. Final-
ly, click [DISK1].

K Click [Open].

L Click [OK].

M Click to select the name of the printer whose driver you want to install, and
then click [Next].

N In the [Available ports:] box, click to select [Printer Port], and then click [Next].

O Change the name of the printer if you want, and then click [Next].

P Select whether or not you want to print a test page, and then click [Finish].

Q If you are asked whether you want to restart Windows, select [Yes]. If you
are not asked, restart Windows after completing the installation.

Setting up options

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

D Click the [Accessories] tab.

E In the [Options] group, select the option you have installed to the printer.

F Use the [Change settings for:] list box to select the appropriate setting for the
selected option.

G Click [Apply] to apply the settings you made.

H Repeat steps EEEE – GGGG for all options.

I After making all settings for options, click [OK].
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Windows 2000 - Installing the PostScript Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver requires Manage Printers permission. Members of

the Administrators, and Power Users groups have Manage Printers permis-
sion by default. When you install a printer driver, log on using an account
that has Manage Printers permission.

Important
❒ Be sure to install the PPD file for Windows 2000. Do not accidentally install

the PPD file for Windows 95/98/Me or Windows NT 4.0.

A Close all applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

C Double-click the [Add Printers] icon.

[Add Printer Wizard] starts.

D After confirming that the [Local Printer] option is selected, click [Next].

A dialog box for selecting the printer port appears.

E Check the check box of the port you want to use, and then click [Next].
A dialog box for selecting the printer manufacturer and model name appears.

F Click [Have Disk].

A dialog box for installing the driver from a disk appears.

G Hold down the left {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM
drive. Keep the left {{{{SHIFT}}}} key held down until the computer has finished
accessing the CD-ROM.

If the Auto Run program starts, click [Cancel].

H Change the drive name in the list box to the name of the CD-ROM drive,
and then click [Browse].

I In the [Folders:] box, double-click [DRIVERS], [PS], [WIN2000]. Then double-
click the folder of the appropriate language for the operating system. Final-
ly, click [DISK1].

J Click [Open].

K Click [OK].

A printer model selection dialog box appears.
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L Click to select the name of the printer whose driver you want to install, and
then click [Next].

A dialog box for changing the printer name appears.

M Change the name of the printer if you want, and then click [Next].

N Click [Next].

O In the next dialog box you will be asked to print a test page, select [No] and
then click [Next].

A confirmation dialog box appears.

P Confirm the settings you have set, and then click [Finish].

The installer copies the printer driver files from the CD-ROM to the compu-
ter's hard disk.

Q Set up the options with the printer driver.

R Restart the Windows.

Note
❒ Print a test page after completing installation.

Setting up options

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Device Settings] tab.

D Use the [Installable Options] group to select the options, and then select [In-
stalled] or [Not] Installed from the drop-down list box.

E Repeat steps DDDD for all options.

F After making all settings you want, click [OK].
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Windows NT 4.0 - Installing the PostScript Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver requires Full Control access permission. Members

of the Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default. When you install a printer
driver, log on using an account that has Full Control permission.

Important
❒ The CD-ROM containing the Windows NT Server operating system version

4.0, or the Windows NT Workstation operating system is required for install-
ing the printer driver.

❒ We recommend that you upgrade the Windows NT 4.0 operating system to
Service Pack 4 or later before installing the printer driver. Contact your Win-
dows retailer for more information about the latest version available.

❒ Be sure to install the PPD file for Windows NT 4.0. Do not accidentally install
the PPD file for Windows 95/98/Me or Windows 2000.

A Close all applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

C Double-click the [Add Printers] icon.

[Add Printer Wizard] starts.

D After confirming that the [My Computer] option is selected, click [Next].

A dialog box for selecting the printer port appears.

E Check the check box of the port you want to use, and then click [Next]

A dialog box for selecting the printer manufacturer and model name appears.

F Click [Have Disk].
A dialog box for installing the driver from a disk appears.

G Hold down the {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM
drive. Keep the {{{{SHIFT}}}} key held down until the computer has finished ac-
cessing the CD-ROM.
If the Auto Run program starts, click [Cancel].

H Change the drive name in the list box to the name of the CD-ROM drive,
and then click [Browse].
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I In the [Folders:] box, double-click [DRIVERS], [PS], [NT4]. Then double-click
the folder of the appropriate language for the operating system. Finally,
click [DISK1].

J Click [Open].

K Click [OK].
A printer model selection dialog box appears.

L Click to select the name of the printer whose driver you want to install, and
then click [Next].

A dialog box for changing the printer name appears.

M Change the name of the printer if you want, and then click [Next].

N Click [Next].

O In the next dialog box asking if you want to print a test page, select [No] and
then click [Finish].

The installer copies the printer driver files from the CD-ROM to the compu-
ter's hard disk.

Note
❒ Print a test page after completing installation and restarting Windows.

P If you are asked whether you want to restart Windows, select [Yes]. If you
are not asked, restart Windows after completing the installation.

Setting up options

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you setup op-
tions, log on using an account that has Full Control permission.

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

D Click the [Device Settings] tab.
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E In the [Installable Options] group, select the option you have installed to the
printer.

The current setting appears in the [Change Setting] box.

F Use the [Change Setting:] list to select the appropriate setting for the selected
option.

G Repeat steps EEEE – FFFF for all options.

H After making all option settings, click [OK].

----The conditions of the bidirectional transmissions
When the bidirectional transmissions is enabled, the information about the pa-
per size and feed direction settings are automatically sent to the computer by the
printer. You can also confirm the printer's condition from your computer.
• The bidirectional transmissions is supported by Windows 95/98/Me, Win-

dows 2000 and Windows NT 4.0.
• When the bidirectional transmissions is enabled on Windows 95/98/Me, the

unavailable functions are grayed out in the [Change Accessories] dialog box of
the printer properties. The [Change Accessories] dialog box is displayed by
clicking the [Change Accessories…] button in the [Printer Configuration] dialog
box. On Windows 2000 and Windows NT 4.0, the [Change Accessories] tab
does not appear in the printer properties.

To support the bidirectional transmissions, the following conditions below are
required.

❖❖❖❖ Connecting with the parallel interface cable and the USB exchange cable.
• The computer supports the bidirectional transmissions.
• The Interface cable supports the bidirectional transmissions.
• The printer is connected to the computer using the standard parallel inter-

face cable and the parallel connector. 
• On Windows 95/98/Me, the [Enable bi-directional support for this printer] is se-

lected in the [Spool Settings…] on the [Details] tab.
• On Windows 2000 and Windows NT 4.0, the [Enable bi-directional support] is

selected and [Enable printer spooling] is not selected on the [port] tab.

❖❖❖❖ Connecting with the network
• PortNavi or Multidirect Print and the TCP/IP protocol are used.
• On Windows 95/98/Me, the [Enable bi-directional support for this printer] is se-

lected in the [Spool Settings…] on the [Details] tab.
• On Windows 2000 and Windows NT 4.0, the [Enable bi-directional support] is

selected and [Enable printer spooling] is not selected on the [port] tab.
• PRINTER MANAGER FOR CLIENT included on the CD-ROM is installed.
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Using Adobe PageMaker Version 6.0 or 6.5

If you use the printer under Windows 95/98/Me, Windows 2000, Windows NT
4.0 with Adobe PageMaker, you need to copy the PPD file to the PageMaker
folder. 
The PPD file is the file with extension ".ppd". It is in the folder “DRIV-
ERS\PS\WIN95_98\(Language)\DISK1\” on the CD-ROM. 
The [WIN95_98] folder, inside the [PS] folder is for the Windows 95/98/Me oper-
ating system. Use the folder at this level that is appropriate for the operating sys-
tem you are using.
The third folder, "(Language)" may be substituted by an appropriate language
name. 
Copy this file to the PageMaker folder.
For PageMaker 6.0 default installation, the folder is "C:\PM6\RSRC\PPD4",
a n d  f o r  P a g e M ak er  6 . 5  d e f a u l t  i ns t a l l a t i o n ,  t he  d i re c t o r y  i s
"C:\PM65\RSRC\USENGLISH\PPD4". The "USENGLISH" may differ de-
pending on your language selection.

Reference
For more information about the language name, see P.45 “Installing by Auto
Run”.
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Macintosh

Macintosh - Installing the PostScript Printer Driver

It is necessary to install a printer driver and a PPD file to print from a Macintosh.
Follow these steps to install a printer driver and a PPD file into a Macintosh us-
ing a system 7.6.1 or later operating system.

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM icon.

C Double-click the [PS] folder.

D Double-click the folder of the language you use.

E Open [DISK1] and double-click the installer icon.

F Follow the instructions on the screen.

G Double-click [Extensions].

H Double-click [Printer Descriptions].

I Double-click the CD-ROM icon on the desktop.

J Double-click [DISK1] in the folder of the language you use.

K Click and drag the PPD file into [Printer Descriptions].

L Click and drag the “Plugin” file into [Printer Descriptions] in [Extensions] in
[System Folder].

M Restart the Macintosh.
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Setting Up the PPD File

Preparation
Confirm that the printer is connected to an AppleTalk network before per-
forming the following procedure.

A On the [Apple] menu, select [Chooser].

B Click the [Adobe PS] icon.

C In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

D Click [Create].

E Click the printer you want to use, and then click [Select].

The PPD file is set up, and the [Adobe PS] icon appears at the left of the printer
name in the list. Next, follow the procedure on P.64 “Setting Up Options” to
make the option settings, or close the [Chooser] dialog box.

Setting Up Options

A On the [Apple] menu, select [Chooser].

B Click the [Adobe PS] icon.

C In the [Select the PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup].

D Click [Configure].

A list of options appears.

E Select the option you want to set up and select the appropriate setting for it.

Note
❒ If the option you want to set up is not displayed, the PPD file might not be

set up correctly. Check the name of the PPD file shown in the dialog box.

F Click [OK].
The list of options closes.

G Click [OK].

The [Chooser] dialog box appears.

H Close the [Chooser] dialog box.



INDEX

1394 Interface Unit Type 2600,   13, 14, 31
1-bin Shift Sort Tray Type 2600,   13, 17

A

Access Control Address,   37, 41
Access Control Mask,   37, 41
AD410,   12, 20
Agfa Font Manager,   4
Auto Run,   45

B

Bypass Tray,   6
Bypass Tray Extension,   6

C

Caution,   ii
Controller Board,   7
CS380,   13, 19

D

Data In indicator,   9

E

Enter key,   10
Envelope Feeder Type 2600,   12, 16
Error indicator,   9
Escape key,   10
Ethernet,   37

F

Form Feed key,   9
Frame type NetWare,   37
Front Cover,   8
Front Cover Release Buttons,   7
Fusing Unit,   8
Fusing Unit Lock Levers,   8

G

Gateway Address,   37, 41
Guide Board,   8

H

Hard Disk Drive Type 2600,   13, 14, 24

I

IP address,   37

J

Job Reset key,   9

M

Memory Unit TypeB 64MB,   13, 14, 22
Menu key,   9

N

Network,   37
Network Boot,   37
Network Interface Board 

Operating Instructions,   v
Network Interface Board Type 2600,   13, 27

O

On Line key,   9
Operation Panel,   7, 9
Options,   11
options, available,   12
options, installing,   15
Output Tray,   7
Output Tray Extension,   7
65



66
P

PageMaker 6.0 or 6.5,   62
Panel display,   9
Paper Exit Cover,   7
Paper Feed Unit Type 2600,   12, 15
Paper Size Dial,   6
Paper Tray,   7
PCL 5e,   2
PCL 6,   2
PCL 6/5e

Windows 2000, Install,   47
Windows 95/98/Me, Install,   46
Windows NT 4.0, Install,   49

PortNavi,   5
PostScript,   3

Macintosh, Install,   63
Windows 2000, install,   57
Windows 95/98/Me, install,   55
Windows NT 4.0, install,   59

PostScript printer driver,   55
Power indicator,   9
Power Switch,   7
printer driver,   2
PRINTER MANAGER FOR 

ADMINISTRATOR,   4
PRINTER MANAGER FOR CLIENT,   4
Printer Reference,   v

Q

Quick Installation Guide,   v

R

Rear Cover,   7
Registration Roller,   8
RPCS

Windows 2000, Install,   52
Windows 95/98/Me, Install,   51
Windows NT 4.0, Install,   54

S

Setup Guide,   v
Standard Tray,   7
Subnet Mask,   37, 41

T

Toner Cartridge,   8
Transfer Roller,   8
Transfer Roller Cover,   8
Type 1 Printer,   1
Type 2 Printer,   1

U

Upper Cover,   7

V

Ventilator,   7

W

Warning,   ii
Windows 2000

PCL 6/5e, Install,   47
PostScript, Install,   57
RPCS, Install,   52

Windows 95/98/Me
PCL 6/5e, Install,   46
PostScript, Install,   55
RPCS, Install,   51

Windows NT 4.0
PCL 6/5e, Install,   49
PostScript, Install,   59
RPCS, Install,   54



67

MEMO



68 UE USA G058

MEMO



Note to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Warning
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution (in case of 100BaseTX environment):
Properly shielded and grounded cables (STP) and connectors must be used for connections to host
computer (and/or peripheral) in order to meet FCC emission limits.

Declaration of Conformity
Product Name: Laser Printer
Model Number: RICOH LASER AP2600
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Properly shielded cables must be used for connections to host computer (and/or peripheral)
in order to meet FCC emission limits.
Network interface cable with ferrite core must be used for RF interference suppression.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

In accordance with IEC 60417, this machine uses the following symbols for the main power switch: 
aaaa means POWER ON.
bbbb means POWER OFF.
Copyright © 2000 Ricoh Co., Ltd.
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Operating Instructions

Printer Reference
Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.



Introduction
This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.
Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Notes:
The actual names of the following applications do not appear on the following pages. Check the model
name of the printer before reading this manual.

Descriptions without the note for identifying the type of the printer are common for both models. Certain
types might not be available in some countries. For more information, please contact your local dealer.
The actual names of the following applications do not appear on the following pages. Confirm which
applications you will be using before reading this manual.

Consumable:

Power Source
RICOH LASER AP2600: 120 V, 60 Hz, 8.4 A or more
RICOH LASER AP2600N: 120 V, 60 Hz, 8.4 A or more
Please be sure to connect the power cord to a power source as above.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Operator Safety:
This machine is considered a CDRH class I laser device, safe for office/ EDP use. The machine con-
tains 5-milliwatt, 760 - 800 nanometer wavelength, GaAIAs laser diode. Direct (or indirect reflected) eye
contact with the laser beam might cause serious eye damage. Safety precautions and interlock mech-
anisms have been designed to prevent any possible laser beam exposure to the operator. 

Laser Safety:
The Center for Devices and Radiological Health (CDRH) prohibits the repair of laser-based optical unit
in the field. The optical housing unit can only be repaired in a factory or at a location with the requisite
equipment. The laser subsystem is replaceable in the field by a qualified Customer Engineer. The laser
chassis is not repairable in the field. Customer engineers are therefore directed to return all chassis
and laser subsystems to the factory or service depot when replacement or the optical subsystem is re-
quired.

Important
Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Caution:
Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Do not attempt any maintenance or troubleshooting other than that mentioned in this manual. This
printer contains a laser beam generator and direct exposure to laser beams can cause permanent eye
damage.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good copy quality, Ricoh recommends that you use genuine Ricoh toner.

Ricoh shall not be responsible for any damage or expense that might result from the use of parts other
than genuine Ricoh parts in your Ricoh office product. 

Descriptions in this manual Model name
Type 1 Printer RICOH LASER AP2600
Type 2 Printer RICOH LASER AP2600N

Descriptions in this manual Application
PRINTER MANAGER FOR ADMINISTRATOR Aficio Manager for Admin
PRINTER MANAGER FOR CLIENT Aficio Manager for Client

Consumable Name
Toner RICOH LP TONER CARTRIDGE Type 100 

BLACK

Consumable Compornents
MAINTENANCE KIT Type 2600 Friction Pads, Paper Feed Rollers, Transfer 

Roller, Fusing Unit



Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Micro-
soft Corporation in the United States and/or other countries.
Adobe®, PostScript®, Acrobat® and PageMaker® are registered trademark of
Adobe Systems Incorporated.
PCL® is a registered trademark of Hewlett-Packard Company.
AppleTalk, Apple, Macintosh and TrueType are registered trademarks of Apple
Computer, Incorporated.
IPS-PRINT™ Printer Language Emulation© Copyright 1999-2000, XIONICS
DOCUMENT TECHNOLOGIES, INC., All Rights Reserved.
Ethernet® is a registered trademark of Xerox Corporation.
Other product names used herein are for identification purposes only and might
be trademarks of their respective companies. We disclaim any and all rights in
those marks.

Notes:

Some illustrations might be slightly different from your machine.
Certain options might not be available in some countries. For details, please con-
tact your local dealer.

Note

The proper names of the Windows operating systems are as follows:
• Microsoft® Windows® 95 operating system
• Microsoft® Windows® 98 operating system
• Microsoft® Windows® Millennium Edition (Windows Me)
• Microsoft® Windows® 2000 Professional
• Microsoft® Windows® 2000 Server
• Microsoft® Windows NT® Server operating system Version 4.0
• Microsoft® Windows NT® Workstation operating system Version 4.0
i
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Safety Information

When using your printer, the following safety precautions should always be fol-
lowed.

Safety During Operation

In this manual, the following important symbols are used: 

R WARNING:

 

R WARNING:
Indicates a potentially hazardous situation which, if instructions 
are not followed, could result in death or serious injury.

R CAUTION:
Indicates a potentially hazardous situation which, if instructions are 
not followed, may result in minor or moderate injury or damage to 
property.

• Connect the power cord directly into a wall outlet and never use an ex-
tension cord.

• Disconnect the power plug (by pulling the plug, not the cable) if the 
power cable or plug becomes frayed or otherwise damaged.

• To avoid hazardous electric shock or laser radiation exposure, do not 
remove any covers or screws other than those specified in this man-
ual.

• Turn off the power and disconnect the power plug (by pulling the plug, 
not the cable) if any of the following conditions exists:

• You spill something into the equipment.

• You suspect that your equipment needs service or repair.

• Your equipment's cover has been damaged.

• Do not incinerate spilled toner or used toner. Toner dust might ignite 
when exposed to an open flame.

• Disposal can take place at our authorized dealer or at appropriate col-
lection sites.

• Dispose of the used toner cartridge in accordance with the local reg-
ulation.



R CAUTION:

 
• Protect the equipment from dampness or wet weather, such as rain, snow, 

and so on.

• Unplug the power cord from the wall outlet before you move the equipment. 
While moving the equipment, you should take care that the power cord will 
not be damaged under the equipment.

• When you disconnect the power plug from the wall outlet, always pull  the 
plug (not the cable).

• Do not allow paper clips, staples, or other small metallic objects to fall inside 
the equipment.

• Keep toner (used or unused) and toner cartridge out of the reach of chil-
dren.

• For environmental reasons, do not dispose of the equipment or expended 
supply waste at household waste collection points. Disposal can take place 
at an authorized dealer or at appropriate collection sites.

• The inside of the machine could be very hot. Do not touch the parts with a 
label indicating the “hot surface”. Otherwise it could cause a personal burn.

• Our products are engineered to meet high standards of quality and function-
ality, and we recommend that you only use the expendable supplies avail-
able at an authorized dealer.
iii
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ENERGY STAR Program

• Energy Saver mode
This printer automatically lowers its power consumption 15 minutes after the
last operation has been completed. To exit Energy Saver mode, press any key
on the operation panel. To change the setting of the Energy Saver mode, see
P.115 “System Menu”.

❖❖❖❖ Specifications

----Recycled Paper
In accordance with the ENERGY STAR Program, we recommend use of recycled
paper which is environment friendly. Please contact your sales representative
for recommended paper.

As an ENERGY STAR Partner, we have determined 
that this machine model meets the ENERGY STAR 
Guidelines for energy efficiency.

The ENERGY STAR Guidelines intend to establish an international energy-saving system for 
developing and introducing energy-efficient office equipment to deal with environmental is-
sues, such as global warming.

When a product meets the ENERGY STAR Guidelines for energy efficiency, the Partner shall 
place the ENERGY STAR logo onto the machine model.

This product was designed to reduce the environmental impact associated with office equip-
ment by means of energy-saving features, such as Low-power mode.

Energy Saver mode Power Consumption 17 W

Default Time 30 minutes



Manuals for This Printer

Manuals for This Printer

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this printer, all users should read and
follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide 
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

❖❖❖❖ Printer Reference (this manual)
Provides information about using the printer and its options. This manual
provided as a PDF file on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Network Interface Board Operating Instructions
Provides information about setting up and using the printer in a network en-
vironment. This manual provided as a PDF file on the CD-ROM labeled “Op-
erating Instructions”.

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features for the PostScript 3 printer driver. This
manual provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions”.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

Note
❒ There are two CD-ROMs that come with this printer. One is labeled "Operat-

ing Instructions" and the other is "Drivers and Utilities".
v
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.
Keys on the computer's keyboard.
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1. Setting Up the Printer Driver
and Canceling a Print Job
PCL 6/5e - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

Changing the default printer settings

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The Printer Properties appear.

D Make any settings you require and click [OK].

Note
❒ With some applications, the printer driver's settings are not used, and the

application's own default settings are applied.

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows 95/98/Me.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list box, and then click [Properties].
The [Printer Properties] dialog box appears.

C Make any settings you require and click [OK].

D Click [OK] to start printing.
1
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Windows 2000 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default setting you want to change.

C On the [File] menu, click [Properties].

The Printer Properties appear.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Changing the default printer settings – Printing Preferences Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties appears.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.



PCL 6/5e - Accessing the Printer Properties

1

Making printer settings from an application

To make the printer settings for a specific application, open the [Print] dialog box
from that application. The following example describes how to make settings for
the WordPad application that comes with Windows 2000.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

differ depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] box.

C Make any settings you require and click [Apply] to start printing.

Windows NT 4.0 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission. 

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].
The Printer Properties appears.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
3
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Changing the default printer settings – Default Document Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Document Defaults].

The Default Document Properties appear.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list box, and then click [Properties].

The Printer Properties appears.

C Make any settings you require and click [OK].

D Click [OK] to start printing.
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RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

Changing the default printer settings

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The printer properties appear.

D Make any settings you require and click [OK].

Note
❒ With some applications, the printer driver's settings are not used, and the

application's own default settings are applied.

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows 95/98/Me.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list box, and then click [Properties].

The [Printer Properties] dialog box appears.

C Make any settings you require and click [OK].

D Click [OK] to start printing.
5
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Windows 2000 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The Printer Properties appears.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Changing the default printer settings – Printing Preferences Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties appear.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the [Print] dialog box
from that application. The following example describes how to make settings for
the WordPad application that comes with Windows 2000.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

differ depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] box.

C Make any settings you require and click [Apply] to start printing.

Windows NT 4.0 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission. 

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
7
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Changing the default printer settings – Default Document Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click to select the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults].

The Default Document Properties appear.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list box, and then click [Properties].

The [Printer Properties] dialog box appears.

C Make any settings you require and click [OK].

D Click [OK] to start printing.
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Windows 95/98/Me - Accessing the Printer Properties

Changing the default printer settings

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

D Make any settings you require and click [OK].

E Click [OK].

Note
❒ With some applications, the printer driver's settings are not used, and the

application's own default settings are applied.

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows 95/98/Me.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B Select the printer you want to use in the Name list box, and then click [Properties].
The [Printer Properties] dialog box appears.

C Make any settings you require and click [OK].

D Click [OK] to start printing.
9
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Windows 2000 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appear.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Changing the default printer settings – Printing Preferences Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties appears.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the [Print] dialog box
from that application. The following example describes how to make settings for
the WordPad application that comes with Windows 2000.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

differ depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] box.

C Make any settings you require and click [Print] to start printing.

D Click [OK] to start printing.

Windows NT 4.0 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears .

B Click to select the icon of the printer whose default settings you want to change.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

D Make any settings you require and click [OK].

Note
❒ Setting you make here are used as the default settings for all applications.
11
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Changing the default printer settings - Default Document Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click to select the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults].

The Default Document Properties appear.

D Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list box, and then click [Properties].

The [Printer Properties] dialog box appears.

C Make any settings you require and click [OK].

D Click [OK] to start printing.
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Macintosh - Setting Up for Printing

Making paper settings from an application

A Open the file you want to print.

B On the [File] menu, click [Page Setup].
The [AdobePS Page Setup] dialog box appears.

C Confirm that the printer you want to use is shown in [Format for:] box.

Note
❒ If the printer is not shown in the [Format for:] box, use the pop-up menu to

display a list of available printers.

Reference
The actual appearance of the Page Setup depends on the application you
are using. See the documentation that comes with the Macintosh for more
information.

D From the [Paper:] box, select the paper size.

E Make any settings you require and click [OK].

Setting up for printing from an application

A Open the file you want to print.

B On the [File] menu, click [Print].

The Printer Settings appears.

C Confirm that the printer is selected in the [Printer :] box.

D Make any settings you require and click [Print] to start printing.
13
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Canceling a Print Job

Windows 95/98/Me - Canceling a Print Job 

A Double-click the printer icon on the Windows taskbar.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing]. 

Note
❒ You can also open the print job queue window by double-clicking the

printer icon in the [Printer] window.

D Press {{{{Job Reset}}}} on the operation panel.

The message appears on the panel display indicating that the print job is be-
ing canceled. 

Important
❒ This procedure cancels the print job that is being processed by the printer.

In some cases, the printer may already be processing data for the next print
job following the one currently being output. In this case, the next print job
is also canceled when you press {Job Reset}.

❒ When the printer is being shared by multiple computers, be careful not to
accidentally cancel someone else's print job.

Note
❒ You cannot stop printing data that has already been processed internally

by the printer. Because of this, printing may continue for a few pages after
you press {Job Reset}.

❒ A print job that contains a large volume of data may take considerable time
to stop.
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Windows 2000 - Canceling a Print Job

A Double-click the printer icon on the taskbar.
A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing]. 

Note
❒ You can also open the print job queue window by double-clicking the

printer icon in the [Printers] window.

D Press {{{{Job Reset}}}} on the operation panel.

The message appears on the panel display indicating that the print job is be-
ing canceled. 

Important
❒ This procedure cancels the print job that is being processed by the printer.

In some cases, the printer may already be processing data for the next print
job following the one currently being output. In this case, the next print job
is also canceled when you press {Job Reset}.

❒ When the printer is being shared by multiple computers, be careful not to
accidentally cancel someone else's print job.

Note
❒ You cannot stop printing data that has already been processed internally

by the printer. Because of this, printing might continue for a few pages af-
ter you press {Job Reset}.

❒ A print job that contains a large volume of data might take considerable
time to stop.
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Windows NT 4.0 - Canceling a Print Job

A Double-click the printer icon on the Windows taskbar.
A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel. 

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing]. 

Note
❒ You can also open the print job queue window by double-clicking the

printer icon in the [Printer] window.

D Press {{{{Job Reset}}}} on the operation panel.

The message appears on the panel display indicating that the print job is be-
ing canceled. 

Important
❒ The procedure cancels the print job that is being processed by the printer.

In some cases, the printer may already be processing data for the next print
job following the one currently being output. In this case, the next print job
is also canceled when you press {Job Reset}.

❒ When the printer is being shared by multiple computers, be careful not to
accidentally cancel someone else's print job.

Note
❒ You cannot stop printing data that has already been processed internally

by the printer. Because of this, printing may continue for a few pages after
you press {Job Reset}.

❒ A print job that contains a large volume of data may take considerable time
to stop.
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Macintosh - Canceling a Print Job

A Double-click the printer's icon on the desktop.
A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

B Select the name of the job you want to cancel.

C Click the pause icon, and then click the trash icon,

D Press {{{{Job Reset}}}} on the operation panel.

The message appears on the panel display indicating that the print job is be-
ing canceled.

Important
❒ This procedure cancels the print job that is being processed by the printer.

In some case, the printer may already be processing data for the next print
job following the one currently being output. In this case, the next print job
is also canceled when you press {Job Reset}.

❒ When the printer is being shared by multiple computers, be careful not to
accidentally cancel someone else's print job.

Note
❒ You cannot stop printing data that has already been processed internally

by the printer. Because of this, printing may continue for a few pages after
you press {Job Reset}.

❒ A print job that contains a large volume of data may take considerable time
to stop.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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2. Uninstalling the Printer
Driver and Software
Uninstalling the PCL 6/5e Printer Driver

This section describes how to uninstall the printer driver. The actual procedure
may differ depending on the operating system.
Follow one of the appropriate procedures below.

Windows 95/98/Me - Uninstalling the PCL 6/5e Printer Driver

A Close all the applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

C Click to select the icon of the printer you want to remove.

D On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

E Click [Yes] to uninstall the printer driver.

Windows 2000 - Uninstalling the PCL 6/5e Printer Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

A Close all the applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

C Click to select the icon of the printer you want to remove.

D On the [File] menu, click [Delete].

A confirmation dialog box appears. 

E Click [Yes] to uninstall the printer driver.
19
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Windows NT 4.0 - Uninstalling the PCL 6/5e Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you install a
printer driver, log on using an account that has Full Control permission.

A Close all applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

C Click to select the icon of the printer you want to remove.

D On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

E Click [Yes] to uninstall the printer driver.



Uninstalling the RPCS Printer Driver

2

Uninstalling the RPCS Printer Driver

This section describes how to uninstall the printer driver. The actual procedure
may differ depending on the operating system.
Follow one of the appropriate procedures below.

Windows 95/98/Me - Uninstalling the RPCS Printer Driver

A Close all the applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

C Click to select the icon of the printer you want to remove.

D On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

E Click [Yes] to uninstall the printer driver.

Windows 2000 - Uninstalling the RPCS Printer Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

A Close all the applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and click [Printers].
The [Printers] window appears.

C Click to select the icon of the printer you want to remove.

D On the [File] menu, click [Delete].
A confirmation dialog box appears. 

E Click [Yes] to uninstall the printer driver.
21
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Windows NT 4.0 - Uninstalling the RPCS Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you install a
printer driver, log on using an account that has Full Control permission.

A Close all applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

C Click to select the icon of the printer you want to remove.

D On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

E Click [Yes] to uninstall the printer driver.
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Uninstalling the PostScript Printer Driver

This section describes how to uninstall the PostScript printer driver.
The actual procedure may differ depending on the operating system.
Follow one of the appropriate one of the following procedures below.

Windows 95/98/Me - Uninstalling the PostScript Printer Driver

A Close all applications that are currently running. 

B Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

C Click to select the icon of the printer you want to remove. 

D On the [File] menu, click [Delete].
A confirmation dialog box appears.

E Click [Yes] to uninstall the printer driver.

Windows 2000 - Uninstalling the PostScript Printer Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

A Close all the applications that are currently running.

B Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

C Click to select the icon of the printer you want to remove.

D On the [File] menu, click [Delete].

A confirmation dialog box appears. 

E Click [Yes] to uninstall the printer driver.
23
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Windows NT 4.0 - Uninstalling the PostScript Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you uninstall a
printer driver, log on using an account that has Full Control permission.

A Close all applications that are currently running. 

B Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

C Click to select the icon of the printer you want to remove. 

D On the [File] menu, click [Delete].

A confirmation dialog box appears.

E Click [Yes] to uninstall the printer driver.

Macintosh - Uninstalling the PostScript Printer Driver

A Drag the “AdobePS” file from the [Extensions] folder in [System Folder] to
[Trash].

B Drag the PPD file and plug-in file from the [Printer Descriptions] folder in the
[Extensions] folder in [System Folder] to [Trash].



3. Paper and Other Media
Paper and Other Media Supported by This 
Printer

Paper Types and Sizes

This section describes the type, size, feed direction, and maximum amount of pa-
per that can be loaded into each paper tray in this printer.

Important
❒ If you use damp or curled paper, a misfeed might occur. In this case, try turn-

ing over the paper stack in the paper tray. If there is no improvement, change
to paper with less curl.

Note
❒ The following symbols and terminology are used to represent the feed direction.

❒ It is recommended that you load paper of the size and direction you frequent-
ly use in the tray selected with “Tray Priority”. For more information about
Tray Priority, see P.103 “Paper Input Menu”.

❒ When loading paper of the same size in more than one tray, it is recommend-
ed that you load paper in the same direction in each tray.

Reference
For more information about loading each type of paper, see P.38 “Loading Pa-
per and Other Media”.

Important
❒ Be sure to set the paper size dial to match the actual paper size loaded in the

tray. When the actual paper size is not shown on the dial, set the dial to “p”
and select the paper size using the operation panel.

❒ For Tray 1, 2 and 3, the dial setting overrides the setting made with the oper-
ation panel. 

❒ The optional Envelope Feeder Unit requires the installation of the optional
Paper Feed Unit. Up to two Paper Feed Units can be installed to the printer at
the same time. The Envelope Feeder Unit must be used in the top-most Paper
Feed Unit (tray2).

In this manual On the panel display Paper feed direction

K ↑ (Feed direction)
A4 (210 × 297)

Letter (81/2"×11")
Short-edge feed direction

L ↑ (Feed direction)
A4 (297 × 210)

Letter (11" × 81/2")
Long-edge feed direction
25
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Note
❒ The printable paper size depends on the memory size of the printer and print

data, see P.139 “Memory Capacity and Paper Size”.
❒ For more information about the meanings of the abbreviations, see the notes

at the bottom of each table.

❖❖❖❖ Input Paper Sizes (Metric version)
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A3 K 297 × 420 ❍ ✩ ✩ X

B4 JIS K 257 × 364 ❍ � � X

A4 K 210 × 297 ❍ ✩ ✩ X

L 297 × 210 ❍ ✩ ✩ X

B5 JIS K 182 × 257 ❍ � � X

L 257 × 182 ❍ � � X

A5 K 148 × 210 ❍ X X X

L 210 × 148 ❍ ✩ � X

B6 JIS K 128 × 182 ❍ X X X

A6 K 105 × 148 ❍ X X X

Double Letter (DLT, 11" × 17") K 279 × 432 ❍ � ✩ X

Legal (LG, 81/2" × 14") K 216 × 356 ❍ � ✩ X

Letter (LT, 81/2" × 11") K 216 × 279 ❍ ✩ ✩ X

L 279 × 216 ❍ ✩ ✩ X

Half Letter (HLT, 51/2" × 81/2") K 140 × 216 ❍ X X X

Executive (Exec., 71/4" × 101/2") K 184 × 276 ❍ � � X

L 276 × 184 ❍ � � X

Folio (81/4" × 13") K 210 × 330 ❍ � � X

Foolscap (F4, 81/2" × 13") K 216 × 330 ❍ ✩ � X

F/GL (8" × 13") K 203 × 330 ❍ � � X

Com#10 Env (41/8" × 91/2") K 104.8 × 241.3 ❍ X X ❍

C5 Env (6.38" × 9.02") K 162 ×229 ❍ X X ❍
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• ❍ means that the size is supported but the paper size should be set with the
operation panel. There is no dial on the tray.
⇒ P.41 “Loading Paper in the Bypass Tray”
⇒ P.46 “Loading envelopes into the Envelope Feeder Unit”

• ✩ means that the size is supported and indicated on the tray dial. Be sure to
set the paper size dial to match the actual paper size loaded in the tray.

• � means that the size is supported but not indicated on the tray dial. You
should set the tray dial to “p”, and select the paper size with the operation
panel.

• ❍* means that the supported size is approximately 90 - 305 mm in width, and
approximately 148 - 432 mm in length. The supported size may differ de-
pending on the printer language you use. Use the printer driver to set the cus-
tom size. Set the custom size setting with the operation panel.

• X means that the size is not supported.

C6 Env (4.49" × 6.38") K 114 ×162 ❍ X X ❍

DL Env (4.33" × 8.66") K 110 × 220 ❍ X X ❍

Monarch Env (37/8" × 71/2") K 98.4 × 190.5 ❍ X X ❍

Custom Size — — ❍* X X X

8K (101/2" × 15.35") K 267 × 390 ❍ X X X

16K (7.68" × 101/2") K 195 × 267 ❍ X X X

L 267 × 195 ❍ X X X
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❖❖❖❖ Input Paper Sizes (Inch version)
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Double Letter (DLT) K 11" × 17" ❍ � ✩ X

Legal (LG) K 81/2" × 14" ❍ � ✩ X

Letter (LT) K 81/2" × 11" ❍ ✩ ✩ X

L 11" × 81/2" ❍ ✩ ✩ X

Half Letter (HLT) K 51/2" × 81/2" ❍ X X X

Executive (Exec.) K 71/4" × 101/2" ❍ � � X

L 101/2" × 71/4" ❍ � � X

A3 K 11.26" × 16.54" ❍ ✩ ✩ X

B4 JIS K 10.12" × 14.33" ❍ � � X

A4 K 8.26" × 5.83" ❍ ✩ ✩ X

L 5.83" × 8.26" ❍ ✩ ✩ X

B5 JIS K 7.17" × 10.12" ❍ � � X

L 10.12” × 7.17" ❍ � � X

A5 K 5.83" × 8.26" ❍ X X X

L 8.26" × 5.83" ❍ ✩ � X

B6 JIS K 5.04" × 7.17" ❍ X X X

A6 K 4.13" × 5.63" ❍ X X X

Folio K 81/4" × 13" ❍ � � X

Foolscap F4 K 81/2" × 13" ❍ ✩ � X

F/GL K 8" × 13" ❍ � � X

Com#10 Env K 41/8" × 91/2" ❍ X X ❍

C5 Env K 6.38" × 9.02" ❍ X X ❍

C6 Env K 4.49" × 6.38" ❍ X X ❍

DL Env K 4.33" × 8.66" ❍ X X ❍

Monarch Env K 37/8" × 71/2" ❍ X X ❍

Custom Size — — ❍* X X X
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• ❍ means that the size is supported but the paper size should be set with the
operation panel. There is no dial on the tray.
⇒ P.41 “Loading Paper in the Bypass Tray”
⇒ P.46 “Loading envelopes into the Envelope Feeder Unit”

• ✩ means that the size is supported and indicated on the tray dial. Be sure to
set the paper size dial to match the actual paper size loaded in the tray.

• � means that the size is supported but not indicated on the tray dial. You
should set the tray dial to “p”, and select the paper size with the operation
panel.

• ❍* means that the supported size is approximately 3.55” - 12.00” in width,
and approximately 5.83” - 17.00” in length. The supported size may differ de-
pending on the printer language you use. Use the printer driver to set the cus-
tom size. Set the custom size setting with the operation panel.

• X means that the size is not supported.

❖❖❖❖ Paper weight and number of sheets to be set

*1 Confirm that the top of the stack is not higher than the limit mark indicated on the
side fence of the tray.

*2 The Envelope Feeder Unit requires the installation of the optional Paper Feed Unit.

8K K 101/2" × 15.35" ❍ X X X

16K K 7.68" × 101/2" ❍ X X X

L 101/2" × 7.68" ❍ X X X

Supported paper weight
Maximum number of 
sheets (plain paper) *1 

Paper Tray 60 - 105 g/m2 (16 - 28 lb) 250 (80 g/m2, 20 lb)

Paper Feed Unit Type 2600 (option) 60 - 105 g/m2 (16 - 28 lb) 500 (80 g/m2, 20 lb)

Bypass Tray 52 - 162 g/m2 (14 - 42 lb) 100 (80 g/m2, 20 lb)

For other kind of papers, 
see P.34 “Types of Paper and 
Other Media”.

Envelope Feeder Type 2600 *2 P.34 “Types of Paper and Other Media”.

Fe
ed

 d
ir

ec
ti

on

S
iz

e 
(i

n
ch

)

B
yp

as
s 

T
ra

y

P
ap

er
 T

ra
y 

(T
ra

y1
)

P
ap

er
 F

ee
d

 U
n

it
 (T

ra
y 

2/
3)

E
n

ve
lo

p
e 

Fe
ed

er
 U

n
it
29



Paper and Other Media

30

3

❖❖❖❖ Output Paper Sizes (Metric version)
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A3 K 297 × 420 ❍ ❍ ❍ ❍

B4 JIS K 257 × 364 ❍ ❍ ❍ ❍

A4 K 210 × 297 ❍ ❍ ❍ ❍

L 297 × 210 ❍ ❍ ❍ ❍

B5 JIS K 182 × 257 ❍ ❍ ❍ ❍

L 257 × 182 ❍ ❍ ❍ ❍

A5 K 148 × 210 ❍ X X X

L 210 × 148 ❍ ❍ ❍ ❍

B6 JIS K 128 × 182 ❍ X X X

A6 K 105 × 148 ❍ X X X

Double Letter (DLT, 11" × 17") K 279 × 432 ❍ ❍ ❍ ❍

Legal (LG, 81/2" × 14") K 216 × 356 ❍ ❍ ❍ ❍

Letter (LT, 81/2" × 11") K 216 × 279 ❍ ❍ ❍ ❍

L 279 × 216 ❍ ❍ ❍ ❍

Half Letter (HLT, 51/2" × 81/
2")

K 140 × 216 ❍ X X X

Executive (Exec., 71/4" × 101/
2")

K 184 × 276 ❍ X ❍ ❍

L 276 × 184 ❍ X ❍ ❍

Folio (81/4" × 13") K 210 × 330 ❍ X ❍ ❍

Foolscap (F4, 81/2" × 13") K 216 × 330 ❍ X ❍ ❍

F/GL (8" × 13") K 203 × 330 ❍ X ❍ ❍

Com#10 Env (41/8" × 91/2") K 104.8 × 241.3 ❍ X X X

CA Env (6.38" × 9.02") K 162 ×229 ❍ X X X

C6 Env (4.49" × 6.38") K 114 ×162 ❍ X X X

DL Env (4.33" × 8.66") K 110 × 220 ❍ X X X

Monarch Env (37/8" × 71/2") K 98.4 × 190.5 ❍ X X X
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• ❍ means that the size is supported.
• X means that the size is not supported.

Custom Size — — ❍ X X X

8K (101/2" × 15.35") K 267 × 390 ❍ ❍ ❍ ❍

16K (7.68" × 101/2") K 195 × 267 ❍ ❍ ❍ ❍

L 267 × 195 ❍ ❍ ❍ ❍
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❖❖❖❖ Output Paper Sizes (Inch version)
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Double Letter (DLT) K 11" × 17" ❍ ❍ ❍ ❍

Legal (LG) K 81/2" × 14" ❍ ❍ ❍ ❍

Letter (LT) K 81/2" × 11" ❍ ❍ ❍ ❍

L 11" × 81/2" ❍ ❍ ❍ ❍

Half Letter (HLT) K 51/2" × 81/2" ❍ X X X

Executive (Exec.) K 71/4" × 101/2" ❍ X ❍ ❍

L 101/2" × 71/4" ❍ X ❍ ❍

A3 K 11.26" × 16.54" ❍ ❍ ❍ ❍

B4 JIS K 10.12" × 14.33" ❍ ❍ ❍ ❍

A4 K 8.26" × 5.83" ❍ ❍ ❍ ❍

L 5.83" × 8.26" ❍ ❍ ❍ ❍

B5 JIS K 7.17" × 10.12" ❍ ❍ ❍ ❍

L 10.12” × 7.17" ❍ ❍ ❍ ❍

A5 K 5.83" × 8.26" ❍ X X X

L 8.26" × 5.83" ❍ ❍ ❍ ❍

B6 JIS K 5.04" × 7.17" ❍ X X X

A6 K 4.13" × 5.63" ❍ X X X

Folio K 81/4" × 13" ❍ X ❍ ❍

Foolscap F4 K 81/2" × 13" ❍ X ❍ ❍

F/GL K 8" × 13" ❍ X ❍ ❍

Com#10 Env K 41/8" × 91/2" ❍ X X X

C6 Env K 4.49" 6.38" ❍ X X X

C5 Env K 6.38" × 9.02" ❍ X X X

DL Env K 4.33" × 8.66" ❍ X X X

Monarch Env K 37/8" × 71/2" ❍ X X X
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• ❍ means that the size is supported and that the paper size should be set with
the operation panel. There is no dial on the tray.

• X means that the size is not supported.

Paper Recommendations

Note the following suggestions when handling or selecting paper used with this
printer.

Loading Paper

• Confirm the paper types of the printer. For more information, see P.34 “Types
of Paper and Other Media”. Print quality cannot be guaranteed if other paper
types are used.

• Do not use paper that is already printed on. 
• If you load paper into the paper tray, be sure not to stack over the limit mark.
• If you load paper onto the bypass tray, be sure that paper fits under the side

guide.
• If you load paper into the paper tray, confirm that the print side is facing

down.
• If you load paper onto the bypass tray, confirm that the print side is facing up.

Custom Size — — ❍ X X X

8K K 101/2" × 15.35" ❍ ❍ ❍ ❍

16K K 7.68" × 101/2" ❍ ❍ ❍ ❍

L 101/2" × 7.68" ❍ ❍ ❍ ❍
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Storing Paper

Paper should always be stored properly. Improperly stored paper might result
in poor print quality, paper misfeeds or printer damage.
Recommendations are as follows:
• Avoid storing paper in humid areas.
• Avoid exposing paper to direct sunlight.
• Store on a flat surface.
• Keep open reams of paper in the package in which the paper came.

Types of Paper and Other Media

❖❖❖❖ Plain paper
• If you print on paper heavier than 155 g/m2 (41 lb), use the bypass tray.

The bypass tray can hold paper up to 162 g/m2 (43 lb) in weight.
• If you load paper heavier than 155 g/m2 (41 lb) onto the bypass tray, set

the printer to Thick Paper mode using the operation panel. 
• If paper is curled or bent, correct it before loading.

❖❖❖❖ OHP transparencies
• Load only one OHP transparency at the same time onto the bypass tray.
• When loading an OHP transparency onto the bypass tray, set the printer

to Transparency mode with the operation panel. 
• Be careful not to touch the print side of the OHP transparencies, otherwise

the print side gets dirty or damaged, and results in poor print quality.
• When printing on an OHP transparency that has a print side, load it facing

down onto the bypass tray.

❖❖❖❖ Adhesive labels
• Load only one adhesive label at the same time onto the bypass tray.
• Use adhesive labels in which the whole side can be printed on.
• Do not use adhesive labels having exposed glue.
• If the print side is coated, print quality might be reduced, as the toner

might not fuse well.
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❖❖❖❖ Envelopes
• When printing on envelopes, use the bypass tray or the Envelope Feeder

Unit.
• Even when the optional Envelope Feeder Unit is not installed, you can se-

lect the sizes for the Envelopes for Tray 2 using the operation panel. How-
ever, you cannot load the envelopes until optional Envelop Feeder Unit is
installed.
To use the Envelope Feeder Unit, installation of the optional Paper Feed
Unit is required. See “Installing Envelope Feeder Type 2600” in the Setup
Guide.

• Specifications of envelopes are as follows:

• You can load up to 10 envelopes (72 – 90 g/m2, 19 – 24 lb) onto the bypass
tray at the same time, without forcibly pressing them. Confirm that the en-
velopes are not damp, and that the top of the stack is not higher than the
limit mark on the side guide. ⇒ P.44 “Loading envelopes onto the bypass tray”.

• You can load up to 60 envelopes (72 – 90 g/m2, 19 – 24 lb) into optional En-
velope Feeder Unit at the same time, without forcibly pressing them. Con-
firm that the envelopes are not damp, and that the top of the stack is not
higher than the limit mark on the side guide. ⇒ P.46 “Loading envelopes into
the Envelope Feeder Unit”.

• Confirm that the print side is facing up when loading onto the bypass tray,
and facing down when loading into the optional Envelope Feeder Unit.

• Load the envelopes with the flaps aligned to the left side fence. The flaps
should be securely folded up. 

• Confirm that there is no air in the envelopes before loading.
• To get better print quality, it is recommended that you set the right, left,

top, and bottom print margin, to at least 15 mm (0.6") each.
• Do not print on both sides of envelopes.
• Load only one size and type of envelopes at the same time.
• Before loading envelopes, flatten the leading edges (the side being fed into

the printer) of them by running a pencil or ruler across them.
• Before loading envelopes, confirm that they are rectangular in shape.
• Do not use the non-supported envelopes listed on P.29 “Paper weight and

number of sheets to be set”.

Metric version Inch version

Weight 72 – 90 g/m2 19 – 24 lb

Recommended weight 
and size

72 g/m2, 114 × 162 mm

(C6 Env)

24 lb, 37/8" × 71/2"

(Monarch)
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Paper not supported by this printer

Avoid using the following types of paper that are not supported by this printer:
• Paper whose weight is heavier or lighter than the limitation. ⇒ P.25 “Paper

Types and Sizes”.
• Bent, folded or creased paper
• Curled or twisted paper
• Torn paper
• Wrinkled paper
• Damp paper
• Paper stuck together
• Paper that is dry enough to emit static electricity
• Paper that has already been printed on, with the exception of preprinted let-

terhead

Note
❒ Ink on paper from an earlier print job, another copier, an inkjet printer or

other device could damage the fusing unit of this printer due to a differ-
ence in fusing temperatures.

• Coated paper
• Special paper like thermal paper, aluminum foil, carbon paper and conduc-

tive paper
• Heavily textured paper
• Glued paper
• Label paper on which glue or base paper is exposed
• Paper with clips or stapled
• Paper with tape or ribbons attached
• Envelopes in the following conditions:

• damp
• excessively curled or twisted
• stuck together
• damaged in any way
• with stamps attached
• with windows, holes, perforations, cutouts or embossing
• with metal clasps, string ties or metal folding bars
• designed to be interlocked
• with nicked edges or bent corners
• with rough, wrinkled or laid finishes
• with any exposed adhesive, when the flap is in the sealed or closed position
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Printable Area

The following shows the printable area for this printer. Be sure to set the print
margins correctly by the application.

A : printable area

Note
❒ The printable area may vary depending on the paper size, printer language

and printer driver settings.

4.3mm(1/6")

4.3mm
(1/6")

1

4.3mm(1/6")

4.3mm
(1/6")

4.3mm(1/6")4.3mm(1/6")
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Loading Paper and Other Media

Loading Paper in the Paper 
Tray

Load paper in the optional Paper
Feed Unit by following the proce-
dures below.

Reference
With the paper tray, you can load
up to 250 pages and with the op-
tional Paper Feed Unit, you can
load up to 500 pages at the same
time. For more information about
the type, size and feed direction of
paper that can be loaded in the tray,
see P.25 “Paper Types and Sizes”.
When you change the paper size
see P.39 “Changing the paper size”.

A Lift the paper tray slightly then
pull it out until it stops.

B While lifting the front side of the
tray, pull it out of the printer.

C Load paper into the tray with the
print side down.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray.

❒ Confirm that paper fits under
the rear guide.

ZCEY430J
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D Carefully slide the paper tray into
the printer until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

Changing the paper size

Important
❒ Confirm that the setting of the pa-

per size dial matches the paper size
and feed direction of the paper in
the tray, otherwise the printer
might be damaged, or printing
problems might occur.

A Lift the paper tray slightly then
pull it out until it stops. Adjust
the paper size dial to match the
size and feed direction of paper in
the paper tray.

Important
❒ If you want to use the paper size

and feed direction that are not
indicated on the paper size dial,
set the dial to “p”. In this case,
you should set the paper size
using the operation panel. See
P.103 “Paper Input Menu”.

B While lifting the front side of the
tray, pull it out of the printer.

C If you load paper larger than A4
KKKK or 81/2” ×××× 11” KKKK, you should ex-
tend the tray as follows:

Note
❒ You cannot load paper smaller

than A4 K or 81/2” × 11”K, if
the tray is extended. In this case,
return the tray to its standard
length.

A Slide the catches inwards to
unlock the tray.
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B Slide the tray until it stops.

C Return the catches to their orig-
inal positions.

Important
❒ Confirm that the catches re-

turn to their original posi-
tions securely. If they are not
locked securely, paper mis-
feeds might occur.

D Adjust the rear and side guides to
the paper size you want to load.

E Load paper into the tray with the
print side down.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray. 

❒ Confirm that paper fits under
the rear guide.

F Carefully slide the paper tray into
the printer until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.
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Loading Paper in the Bypass 
Tray

Reference
With the bypass tray, you can load
up to 100 pages at the same time.
For more information about the
type, size and feed direction of pa-
per that can be loaded in the tray,
see P.25 “Paper Types and Sizes”.

Note
❒ If you set custom size paper, you

should set the paper size using the
printer driver. Also, use the opera-
tion panel to set the custom size
setting.

A Open the bypass tray.

B Slide the side guides outward,
and load paper until it stops with
the print side up.

Note
❒ If you load A4K or lager, or 81/

2” × 11”Kor larger, slide out the
bypass tray extension (A) and
then flip it open (B).

C Adjust the side guides to the pa-
per width.

Important
❒ Confirm that paper fits under

the side guides.
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D Set the paper size and feed direc-
tion using the operation panel as
follows:
A Press {{{{Menu}}}}.

“Menu” appears on the panel
display.

B Press {{{{TTTT}}}} or {{{{UUUU}}}} to “Paper In-
put” menu.

  Menu

   Paper Input

C Press {{{{Enter #}}}}.

The following message appears
on the panel display.

  Paper Input:

   Bypass Size

D Press {{{{Enter #}}}}.
E Press {{{{TTTT}}}} or {{{{UUUU}}}} to select the

paper size you want to use. 
F Press {{{{Enter #}}}} to apply the set-

ting. Wait for a while.

G After the panel display chang-
es, press {{{{Online}}}}.

"Ready" message appears on
the panel display.

  Ready

   

E Start printing with the computer.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape
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Power Error Data In

EnterForm Feed

Job Reset
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Escape
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Loading Paper in the Optional 
Paper Tray

Reference
With the Paper Feed Unit, you can
load up to 500 pages at the same
time.
For more information about the
type, size and feed direction of pa-
per that can be loaded in the tray,
see P.25 “Paper Types and Sizes”.

Important
❒ If the printer is equipped with the

optional tray(s), do not slide out
more than one tray at the same
time. If you do, the printer might
fall down.

❒ Confirm that the setting of the pa-
per size dial matches the paper size
and feed direction of the paper in
the tray. If different, the printer
might be damaged, or printing
problems might occur.

A Lift the paper tray slightly then
pull it out until it stops. Adjust
the paper size dial to match the
size and feed direction of paper in
the Paper Feed Unit.

Important
❒ If you want to use paper sizes or

feed directions that are not list-
ed on the paper size dial, adjust
the dial to “p”. In this case, you
should set the paper size using
the operation panel. See P.103
“Paper Input Menu”.

B While lifting the front side of the
tray, pull it out of the printer.

C Adjust the rear and side guides to
the paper size you want to load.
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D Load paper into the paper tray
with the print side down.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray.

❒ Confirm that paper fits under
the rear guide. 

E While lifting the front of the tray,
place the tray into the printer.
Then slide it inside until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

Loading Envelopes

As there are many kinds of envelopes,
be sure to check if those to be used are
supported by this printer.

Reference
For more information about enve-
lopes, see P.34 “Types of Paper and
Other Media”.

Important
❒ Even when the optional Envelope

Feeder Unit is not installed, you
can select the sizes for the enve-
lopes for Tray 2 using the opera-
tion panel. However, you cannot
load the envelopes until the op-
tional Envelope Feeder Unit is in-
stalled.

❒ To install the Envelope Feeder
Unit, the optional Paper Feed Unit
must be installed. See “Installing
Envelope Feeder Type 2600” in the
Setup Guide.

Loading envelopes onto the bypass tray

Reference
With the bypass tray, you can load
up to 10 envelopes at the same
time. For more information about
envelopes, see P.34 “Types of Paper
and Other Media”.

A Open the bypass tray.
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B Load envelopes until they stop,
with the print side up and the
sides of the flaps on the left as
shown below.

Important
❒ Confirm that the envelope flaps

are securely folded down, and
that there is no air inside the en-
velopes.

Note
❒ Confirm that the top of the stack

is not higher than the limit mark
on the side guides.

❒ Do not push the stack of enve-
lopes with too much force.

C Slide the side guides against the
edge of the envelope stack.

Note
❒ Confirm that the edges of enve-

lopes fit under the side guides.

D Set the envelope size and feed di-
rection using the operation panel
as follows:
A Press {{{{Menu}}}}.

“Menu” appears on the panel
display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Paper Input” menu.

  Menu:

   Paper Input

C Press {{{{Enter #}}}}. 

The following message appears.

  Paper Input:

   Bypass Size

D Press {{{{Enter #}}}}. 

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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Job Reset
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Escape
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E Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the
envelope type you want to use.

Reference
For information about types
of envelopes you can select,
see P.25 “Paper and Other Me-
dia Supported by This Printer”.

F Press {{{{Enter #}}}} to apply the set-
tings. Wait for a while.

G After the panel display chang-
es, press {{{{Online}}}}.

"Ready" message appears on
the panel display.

  Ready

  

E Start printing with the computer.

Loading envelopes into the Envelope 
Feeder Unit

Important
❒ With the optional Envelope Feeder

Unit, you can load up to 60 enve-
lopes at the same time. For more in-
formation about envelopes, see
P.34 “Types of Paper and Other Me-
dia”.

A Slide the optional Paper Feed Unit
(tray 2) out until it stops. Next, lift
it slightly, then slide it out.

Note
❒ Keep the paper tray with paper

in a cool and dry place.

B Prepare the Envelope Feeder Unit.

C While pinching the side guides,
slide them outward until they
stop. While pinching the rear
guide, slide it toward the back.

EnterForm Feed

Job Reset

On Line

Escape

Menu
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D Push the bottom plate down until
it locks into place.

E Load envelopes into the Envelope
Feeder Unit, with the print side
down and the flap on the left as
shown in the illustration.

Important
❒ Confirm that the envelope flaps

are securely folded down, and
that there is no air inside the en-
velopes.

Note
❒ Confirm that the top of the stack

is not higher than the limit mark
on the side guides.

❒ Confirm that the envelopes fit
under the side guides.

❒ Do not push the stack of enve-
lopes with too much force.

F While pinching the side guides,
slide them along the edge of the
envelope stack.

G While pinching the rear guide,
slide it along the edge of the enve-
lope stack.

H While lifting the front of the tray,
place it into the printer. Then
slide it until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.
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I Set the envelope size and feed di-
rection using the operation panel
as follows:
A Press {{{{Menu}}}}.

“Menu” appears on the panel
display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Paper Input” menu.

  Menu:

   Paper Input

C Press {{{{Enter #}}}}. 

The following message appears
on the panel display.

  Paper Input

   Bypass Size

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Tray Paper Size”.

  Paper Input:

   Tray Paper Size

E Press {{{{Enter #}}}}. 

The following message appears
on the panel display.

  Tray Paper Size:

   Tray 1

F Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Tray 2”.

  Tray Paper Size:

   Tray 2

G Press {{{{Enter #}}}}.

H Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the
envelope type you want to use.

Reference
For more information about
types of envelopes you can
select, see P.25 “Paper and
Other Media Supported by This
Printer”.

I Press {{{{Enter #}}}}. Wait for a while.

J After the panel display chang-
es, press {{{{Online}}}}.

"Ready" message appears on
the operation panel.

  Ready

  

J Start printing with the computer. 
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4. Sample Print/Locked Print
Sample Print

Use this function to print only the first
set of a multiple-set print jobs. The re-
maining sets are saved on the option-
al Hard Disk Drive in the printer. The
saved job can be printed or canceled
from the printer's operation panel.

Limitation
❒ To use this function, the optional

Hard Disk Drive must be installed
on the printer.

Note
❒ If the application has a collate op-

tion, confirm that it is not selected
before sending a print job. By de-
fault, sample print jobs are auto-
matically collated by the printer
driver. If the collate option is se-
lected from the application print
dialog box, more pages than in-
tended may be printed.

❒ You can identify the file you want
to print by the User ID and the
time when the job was stored.

❒ The actual number of pages the
printer can save depends on the
contents of the print images. For
example, the printer can save up to
30 jobs or 2,000 pages. It depends
on the data volume.

❒ If the first set of the sample print
file is not as you expected and you
do not want to print the remaining
sets, delete the sample print file us-
ing the operation panel. If you
print the remaining sets of the
sample print file, the job in the
printer is deleted automatically.

Printing a Sample Print File

The following procedure describes
how to print a sample print file with
the PCL printer driver. For informa-
tion about how to print a sample print
file with the PostScript printer driver,
see the PostScript3 Operating Instruc-
tions Supplement included as a PDF
file on the CD-ROM.

A From an application, select the
menu command to print.

The print dialog box appears.

B Open the Printer Properties.

C From the [Job Type:] box on the
[Setup] tab, select [Sample Print].

D Click the [Details...] button.

E In the [User ID:] box, type a User ID
of up to eight alphanumeric char-
acters.

Note
❒ This is used to identify the user

associated with a job.
❒ The User ID can consist of up to

eight alphanumeric (a-z, A-Z, 0-9)
characters.

F Click [OK].

G After making all desired settings,
click [OK].

H Start printing from the applica-
tion's print dialog box.
The sample print job is sent to the
printer and the first set is printed.
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I Check the print job to confirm
whether the settings are acceptable.

If the settings are fine, go to step J
to print the rest of the print job.
If not, you can delete the saved job.
⇒ P.51 “Deleting a Sample Print File”

J On the printer's operation panel,
press {{{{Menu}}}}.

“Menu” appears on the panel dis-
play.

K Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
“Sample Print“ menu.

  Menu:  

   Sample Print

L Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Sample Print:

  08:56 ABCD1234

M Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
file you want to print, and then
press {{{{Enter #}}}}.

  Select Action: 

  Print File

Note
❒ If you want to cancel the sample

print file, press {Escape}.

N Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Qty:  1(1-999)

  Press # To Print

O Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
number of sets.

Note
❒ You can enter up to 999 sets.

  Qty:  6(1-999)

  Press # To Print

P Press {{{{Enter #}}}} to print the file.

The following message appears on
the panel display.

  Printing...

  

Note
❒ If you are not satisfied with the

first printout of the sample print
file and do not want to print the re-
mainder, the job in the printer is
deleted automatically.
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Deleting a Sample Print File

If you are not satisfied with the print-
out, delete the sample print file. Then
revise it and print again until the set-
tings are fine.

A Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

B Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
"Sample Print" menu .

  Menu:  

   Sample Print

C Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Sample Print:

  08:56 ABCD1234

D Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
file you want to delete, and then
press {{{{Enter #}}}}.
The following message appears on
the panel display.

  Select Action:

   Print File 

Note
❒ If you want to cancel the dele-

tion of a sample print file, press
{Escape}.

E Press {{{{TTTT}}}} or {{{{UUUU}}}} to display a file
you want to delete, and then press
{{{{Enter #}}}}.

  08:56  ABCD1234

  Press #To Del 

F Press {{{{Enter #}}}} to delete the file.
The following message appears on
the panel display.

  Deleted

   

G Press {{{{Online}}}}.

"Ready" appears on the panel dis-
play.

  Ready
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Checking the Error Log

A Press {{{{Menu}}}}.
"Menu" appears on the panel dis-
play.

B Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
"Sample Print" menu.

  Menu:

   Sample Print

C Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Sample Print:

  08:56 ABCD1234

D Press {{{{TTTT}}}} or {{{{UUUU}}}} to display “Error
File(s)”.

  Sample Print:

   Error File(s)

E Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Error File(s):

   06:52  ABCD1234

Note
❒ You can check the other error

logs by using {TTTT} or {UUUU}.

F Press {{{{TTTT}}}} or {{{{UUUU}}}} to check "Error
File(s)", and then press {{{{Enter #}}}}.
The following message appears on
the panel display.

  Sample Print:

   Error File(s)

G Press {{{{Online}}}}.

"Ready" appears on the panel dis-
play.

  Ready
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Locked Print

Use this function to maintain privacy
when printing confidential docu-
ments. Documents will not be printed
out automatically, unless a password
is entered, using the operation panel
after sending the print job.

Limitation
❒ To use this function, the optional

Hard Disk Drive must be installed
on the printer.

Note
❒ If the application has a collate op-

tion, confirm that it is not selected
before sending a print job. By de-
fault, locked print jobs are auto-
matically collated by the printer
driver. If the collate option is se-
lected from the application print
dialog box, more pages than in-
tended may be printed.

❒ You can identify the file you want
to print by the User ID and the
time when the job was stored.

❒ The actual number of pages the
printer can save depends on the
contents of the print images. For
example, the printer can save up to
30 jobs or 2,000 pages. It depends
on the data volume.

❒ After the locked print file is print-
ed, the job in the printer is deleted
automatically.

Printing a Locked Print File

The following procedure describes
how to print a locked print file with
the PCL printer driver. For informa-
tion about how to print a locked print
file with the PostScript printer driver,
see the PostScript3 Operating Instruc-
tions Supplement included as a PDF
file on the CD-ROM.

A From an application, select the
menu command to print.

The print dialog box appears.

B Open the Printer Properties.

C From the [Job Type:] box on the
[Setup] tab, select [Locked Print].

D Click the [Details:] button.

E In the [User ID:] box, type a User ID
of up to eight alphanumeric char-
acters.

Note
❒ This is used to identify the user

associated with a job.
❒ The User ID can consist of up to

eight alphanumeric (a-z, A-Z, 0-9)
characters.

F In the [Password:] box, type a pass-
word of four digits.

Note
❒ The password must be four dig-

its (0-9).

G Click [OK].

H After making all desired settings,
click [OK].
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I Start printing from the applica-
tion's print dialog box.

The locked print job is sent to the
printer.

J On the printer's operation panel,
press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

K Press {{{{TTTT}}}} or {{{{UUUU}}}} to display
"Locked Print" menu.

  Menu:

   Locked Print

L Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Locked Print

  08:56 ABCD1234

M Press {{{{TTTT}}}} or {{{{UUUU}}}} to display a file
you want to print, and then press
{{{{Enter #}}}}.
The following message appears on
the panel display.

  Password:

  [0---]   

N Enter the password you entered
in step FFFF.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
leftmost digit of the password.

  Password:

  [1---]   

B Press {{{{Enter #}}}}.
The next digit appears.

  Password:

  [12--]

Note
❒ If you want to change the

locked print file, press {Escape}.
C Repeat steps AAAA and BBBB to enter

the remaining digit of the pass-
word, and the press {{{{Enter #}}}}.

If the password is not correct,
the following message appears
and the panel display returns to
the password menu. Reset or
reenter the password.

  Invalid Password

  Try Again

O Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "Print
File", and then press {{{{Enter #}}}}.

Note
❒ If you want to change the

locked print file, press {Escape}.
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P Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Qty: 6(1-999)

  Press # To Print

Q Press {{{{Enter #}}}} to print the file.

  Printing...

  

Deleting the Locked Print File

A Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

B Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
"Locked Print" menu.

  Menu:

   Locked Print

C Press {{{{Enter #}}}}.

  Locked Print:  

  08:56 ABCD1234

D Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
file you want delete, and then
press {{{{Enter #}}}}.

  Password:

  [0---]   

E Enter the password of the locked
print file.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
leftmost digit of the password.

  Password:

  [1---]   

B Press {{{{Enter #}}}}.

The next digit appears.

  Password:

  [12--]

Note
❒ If you want to change the

locked print file, press {Es-
cape}.
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C Repeat steps AAAA and BBBB to enter
the remaining password digits,
and then press {{{{Enter #}}}}.
If the password is not correct,
the following message appears
and the panel display returns to
the password menu. Reenter
the password.

  Invalid Password

  Try Again

F Press {{{{TTTT}}}} or {{{{UUUU}}}} to display “De-
lete File”.

  Select Action:

   Delete File

G Press {{{{Enter #}}}}.
The following message appears on
the panel display.

  08:56 ABCD1234

  Press #To Del 

Note
❒ If you want to change the locked

print file, press {Escape}.

H Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Deleted

  

I Press {{{{Online}}}}.

"Ready" appears on the panel dis-
play.

  Ready

  

Checking the Error Log

A Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

B Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
"Locked Print" menu.

  Menu:  

   Locked Print

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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C Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Locked Print:

  08:56 ABCD1234

D Press {{{{TTTT}}}} or {{{{UUUU}}}} to display “Error
File(s)”.

  Locked Print:

   Error File(s)

E Press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Error File(s):

  06:52 ABCD1234

F Press {{{{TTTT}}}} or {{{{UUUU}}}} to check "Error
File(s)", and then press {{{{Escape}}}}.

The following message appears on
the panel display.

  Locked Print:

   Error File(s)

Note
❒ Press {Escape} to return to the

previous menu.

G Press {{{{Online}}}}.

"Ready" appears on the panel dis-
play.

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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5. Troubleshooting
Error & Status Messages on the Operation 
Panel

Messages/Second messages Description Solution

Call Service: EC

Power Off On

/If Error Reoccur

Call Service

An error has occurred in the 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Change Setting 

Tray #

/Paper Size:

Paper Type:

The paper type and size set-
ting on the tray differs from 
that of actual paper type and 
size in the tray.

Load { paper size and type } 
paper with the selected feed 
direction into tray. Printing 
will not automatically resume 
if the paper type, size and di-
rection setting is incorrect. 
There are two methods to 
resume printing.

A Use the operation panel to 
set the correct paper type, 
size and direction of the 
paper in tray.

B Press {Form Feed} and se-
lect the tray with the oper-
ation panel.

Close Duplex

Unit Cover

The cover of the optional Du-
plex Unit is open.

Close the cover of the optional 
Duplex Unit.

Close

Front Cover

The front cover is open. Close the front cover.

Close Rear/Paper 

Exit Cover

The paper exit cover or the 
rear cover is open.

Close the paper exit cover or 
the rear cover.

Close

Mailbox Cover

The cover of the Mailbox is 
open.

Close the cover of the Mail-
box.

Collate Cancelled The collate feature has been 
canceled.

To print the image correctly, 
add memory to the printer, or 
reduce the resolution of the 
image.

Driver Setting Error (Memo-
ry)

The actual amount of memory 
installed does not match the 
setting of printer driver. The 
current print job has been can-
celed.

Configure the memory size 
correctly from the printer 
driver.
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Duplex Cancelled Duplex Print has been can-
celed.

To print the image correctly, 
add memory to the printer, or 
reduce the resolution of the 
image.

Load paper into the tray indi-
cated.

Energy Save Mode The printer is in Energy Saver 
mode.

Wait for a while.

Exceeded Max. Pages (Col-
late)

An error has occurred in the 
collation table overflow.

To print the image correctly, 
add memory to the printer, or 
reduce the resolution of the 
image.

Exceeded Max. Stored Files The sample print job or the 
locked print job to be sent 
from the computer will cause 
the maximum number of files 
to be exceeded.

Delete the stored files.

Exceeded Max. Stored Pages The sample print job or the 
locked print job to be sent 
from the computer will cause 
the maximum number of stor-
able pages to be exceeded.

Reduce the number of pages 
to print.

Hardware Problem

Ethernet

An error has occurred in the 
optional Network Interface 
Board.

First, turn off  the power 
switch and then on. If the mes-
sage appears again, call your 
sales or service representative.

Turn off the power switch . 
Replace the Network Interface 
Board and turn on the power 
switch. See “Installing Network 
Interface Board Type 2600” in 
the Setup Guide.

Turn off the power switch, re-
move the Network Interface 
Board and turn on the power 
switch.

Note
❒ If you remove the Net-

work Interface Board, you 
cannot print over the net-
work. You can send a print 
jobs to the printer only via 
a parallel cable connection.

Messages/Second messages Description Solution
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Hardware Problem

HDD

An error has occurred in the 
optional Hard Disk Drive.

First, turn the power switch 
off and then on, If the message 
appears again, call your sales 
or service representative.

Turn off the power switch. Re-
place the Hard Disk Drive and 
turn on the power switch. See 
“Installing Hard Disk Drive 
Type 2600” in the Setup Guide.

Turn off the power switch. Re-
move the Hard Disk Drive 
and turn on the power switch.

Note
❒ If the Hard Disk Drive is 

not installed, you cannot 
send the sample print job, 
locked print job and 
download the font to Hard 
Disk Drive using the PS 
Utility for Mac.

Hardware Problem

IEEE1394

An error has occurred in the 
optional 1394 Interface Unit.

First, turn the power switch 
off and then on, If the message 
appears again, call your sales 
or service representative.

Turn off the power switch. Re-
place the 1394 Interface Unit 
and turn on the power switch. 
See “Installing 1394 Interface 
Unit Type 2600” in the Setup 
Guide.

Turn off the power switch, re-
move the 1394 Interface Unit 
and turn on the power switch.

Note
❒ If you remove the 1394 In-

terface Unit, you cannot 
send print jobs via the 1394 
Interface Unit. You can 
only send print jobs to the 
printer via the parallel ca-
ble connection.

Hardware Problem

NV-RAM

An error has occurred in the 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Messages/Second messages Description Solution
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Hardware Problem

Option RAM

An error has occurred in the 
optional Memory Unit.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Turn off the power switch, Re-
place the Memory Unit, and 
then turn on the power 
switch. See "Installing Memory 
Unit TypeB 64MB" in the Setup 
Guide.

Turn off the power switch, re-
move the Memory Unit, and 
then turn on the power 
switch.

Note
❒ If you remove the Memory 

Unit, you must set up the 
option with the printer 
driver. If you are using 
Windows 95/98/Me, Win-
dows 2000 and Windows 
NT 4.0, see "Installing the 
Printer Driver and Software" 
in the Setup Guide.

❒ In this case, you might not 
be able to print complex 
print jobs.

Hardware Problem

Shift Tray

An error has occurred in the 
shift motor of the shift tray.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

HDD Full The optional Hard Disk Drive 
is full. The sample print job or 
locked print job to be sent 
from the computer is too large 
to store.

Delete any unnecessary stored 
files.

HDD Not Installed You cannot print the sample 
print and the locked print 
jobs, because the optional 
Hard Disk Drive is not in-
stalled.

Install the Hard Disk Drive. 
See “Installing Hard Disk Drive 
Type 2600” in the Setup Guide.

Hex Dump Mode The printer is in Hex Dump 
Mode.

Wait for a while. If the "Hex 
Dump Mode" message does 
not change, on the panel dis-
play press {Online} to return 
to the "Ready" condition.

Messages/Second messages Description Solution
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I/O Buffer Overflow There is too much data for the 
I/O buffer to handle.

Make sure the interface cable 
is inserted into the printer and 
your computer securely.

Make sure the interface cable 
is not damaged or broken.

Increase the size of the I/O 
buffer.

Invalid Password

Try Again

The password was not en-
tered correctly.

Wait for two seconds until the 
previous display appears. 
Then enter the password cor-
rectly.

Load Correct

Size Paper

/Press #

To Continue

The paper size setting on the 
tray differs from that of actual 
paper size in the tray.

Load { paper size } paper of 
the selected feed direction and 
paper size into the tray. Print-
ing will not automatically 
resume if the paper size and 
direction setting is incorrect. 
There are two methods to 
resume printing.

A Use the operation panel to 
set the correct paper size 
and direction of the paper 
in tray.

B Press {Form Feed} and se-
lect the tray with the oper-
ation panel.

Load Paper 

/Paper Size:

Paper Type:

The paper type and size set-
tings for this tray do not 
match the size and type of pa-
per actually loaded.

Load paper that matches the 
paper size and type settings. 
Printing will not automatical-
ly resume if the paper type, 
size and direction settings are 
incorrect. There are two meth-
ods to resume printing.

A Use the operation panel to 
set the correct paper type, 
size and direction of the 
paper in tray.

B Press {Form Feed} and se-
lect the tray with the oper-
ation panel.

Load Paper 

Tray #

There is no paper left in this 
tray.

Load paper into the tray indi-
cated.

Menu Protected

Cannot Change

The menu is protected and the 
settings cannot be changed.

Wait for two seconds until the 
previous display appears.

Messages/Second messages Description Solution
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No Files Exist There are no files available for 
the sample print job or the 
locked print job.

Wait for two seconds until the 
previous display appears.

Offline The printer is offline. If you want to bring the print-
er online. Press {Online}.

Output Tray Changed The output tray has been 
changed. The tray in the paper 
feed path is not set correctly 
when the printer receives the 
print job.

Select the output tray correct-
ly.

Print Overrun A Print overrun occurred on a 
file being printed. Only a part 
of the data on the page will be 
printed, and the print job is 
suspended, or the current 
print job has been canceled.

To print the image correctly, 
add memory to the printer or 
reduce the resolution of the 
image.

Printing... ——— Wait for a while.

Processing... The printer is processing in-
ternally.

Wait for a while.

Ready The printer is online and 
ready to make prints.

If you want to take the printer 
offline, press {Online}.

Remove Misfeed

Duplex Unit

/Open Duplex

Unit Cover

There is misfeed in the Duplex 
Unit.

Remove the misfed paper.

Remove Misfeed

Internal Path

/Open Front Cover

There is a misfeed in the print-
er.

Remove the misfed paper. See 
P.81 “Removing Misfed Paper”.

Remove Misfeed

Mailbox

/Open

Mailbox Cover

There is a misfeed in the Mail-
box.

Remove the misfed paper.

Remove Misfeed

Paper Exit Cover

/Open Paper

Exit Cover

There is a misfeed in the paper 
exit cover.

Remove the misfed paper.

Remove Misfeed

Paper Tray

/Remove Misfeed

Paper Tray

There is a misfeed in the print-
er.

Remove the misfed paper. See 
P.81 “Removing Misfed Paper”.

Messages/Second messages Description Solution



Error & Status Messages on the Operation Panel

5

Remove Misfeed

Upper Tray Unit

/Open Upperr

Tray Cover

There is a misfeed in the up-
per tray unit.

Remove the misfed paper.

Remove Paper

All Output Trays

All output trays are full, and 
the print job is suspended.

Remove paper from all output 
trays, and the print job will be 
resumed automatically.

Remove Paper

From Upper Tray

The upper tray is full, and the 
print job is suspended.

Remove paper from the upper 
tray, and the print job will be 
resumed automatically.

Remove Paper

Mailbox Tray #

The Mailbox is full, and the 
print job is suspended.

Remove paper from the Mail-
box, and the print job will be 
resumed automatically.

Remove Paper

Standard Tray

The standard tray is full, and 
the print job is suspended.

Remove paper from the stand-
ard tray, and the print job will 
be resumed automatically.

Replace

Maintenance Kit

It is time to replace parts in-
cluded in the Maintenance 
Kit. 

Replace parts. See P.132 
“MAINTENANCE KIT Type 
2600”.

Replace

Toner Cartridge

The toner cartridge is not set 
correctly or toner is almost 
run out.

Set the toner cartridge correct-
ly. See P.88 “Replacing the Ton-
er Cartridge”.

The toner dust is full. Prepare a new toner cartridge. 
If the image density gets too 
light, replace the toner car-
tridge with a new one. See 
P.88 “Replacing the Toner Car-
tridge”.

Reset Duplex

Unit Correctly

The optional Duplex Unit is 
not set correctly.

Set the optional Duplex Unit 
correctly. If the message ap-
pears again, call your sales or 
service representative.An error has occurred in the 

Duplex Unit.

Reset Fusing

Unit Correctly

The fusing unit is not set cor-
rectly.

Set the fusing unit correctly, 
or set the proper fusing unit.

Reset Toner

Cartridge

The toner cartridge is not set 
correctly.

Set the toner cartridge correct-
ly. See P.88 “Replacing the Ton-
er Cartridge”.

The toner cartridge is not set 
installed.

If the cartridge is installed, 
close the front cover and turn 
the off power switch and then 
on. If the message appears 
again, contact your sales or 
service representative.

Messages/Second messages Description Solution
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Reset Tray #

Correctly

The input paper tray is not set 
correctly.

Set the input paper tray cor-
rectly.

Resetting Job... The print job is being reset. Wait for a while.

RPCS Graphic Error There is not enough graphics 
memory to print the data.

Specify the correct memory 
capacity in the [Change Acces-
sories…] option in the RPCS 
printer driver's print settings 
tab. For Windows 95/98/Me, 
Windows 2000 and Windows 
NT 4.0 descriptions, see "In-
stalling the RPCS Printer Driv-
er" in the Setup Guide.

To print the image correctly, 
add memory to the printer, or 
reduce the resolution of the 
image.

RPCS Memory Overflow A memory overflow occurred 
during the print job. After a 
part of the data on the page is 
printed, the print job is sus-
pended.

Specify the correct memory 
capacity in the [Change Acces-
sories…] option in the RPCS 
printer driver's print settings 
tab. See the descriptions of 
Windows 95/98/Me, Win-
dows 2000 and Windows NT 
4.0 in "Installing the RPCS 
Printer Driver" in the Setup 
Guide.

To print the image correctly, 
add memory to the printer, or 
reduce the resolution of the 
image.

RPCS Syntax Error An error has occurred in the 
syntax.

Specify the correct memory 
capacity in the [Change Acces-
sories…] option in the RPCS 
printer driver's print settings 
tab. See the descriptions of 
Windows 95/98/Me, Win-
dows 2000 and Windows NT 
4.0 in "Installing the RPCS 
Printer Driver" in the Setup 
Guide.

To print the image correctly, 
add memory to the printer, or 
reduce the resolution of the 
image.

Messages/Second messages Description Solution
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SC XXX-X

Power Off On

If Error Reoccur

Call Service

An error has occurred. First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

SC2001 An error has occurred in the 
resident font RAM.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Toner Is Almost

Empty

The toner is almost run out. Prepare a new toner cartridge. 
If the image density gets too 
light, replace the toner car-
tridge with a new one. See 
P.88 “Replacing the Toner Car-
tridge”.

Waiting... The printer is waiting for the 
next print job.

Wait for a while.

Warming Up... The printer is warming up or 
toner is being supplied.

Wait until the panel display 
change the "Ready".

Messages/Second messages Description Solution
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Getting Printer Information over the Network

Printer current status

You can check the printer's status using the telnet command.

❖❖❖❖ telnet
Use the status command.

❖❖❖❖ UNIX
Use the lpg or lpstat command or stat parameter of rsh, rcp, or ftp.

Reference
For more information, see “Remote Maintenance by Telnet (mshell)” in the
Network Interface Board Operating Instructions is provided as a PDF file
on the CD-ROM labeled “Operating Instructions”.

Messages Description Comments

Call Service Center There is a malfunction in the 
printer.

Turn the printer off and on.

Call Service Center: SC***-* An error has occurred in the 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Canceling Job... The printer is canceling the 
print job.

Wait for a while.

Cover Open: Duplex Unit The cover of the optional Du-
plex Unit is open.

Close the cover of the optional 
Duplex Unit.

Cover Open: Front Cover Close the front cover. Close the front cover.

Cover Open: Mailbox The cover of the Mailbox is 
open.

Close the cover of the Mailbox 
cover.

Cover Open: Paper Exit/Rear The paper exit cover or the 
rear cover is open.

Close the paper exit cover or 
the rear cover.

Cover Open: Upper Tray The upper tray cover is open. Close the upper tray cover.

Empty: Toner The toner cartridge is empty. Replace the new toner car-
tridge.

Energy Saver Mode The printer is in Energy Save 
Mode.

Wait for a while.

Energy Saver Mode 1

Error: Command Transmis-
sion

An error has occurred in the 
engine or controller.

First, turn the power switch 
off and then on. If the message 
appears again, call your sakes 
or service representative.
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Error: Ethernet Board An error has occurred in the 
optional Network Interface 
Board.

First, turn the power switch 
off and then on. If the message 
appears again, call your sakes 
or service representative.

Error: HDD Board An error has occurred in the 
optional Hard Disk Drive.

First, turn the power switch 
off and then on. If the message 
appears again, call your sakes 
or service representative.

Error: IEEE 1394 Board An error has occurred in the 
optional 1394 Interface Unit.

First, turn the power switch 
off and then on. If the message 
appears again, call your sakes 
or service representative.

Error: Memory Switch An error has occurred in 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sakes 
or service representative.

Error: Optional RAM An error has occurred in the 
optional Memory Unit.

First, turn the power switch 
off and then on. If the message 
appears again, call your sakes 
or service representative.

Error: Parallel I/F Board An error has occurred in the 
parallel interface board.

First, turn the power switch 
off and then on. If the message 
appears again, call your sakes 
or service representative.

Full: Mailbox Optional all output trays of 
Mailbox are full.

Remove paper from the Mail-
box.

Full: Mailbox Tray 1 The output tray 1 of the op-
tional Mailbox is full.

Remove paper from the out-
put tray 1 of the optional Mail-
box.

Full: Mailbox Tray 2 The output tray 2 of the op-
tional Mailbox is full.

Remove paper from the out-
put tray 2 of the optional Mail-
box.

Full: Mailbox Tray 3 The output tray 3 of the op-
tional Mailbox is full.

Remove paper from the out-
put tray 3 of the optional Mail-
box.

Full: Mailbox Tray 4 The output tray 4 of the op-
tional Mailbox is full.

Remove paper from the out-
put tray 4 of the optional Mail-
box.

Full: Output Tray(s) All output trays are full. Remove paper from all output 
trays.

Full: Standard Output Tray The output tray is full. Remove paper from output 
trays.

Full: Upper Output Tray The upper tray of the optional 
1-bin Shift Sort Tray is full.

Remove paper from the upper 
tray.

Messages Description Comments
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Full: Waste Toner The toner is almost run out. Prepare a new toner cartridge.

Hex Dump Mode The printer is in Hex Dump 
Mode.

Wait for a while. If the "Hex 
Dump Mode" message does 
not change, on the panel dis-
play press {Online} to return 
to the "Ready" condition.

Low: Toner The toner cartridge is not set 
correctly or toner is almost 
running out.

Set the toner cartridge correct-
ly. 

Malfunction: Upper Tray An error has occurred in the 
upper tray.

First, turn the power switch 
off and then on. If the message 
appears again, call your sakes 
or service representative.

Mismatch: Paper Size The paper size setting of the 
tray differs from that of actual 
paper size in the tray.

Load paper of the indicated 
paper size into the paper tray 
being used. See P.25 “Paper 
and Other Media Supported by 
This Printer”.

Mismatch: Paper Size and 
Type 

The paper type setting of the 
tray differs from that of actual 
paper type in the tray.

Load paper of the indicated 
paper size and type into the 
paper tray being used. See 
P.25 “Paper and Other Media 
Supported by This Printer”.

Mismatch: Paper Type The paper type setting of the 
tray differs from that of actual 
paper type in the tray.

Load paper of the indicated 
paper type into the paper tray 
being used. See P.25 “Paper 
and Other Media Supported by 
This Printer”.

No Paper: Bypass Tray There is no paper of the indi-
cated paper size in the bypass 
tray.

Load paper into the bypass 
tray. See P.41 “Loading Paper in 
the Bypass Tray”.

No Paper: Input Tray(s) There is no paper of the indi-
cated paper size in the paper 
tray.

Load paper into the paper 
tray. See P.38 “Loading Paper in 
the Paper Tray”.

No Paper: Selected Tray There is no paper of the indi-
cated paper size in the current 
tray.

Load paper into the current 
tray. See P.38 “Loading Paper 
and Other Media”.

No Paper: Tray 1 There is no paper of the indi-
cated paper size in the paper 
tray (Tray1).

Load paper into the bypass 
tray. See P.41 “Loading Paper in 
the Bypass Tray”.

No Paper: Tray 2 There is no paper of the indi-
cated paper size in the option-
al Paper Feed Unit (Tray2).

Load paper into the bypass 
tray. See P.41 “Loading Paper in 
the Bypass Tray”.
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No Paper: Tray 3 There is no paper of the indi-
cated paper size in the option-
al Paper Feed Unit (Tray3).

Load paper into the bypass 
tray. See P.41 “Loading Paper in 
the Bypass Tray”.

No Paper: User Selected Tray There is no paper of the indi-
cated paper size in the select-
ed tray.

Load paper into the selected 
tray. See P.38 “Loading Paper 
and Other Media”.

Not Detected: Duplex Unit The optional Duplex Unit is 
not set correctly.

Set the optional Duplex Unit 
correctly. If the message ap-
pears again, call your sales or 
service representative.An error has occurred in the 

Duplex Unit.

Not Detected: Fusing Unit The fusing unit is not set cor-
rectly.

Set the fusing unit correctly. If 
the message appears again, 
call your sales or service rep-
resentative.

Not Detected: Input Tray(s) The input tray is not set cor-
rectly.

Set the input tray correctly. If 
the message appears again, 
call your sales or service rep-
resentative.

Not Detected: Toner Car-
tridge

The toner cartridge is not set 
correctly.

Set the toner cartridge correct-
ly. If the message appears 
again, call your sales or serv-
ice representative.

No Detected: Tray 1 The paper tray (Tray 1) is not 
set correctly. 

Set the paper tray (Tray 1) cor-
rectly. If the message appears 
again, call your sales or serv-
ice representative.

No Detected: Tray 2 The optional Paper Feed Unit 
(Tray 2) is not set correctly.

Set the optional Paper Feed 
Unit (Tray 2) correctly. If the 
message appears again, call 
your sales or service repre-
sentative.

No Detected: Tray 3 The optional Paper Feed Unit 
(Tray 3) is not set correctly.

Set the optional Paper Feed 
Unit (Tray 3) correctly. If the 
message appears again, call 
your sales or service repre-
sentative.

Not Detected: User Selected 
Tray

The selected tray is not set cor-
rectly.

Set the selected tray correctly. 
If the message appears again, 
call your sales or service rep-
resentative.

Offline The printer is Offline. If you want to change into On-
line, press {Online}.

On Line The printer is Online. You can print the job data.

Online

Messages Description Comments
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Paper Misfeed: Duplex Unit There is misfeed in the Duplex 
Unit.

Remove the misfed paper. See 
P.85 “When "Remove Misfeed 
Duplex Unit" Appears”.

Paper Misfeed: Front Cover There is misfeed in the printer. Remove the misfed paper. See 
P.82 “When "Remove Misfeed 
Internal Path/Open Front Cov-
er" Appears”.

Paper Misfeed: Input Tray There is misfeed in the printer. Remove the misfed paper. See 
P.81 “When “Remove Misfeed 
Paper Tray” Appears”.

Paper Misfeed: Mailbox There is misfeed in the Mail-
box.

Remove the misfed paper. See 
P.87 “When "Remove Misfeed 
Mailbox" Appears”.

Paper Misfeed: Output Tray There is misfeed in output 
tray.

Remove the misfed paper. See 
P.84 “When "Remove Misfeed 
Paper Exit Cover" Appears”.

Paper Misfeed: Upper Tray There is misfeed in upper tray. Remove the misfed paper. See 
P.87 “When "Remove Misfeed 
Upper Tray Unit" Appears”.

Printing... --- Wait for a while.

Replace Maintenance Kit It is time to replace parts in-
cluded in the Maintenance 
Kit. 

Replace parts. See P.132 
“MAINTENANCE KIT Type 
2600”.

Warming Up/Adjusting... The printer is warming up or 
toner is being supplied.

Wait until the panel display 
change the "Ready".

Messages Description Comments
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Printer configuration

You can check the printer configuration using telnet.

❖❖❖❖ telnet
Use the info command.

❖❖❖❖ UNIX
Use the lpg or lpstat command or stat parameter of rsh, rcp, or ftp.

Reference
For more information, see “Remote Maintenance by Telnet (mshell)” in the
Network Interface Board Operating Instructions is provided as a PDF file
on the CD-ROM labeled “Operating Instructions”.

Note
❒ “*” (asterisk) is displayed with the current setting.
❒ Regarding *1–*6, see below table.

Item Description

Printer System Version of the printer

Network Board Version of the network board

Input Tray

No.

Name

PaperSize

Status

ID number of the paper tray

Name of the paper tray*1

Paper size loaded in the paper tray*2

Current status of the paper tray*3

Output Tray

No.

Name

Status

ID number of the output tray

Name of the output tray*4

Current status of the output tray*5

Emulation

No.

Name

Version

ID number of the emulation used by the printer

Name of the emulation used in the printer

Version of the emulation

Program

No.

Name

ID number of the program

Name of the program
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❖❖❖❖ *1 Input Tray: Name

❖❖❖❖ *2 Input Tray: Paper Size

Name Description

Tray X Name of installed paper tray. (X is the number 
of tray.)

Bypass Tray Bypass Tray

Paper Size Description

A3 (297 × 420) A3 K

B4JIS (257 × 364) B4K

A4 (297 × 210) A4L

A4 (210 × 297) A4K

B5JIS (257 × 182) B5L

B5JIS (182 × 257) B5K

A5 (210 × 148) A5L

A5 (148 × 210) A5K

A6 (105 × 148) A6K

11 × 17 DLK

81/2 × 14 LGK

11 × 81/2 LTL

81/2 × 11 LTK

51/2 × 81/2 HLK

FRI Custom Size

101/2 × 71/4 101/2" × 71/4"L

71/4 × 101/2 71/4" × 101/2"K

81/4 × 13 81/4" × 13"K

81/2 × 13 81/2" × 13"K

41/8 × 91/2 41/8" × 91/2"K

37/8 × 71/2 37/8" × 71/2"K

DL (110 × 220) DLK

C5 Env(162 × 229) C5 EnvK

8 × 13 8"×13"K

C6 Env(114 × 162) C6 EnvK

8K (267 × 390) 8KK

16K (267 × 195) 16KL
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❖❖❖❖ *3 Input Tray: Status

❖❖❖❖ *4 Output Tray: Name

❖❖❖❖ *5 Output Tray: Status

16K (195 × 267) 16KK

NCS There is no tray.

** The paper size is not selected.

Status Description

Normal 

NoTray There is no paper tray

PaperEnd There is no paper in the paper tray

Name Description

Standard Tray Output Tray

1-bin Shift Tray 1-bin Shift Sort Tray

Mailbox Tray 1-4 Mailbox output tray 1-4

Status Description

Normal ----

PaperExist There is paper in the output tray

OverFlow Output tray is full of paper

Error Other error

Paper Size Description
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Printer Does Not Print

Possible Cause Solutions

Is the power on? Confirm that the cable is securely plugged into the power outlet 
and the printer. 

Turn on the power switch.

Does the Online indicator 
stay on?

Press {Online} so the indicator lights.

Does the Error indicator 
stay red?

Check the error message on the panel display and take the re-
quired action.

Is paper loaded? Load paper into the paper tray or on the bypass tray. 

See P.38 “Loading Paper and Other Media”.

Can you print a configura-
tion page ?

If you cannot print a test page, it probably indicates a printer mal-
function. You should contact your sales or service representative. 
See P.107 “List/Test Print Menu”.

If you can print a test page but cannot get the printer to print when 
you issue a print command from the computer, it probably means 
there is a problem with the computer.

Note that large or complex data might take a long time to be print-
ed.

Is the interface cable con-
necting the printer to the 
computer connected se-
curely?

Connect the interface cable properly. If there are any connectors or 
screws, confirm that they are fastened securely.

Are you using the correct 
interface cable?

The type of interface cable you should use depends on the compu-
ter. Be sure to use the correct one. 

If the cable is damaged or worn, replace it with a new one.

Is the paper feed roller 
clean?

Clean the paper feed roller if it is dirty. See P.92 “Cleaning the Paper 
Feed Roller”.
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Possible Cause Solutions

Is the Data In indicator 
blinking or lit after starting 
the print job?

If not blinking or lit, the data is not being sent to the printer. 

❖❖❖❖ If the printer is connected to the computer using the in-
terface cable
Make sure the printer port settings are correct. For a parallel 
port connection, port LPT1 or LPT2 should be set. 

• Windows 95/98/Me

A Click [Start], point to [Settings] and then click [Printers].

B Click to select the icon of the printer. Next, on the [File] 
menu, click [Properties].

C Click the [Details] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

• Windows 2000

A Click [Start], point to [Settings] and then click [Printers].

B Click to select the icon of the printer. Next, on the [File] 
menu, click [Properties].

C Click the [Port] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

• Windows NT 4.0

A Click [Start], point to [Settings] and then click [Printers].

B Click to select the icon of the printer. Next, on the [File] 
menu, click [Properties].

C Click the [Port] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

❖❖❖❖ Network Connection
Contact your network administrator.

Do you print via a net-
work?

Confirm that the "Ethernet" setting is correct from the operation 
panel. See P.120 “Host Interface Menu”.

The setting governs the data transfer speed used by the Network 
Interface Board. Three options are available: 

• Auto (default)

• 100 Mbps

• 10 Mbps

Note
❒ For details about the appropriate setting to use on your net-

work, contact your network administrator.
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Note
❒ If you cannot solve the problem by taking the preceding actions, contact your

sales or service representative.

Is the optional 1394 Inter-
face Unit installed correct-
ly?

Confirm that the 1394 interface cable is securely plugged into the 
power outlet and the printer.

Turn on the power switch.

Use the 1394 Interface Unit tool located in the following folder on 
the CD-ROM:

\DRIVERS\UTILITY\1394\

Reference
For more information about using the 1394 Interface Unit tool, 
see the readme file on the CD-ROM.

Possible Cause Solutions
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Other Printing Problems

Status Possible Causes, Descriptions, and Solutions

The print side of the page is a 
hazy gray.

Adjust the image density.

See P.99 “Making Printer Settings with the Operation Panel”.

If paper is curled, correct it.

Check if the size selected with the paper tray dial matches that 
selected with the operation panel. If not, select the correct size 
that matches the size and feed direction loaded in the tray.

If you print something after printing on the paper whose size 
is smaller than the actual document size, the back of the next 
output might get dirty.

See P.38 “Loading Paper and Other Media”.

If you continuously print data that contains extremely small 
amount of words or images in the printable area, the printed 
side of the page could be a hazy gray. Adjust the image densi-
ty. See P.99 “Making Printer Settings with the Operation Panel”.

Image quality varies when 
printing on thick paper or on 
OHP transparencies.

Switch to Thick Paper mode. 

• When toner is not fused enough, set it to “On”. 

• When the image is blurred, set it to “----”.

See P.99 “Making Printer Settings with the Operation Panel”.

Some parts of the print image 
are not clear.

Make the image density darker.

See P.99 “Making Printer Settings with the Operation Panel”.

If Toner Saving mode is selected using the operation panel, 
the whole image gets lighter. 

The print image is not clear. Due to a sudden change in temperature, condensation might 
appear inside the printer, reducing print quality. If this oc-
curs, when you move the printer from a cold room to a 
warmer room, do not use the printer until it acclimatizes to 
the temperature. 

Nothing is printed on the paper. Check if the tape of the toner cartridge is completely removed. 
Be sure to remove the tape completely when replacing the ton-
er cartridge. See P.88 “Replacing the Toner Cartridge”.

Note
❒ If the power switch is turned on with the tape still at-

tached to the toner cartridge, the printer might be dam-
aged.

Multiple pages are fed through 
the printer at once.

Clean the friction pad if it is dirty. See P.91 “Cleaning the Fric-
tion Pad”.

Remove all paper from the tray and fan it gently to get air be-
tween the sheets. After that, load it back into the tray.

The image is printed on the re-
verse side of the paper.

Set the paper the other way up.
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Note
❒ If the problem cannot be solved, contact your sales or service representative.

Paper misfeeds occur frequent-
ly.

Check the paper size settings. The size set with the paper size 
dial might be different from the actual paper size. Make the 
correct dial setting. 

See P.38 “Loading Paper and Other Media”.

Use the recommended paper. Avoid using curled, folded, 
wrinkled, perforated or glossy paper. See P.36 “Paper not sup-
ported by this printer”.

Clean the paper feed roller, friction pad and/or registration roll-
er, if they are dirty. See P.92 “Cleaning the Paper Feed Roller”.

The operation panel error mes-
sage stays on after removing the 
misfed paper.

Open the front cover of the printer and then close it. See P.81 
“Removing Misfed Paper”.

Output are not delivered to the 
selected tray you require.

Check the paper size settings. The size selected with the pa-
per size dial might be different from the actual paper size. 
Make the correct dial setting.

See P.38 “Loading Paper and Other Media”.

When using the bypass tray, set the paper size using the op-
eration panel.

See P.38 “Loading Paper and Other Media”.

When you are using a Windows operating system, the print-
er driver settings override those set using the operation pan-
el. Set the desired output tray using the printer driver. See 
the driver's online Help file.

The printed image is different 
from the image on the compu-
ter.

When you use some functions, such as enlargement and re-
duction, the layout of the image might be different from that 
shown in the computer display.

It takes too much time to resume 
printing.

The data is so large or complex that it takes time to process 
it. If the Data In indicator is blinking, the data processing is 
being done. Just wait until it resumes.

Changing the paper feed direction may sometimes reduce 
the time to resume printing.

The image is printed in the 
wrong orientation.

Set the correct orientation under the “PCL Menu” with the 
operation panel. See P.124 “PCL Menu”.

Confirm that the setting of orientation has been set in the ap-
plication you use.

Set the correct paper size and feed direction that matches 
tray settings on the RPCS printer driver.

Part of the image cannot be 
printed.

A paper size which is smaller than that selected in the appli-
cation is used for printing. Load the correct size of paper.

Network configurations you have 
made do not become effective.

Print a configuration page and check the network settings.

Status Possible Causes, Descriptions, and Solutions
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Removing Misfed Paper

When a paper misfeed occurs, an error message appears on the panel display.
The procedure you should follow to remove misfed paper depends on the loca-
tion of the misfeed, which is indicated on the panel display.

R CAUTION:

Important
❒ Check the following points if paper continues to misfeed.

• Confirm that the setting of the paper size dial matches the size and feed di-
rection of the paper loaded in the paper tray.

• If the friction pad or the paper feed roller is dirty, clean it. For more infor-
mation, see P.91 “Cleaning the Friction Pad”.

• Confirm that the toner cartridge is set correctly.
❒ If a paper misfeed still occurs, contact your sales or service representative.
❒ Removing misfed paper with force, cause the paper might be torn and left some torn

scraps within the printer. This makes the printer misfed and might be damaged.
❒ Do not leave any torn scraps within the printer.

When “Remove Misfeed Paper 
Tray” Appears

Important
❒ Removing misfed paper with force,

cause the paper might be torn and
left some torn scraps within the
printer. This makes the printer mis-
fed and might be damaged.

A Lift the paper tray slightly then
pull it out until it stops, and re-
move misfed paper.

B Carefully slide the paper tray into
the printer until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

• When removing misfed paper, do not touch the fusing section because it 
becomes very hot. 
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C Open the front cover by pushing
the front cover release button,
and then close it to reset the mis-
feed condition.

Note
❒ You can apply this procedure

for both the paper tray and the
optional Paper Feed Unit.

❒ To reset the misfeed condition,
open and close the front cover,
then the indicator will be off.

When "Remove Misfeed 
Internal Path/Open Front 
Cover" Appears

Important
❒ Removing misfed paper with

force, cause the paper might be
torn and left some torn scraps
within the printer. This makes the
printer misfed and might be dam-
aged.

A Open the front cover by pushing
the front cover release button.

B While lifting the front side of the
toner cartridge, pull it out of the
printer.

Important
❒ Do not put the toner cartridge

on an unstable or tilted surface.
❒ Do not hold the toner cartridge

upside down or stand it verti-
cally.
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C Pull out the misfed paper by
holding both sides of paper. Be
careful not to make your hands
dirty with toner.

D Holding the grips of the toner car-
tridge, insert it into the printer
until it stops.

E Push down the toner cartridge to
settle it in appropriate position.

F Close the front cover.

Important
❒ If paper is fed from the bypass

tray, be sure to remove all the pa-
per from the bypass tray and close
it before opening the front cover.
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When "Remove Misfeed Paper 
Exit Cover" Appears

R CAUTION:

Important
❒ Removing misfed paper with force,

cause the paper might be torn and
left some torn scraps within the
printer. This makes the printer mis-
fed and might be damaged.

A If you installed the 1-bin Shift
Sort Tray, slide the upper tray out
from it. If you installed the Mail-
box, slide the output tray into
lower slide out from it.
The following procedures are ex-
ample of Mailbox.

B Open the paper exit cover.

C Remove the misfed paper.

D Close the paper exit cover until it
clicks.

• When removing misfed paper, 
do not touch the fusing section 
because it becomes very hot.
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When "Remove Misfeed 
Duplex Unit" Appears

R CAUTION:

Important
❒ Removing misfed paper with

force, cause the paper might be
torn and left some torn scraps
within the Duplex Unit.  This
makes the printer misfed and
might be damaged.

A  Remove the misfed paper inside
of the cover.

A Open the rear cover of the Du-
plex Unit.

B Remove the misfed paper.

C Close the rear cover of the Du-
plex Unit.

D While lifting the lever (AAAA),
open the cover of the Duplex
Unit (BBBB).

E Remove the misfed paper.

• When removing misfed paper, 
do not touch the fusing section 
because it becomes very hot.
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F Close the cover of the Duplex Unit.

If the error message appears
again, go to step B.

B Pull the Duplex Unit out of the
printer until it stops, and remove
the misfed paper.
A Push down the lever on the right

side of the Duplex Unit (AAAA) and
pull it out until it stops (BBBB).

B Lift the guide board inside the
Duplex Unit, and remove the
misfed paper.

Important
❒ When A5L paper misfeeds,

you might not remove it by
pulling the Duplex Unit out.
In this case, pull the paper tray
out and remove the paper.

C While aligning the power cord
with the groove of the left slide
of the Duplex Unit, insert the
Duplex Unit into back of the
printer aligning the rails inside
of the printer until it is con-
nected.

If the error message appears
again, the misfed paper might be
left in the printer. Confirm that
the inside of the printer. For more
information, see P.82 “When "Re-
move Misfeed Internal Path/Open
Front Cover" Appears”.
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When "Remove Misfeed 
Mailbox" Appears

Important
❒ Removing misfed paper with force,

cause the paper might be torn and
left some torn scraps within the
Mailbox. This makes the printer
misfed and might be damaged.

A Open the cover of the Mailbox.

B Remove the misfed paper.

C Close the cover of the Mailbox.

When "Remove Misfeed Upper 
Tray Unit" Appears

Important
❒ Removing misfed paper with force,

cause the paper might be torn and
left some torn scraps within the 1-bin
Shift Sort Tray. This makes the print-
er misfed and might be damaged.

A Open the upper tray cover.

B Remove the misfed paper.

C Close the upper tray cover.
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Replacing the Toner Cartridge

R WARNING:

R CAUTION:

When “Replace Toner Cartridge” ap-
pears on the panel display, the toner
is almost running out. Prepare a new
toner cartridge. If the image density
gets too light, replace the toner car-
tridge with a new one.

Important
❒ Do not expose the toner cartridge

to light for a long time. Do not
leave the front cover open for a
long time. If the toner cartridge is
exposed to a light for a long time,
the toner cartridge might be dam-
aged and print quality might be re-
duced.

Note
❒ Do not stand or place the toner car-

tridge upside-down.
❒ The actual number of printed pag-

es you get from a particular toner
cartridge depends on the type and
size of paper you are using, the
contents of the print images, and
printing environment conditions.
All this means that a toner car-
tridge might require replacement
sooner than the normal life de-
scribed on P.150 “Consumables”.

A Open the front cover by pushing
the front cover release button.

• Do not incinerate spilled toner 
or used toner. Toner dust 
might ignite when exposed to 
an open flame.

• Disposal can take place at our 
authorized dealer or at appro-
priate collection sites.

• If you dispose the used toner 
cartridges yourself, dispose 
of them according to your lo-
cal regulations.

• The inside of the printer be-
comes very hot. Do not touch the 
parts with a label indicating the 
“hot surface”, otherwise it could 
cause a personal burn.

• Do not eat or swallow toner.

• Keep toner (used or unused) and 
toner cartridges out of reach of 
children.

• Our products are engineered to 
meet the highest standards of 
quality and functionality. When 
purchasing expendable sup-
plies, we recommend using only 
those specified by an authorized 
dealer.
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B While lifting the front side of the
toner cartridge, pull it out of the
printer.

Note
❒ Do not put the toner cartridge

on an unstable or tilted surface.

C Wipe around the metallic regis-
tration roller by turning with a
soft damp cloth.

Important
❒ Do not use chemical cleaner or

organic solvent such as thinner
or benzene.

D Take a new toner cartridge from
the box.

E Hold the toner cartridge as shown
in the illustration, and shake it
side to side about seven – eight
times.

Note
❒ If the toner cartridge is not

shaken enough, toner might not
be evenly distributed in the car-
tridge. In this case, print quality
might be reduced.

F Place the toner cartridge on a flat
surface. Pull out the tape inside
the unit horizontally while hold-
ing the cartridge with one hand as
shown in the illustration.

Note
❒ Be sure to remove the tape com-

pletely before installing the new
toner cartridge, otherwise the
printer might be damaged.
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❒ Be sure to pull the tape horizon-
tally.  Pulling it upward or
downward causes toner scatter-
ing.

❒ Be careful not to make your
cloths dirty with toner.

❒ After pulling out the tape from
the cartridge, toner scatters eas-
ily. Do not shake or give a shock
to the cartridge.

G Holding the grips of the cartridge,
insert it into the printer until it
stops.

H Push down the toner cartridge to
settle it in appropriate position.

I Close the front cover.

Important
❒ Do not close the front cover

with force. If you cannot close
the cover easily, pull out the
toner cartridge from the printer
and insert it again. After that,
close the front cover again.
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Cleaning and Adjusting the Printer

Cleaning the Friction Pad

If the friction pad is dirty, a multi-
feed or misfeed might occur. In this
case, clean the pad as follows:

A Lift the paper tray slightly then
pull it out until it stops, and while
lifting the front side of the tray,
pull it out of the printer.

B Place the tray on a flat surface.
When there is paper in the tray,
remove paper.

C Wipe the brown part of the fric-
tion pad with a soft damp cloth.
After that, wipe it with a dry cloth
to remove the water.

Important
❒ Do not use chemical cleaner or

organic solvent such as thinner
or benzene.

D Load paper into the paper tray
with the print side up. Carefully
slide the paper tray into the print-
er until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

Note
❒ If misfeeds or multi-feeds of pa-

per occur after cleaning the fric-
tion pad, contact your sales or
service representative.

❒ Follow the same procedure to
clean the friction pad of the op-
tional Paper Feed Unit and the
Envelope Feeder Unit.

TS3Y250E
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Cleaning the Paper Feed 
Roller

If the paper feed roller is dirty, a mis-
feed might occur. In this case, clean
the roller as follows:

R CAUTION:

Important
❒ The following are examples of

cleaning the paper feed roller on
the paper tray.

❒  You can clean the paper feed roller
on the optional Paper Feed Unit by
following the procedures below.
The paper feed roller on the op-
tional Paper Feed Unit differs from
one on the paper tray. Confirm the
type of paper feed roller you are
installing.

A Turn off the power switch.

B Pull out the plug from the socket.
Remove all the cables from the
printer.

C Lift the paper tray slightly then
pull it out until it stops, and while
lifting the front side of the tray,
pull it out of the printer.

D Move the printer to the edge of a
stable table or desk.

Important
❒ Do not put the printer on an un-

stable or tilted surface.
❒ If the printer is equipped with

the optional Paper Feed Unit,
do not move the printer and
unit together as they are not se-
curely attached.

❒ When lifting the printer, con-
firm that the optional Paper
Feed Unit is not attached to the
printer.

• When lifting the printer, use the 
grips on both sides of the printer, 
otherwise the printer might fall 
and cause personal injury.

• When you move the printer, un-
plug the power cord from the wall 
outlet to avoid a fire or an electric 
shock.

• When you pull out the plug from 
the socket, grip the plug to avoid 
damaging the cord and causing 
a fire or an electric shock.
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E Slide the green lock lever to the
left (AAAA), so that the paper feed
roller can be released (BBBB).

F Wipe the rubber part of the roller
with a soft damp cloth. After that,
wipe it with a dry cloth to remove
the water.

Important
❒ Do not use chemical cleaner or

organic solvent such as thinner
or benzene.

G While sliding the green lock lever
to the left (AAAA), set the paper feed
roller to its original position (BBBB).
After that, return the green lock
lever to its original position (CCCC).

Note
❒ Confirm that the green lock le-

ver secures the roller correctly
by confirming that the roller ro-
tates smoothly.

H Move the printer to the place
where it was placed. Carefully
slide the paper tray into the print-
er until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

I Insert the plug of the power cord
into the wall socket securely.
Connect all the cables that were
removed in step BBBB.

J Turn on the power switch.

Note
❒ Follow the same procedure to

clean the paper feed roller of the
optional Paper Feed Unit.
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Cleaning the Registration 
Roller

If the registration roller is dirty, a mis-
feed might occur. In this case, clean
the roller as follows:

R WARNING:

R CAUTION:

A Turn off the power switch.

B Open the front cover by pushing
the front cover release button. 

C Pull the toner cartridge out of the
printer by holding the grips of the
cartridge.

Note
❒ Do not hold the toner cartridge

upside down or stand it verti-
cally.

❒ Do not put the toner cartridge
on an unstaple or tilted surface.

D Wipe around the metallic regis-
tration roller by turning with a
soft damp cloth.

Important
❒ Do not use chemical cleaner or

organic solvent such as thinner
or benzene.

• Be sure to turn off the power 
switch and wait for about 30 
minutes before cleaning the 
registration roller. Not waiting 
for the printer to cool down 
can result in a burn.

• The inside of the printer be-
comes very hot. Do not touch the 
parts with a label indicating the 
“hot surface”, otherwise it could 
cause a burn.
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E Holding the grips of the toner car-
tridge, insert it into the printer
until it stops.

F Push down the toner cartridge to
settle it in appropriate position.

G Close the front cover.

Important
❒ Carefully close the front cover. If

you cannot close the cover easily,
pull the toner cartridge out of the
printer and insert it again. After
that, close the front cover again.

H Turn on the power switch.

Adjusting the Image Density

You can adjust the image density
when the print side of the page is a
hazy gray or print image is too light.

Important
❒ Extreme settings may create print-

outs that appear dirty.
❒ Image density settings should be

made from the application or the
printer driver whenever possible.

A Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
"Maintenance" menu, and then
press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Maintenance:

   Image Density

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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C Press {{{{Enter #}}}}.

  Image Density:

   -2

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the image
density value.

Note
❒ To maintain a darker image un-

der high volume printing condi-
tions, we highly recommended
that you select 3 from the opera-
tion panel.

❒ You can adjust the image densi-
ty, -3 to +3, from seven steps. In-
creasing the value makes the
printouts darker and decreasing
thinner.

E Press {{{{Enter #}}}}.

F Press {{{{Online}}}}.

"Ready" message appears on the
panel display.

  Ready

   

Adjusting the "Registration" of 
the Trays

You can adjust the registration of
each tray. The vertical adjustment is
used for all trays. Normally, you need
not update the registration. But when
the optional Paper Feed Unit or the
Duplex Unit is installed, updating the
registration is useful in some case.
The following procedure describes
how to adjust Tray 1. You can use the
same procedure to adjust the other
tray as well.

A Press {{{{Menu}}}}.

"Menu" appears on the panel display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
"Maintenance" menu, and then
press {{{{Enter #}}}}.

  Maintenance:

   Image Density

EnterForm Feed

Job Reset
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Escape

Menu

Power Error Data In
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Escape
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C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Reg-
istration", and then press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Registration:

   Prt. Test Sheet

D Print the test sheet to preview the
settings you have made.

A After confirming that "Prt. Test
Sheet" is on the panel display,
press {{{{Enter #}}}}.

The following message appears
on the panel display.

  Prt. Test Sheet

   Tray 1

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
tray you want to adjust, and
then press {{{{Enter #}}}} to print the
test sheet. Wait for two sec-
onds.

The following message appears
on the panel display.

  Printing...

  

E Adjust the registration by con-
firming the position of the print-
ed image of the test sheet.
The following are example to ad-
just the margin on the test sheet
equally.
A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display

"Adjustment", and then press
{{{{Enter #}}}}.

The following message appears
on the panel display.

  Adjustment:

   Horiz.: Tray 1

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
tray you want to adjust, and
then press {{{{Enter #}}}}.

The following message appears
on the panel display.

  Horiz.: Tray 1

   -4.0 mm

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the dig-
it of the registration value
(mm).

Note
❒ Increase the value to shift the

print area in a positive direc-
tion, and decrease to shift in a
negative direction.

❒ Pressing {UUUU} or {TTTT} makes
the value increase or de-
crease by 1.0 mm step.
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F Print the test sheet to check the
settings you have made.

G Repeat steps CCCC and DDDD to adjust the
registration if necessary.

H Press {{{{Online}}}}.

“Ready” appears on the panel dis-
play.

  Ready

  

EnterForm Feed
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6. Making Printer Settings with
the Operation Panel
Menu Chart

This section describes how to change the default settings of the printer and pro-
vides information on the parameters included in each menu.

Category Function menu

Sample Print *1  ⇒ P.49 Select Action / Show Error Log

Locked Print *1  ⇒ P.53 Select Action / Show Error Log 

Paper Input⇒ P.103 Bypass Size

Tray Paper Size

Paper Type

Tray Locking

Tray Priority

List/Test Print⇒ P.107 Config. Page

Menu List

PCL Config.Page

PS Font List

Hex Dump

Maintenance⇒ P.111 Image Density

Registration Prt. Test Sheet

Adjustment

HDD Format

Menu Protect *2 

System⇒ P.115 MisfeedRecovery

Prt. Err Report

Auto Continue

Memory Overflow

Duplex

Output Tray

Job Separation

Energy Saver

Memory Usage

Unit Of Measure
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*1 The “Sample Print” menu and the “Locked Print” menu appear only when the op-
tional Hard Disk Drive is installed.

*2 While the printer is On Line, press {Enter #}, and then press {Escape}, finally press
{Menu}. You can access the “Menu Protect” on the panel display.

System⇒ P.115 Edge Smoothing

Resolution PCL

PS

Toner Saving

Host Interface⇒ P.120 I/O Buffer

I/O Timeout

Network Setup IP Address

Subnet Mask

Gateway Address

Access Control

Access Mask

Network Boot

Frame Type (NW)

Active Protocol

Ethernet

PCL Menu⇒ P.124 Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Language⇒ P.128

Category Function menu
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Accessing the Main Menu

Press {Menu}, and “Menu” appears on the panel display.

This menu shows the following nine items which can be displayed one by one
pressing {UUUU} or {TTTT}.
• Sample Print
• Locked Print
• Paper Input
• List/Test Print
• Maintenance
• System
• Host Interface
• PCL Menu
• Language

Note
❒ If the optional Hard Disk Drive is not installed, the “Sample Print” menu and

the “Locked print” menu cannot be displayed on the operation panel.
❒ {TTTT}: Press to go to the next page.
❒ {UUUU}: Press to go back to the previous page.
❒ After making the printer settings, be sure to return to the previous menu by

pressing {Escape}.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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Job Reset
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Escape
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❒ After making the printer settings, press {Online} to return to the “Ready” con-
dition.

❒ The revised settings are not canceled even if the power switch is turned off.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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Paper Input Menu

There are five menu items in the “Paper Input” menu.
• Bypass size
• Tray Paper Size
• Paper type
• Tray Locking
• Tray Priority

Reference
For more information about loading paper in the tray, see P.38 “Loading Paper
and Other Media”.

Paper Input Parameters

Menu Description

Bypass Size The paper size for the bypass tray.

For more information about paper sizes that can be set in the by-
pass tray, see P.25 “Paper and Other Media Supported by This Print-
er”.

Tray Paper Size The paper size for the optional Envelope Feeder. Use to specify 
sizes not indicated on the paper size dial of Tray 1, Tray 2, Tray 3.

When you select the sizes that are not indicated on the paper size 
dial of Tray 1, Tray 2 or Tray 3, you should set the dial to “p” and 
then select the paper size here.

❖❖❖❖ Tray 1
For more information about paper sizes that can be set in the 
Tray 1, see P.25 “Paper and Other Media Supported by This Print-
er”.

❖❖❖❖ Tray 2
For more information about paper sizes that can be set in the 
Tray 2, see P.25 “Paper and Other Media Supported by This Print-
er”.

❖❖❖❖ Tray 3
For more information about paper sizes that can be set in the 
Tray 3, see P.25 “Paper and Other Media Supported by This Print-
er”.

Note
❒ Only the installed trays appear on the panel display.
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Paper type If you use different kinds of paper, you set the paper type for Tray 
1, Tray 2, Tray 3 or Bypass Tray.

❖❖❖❖ Tray 1, Tray 2, Tray 3
Plain Paper, Recycled Paper, Special Paper, Color Paper, Let-
terhead, Preprinted, Prepunched, Bond paper, Cardstock

❖❖❖❖ Bypass Tray
Plain Paper, Recycled Paper, Special Paper, Color Paper, Let-
terhead, Preprinted, Prepunched, Bond paper, Cardstock, 
Transparency, Thick Paper

Note
❒ Default : Plain Paper

❒ Only the installed trays appear on the panel display.

Tray Locking If you use different kinds of paper, you can lock a tray to prevent 
printing on wrong paper such as letterhead or colored paper. 
When "Auto Select" is selected in the Paper Source selections from 
the printer driver, the locked tray will not be used.

Tray 1, Tray 2, Tray 3, Bypass Tray

Note
❒ Default : Tray 1

❒ Only the installed trays appear on the panel display.

❒ You cannot lock multiple trays.

❒ If you want to use the locked tray, you must select the tray 
from the printer driver.

❒ When a locked tray is selected from the printer driver, the 
printer does not search for another tray.

Tray Priority You can set which tray should be checked first when "Auto tray 
Select" is selected in the Paper Source selections from the printer 
driver. When printing from DOS, the tray selected here is used 
when no tray is selected for a print job.

Tray 1, Tray 2, Tray 3, Bypass Tray

Note
❒ Default : Tray 1

❒ Only the installed trays appear on the panel display.

❒ It is recommended that you load paper of the size and direc-
tion you most frequently use in the tray selected with "Tray 
Priority".

Menu Description
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Changing the Paper Input Menu

A Press {{{{Menu}}}}.

“Menu” appears on the panel display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “Paper Input” menu.

  Menu:

   Paper Input

C Press {{{{Enter #}}}}.

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Tray Priority”.

  Paper Input:

   Tray Priority

E Press {{{{Enter #}}}}.
The following message appears on the panel display.

  Tray Priority:

   *Tray 1

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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Escape
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F Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the tray type you want to use.

G Press {{{{Enter #}}}}. Wait for two seconds.
“Menu” appears on the panel display.

H Press {{{{Online}}}}.

 “Ready” message appears on the panel display.

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu
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List/Test Print Menu

There are five menu items in the “List/Test Print” menu.
• Config. Page
• Menu List
• PCL Config.Page
• PS Font List
• Hex Dump

List/Test Print Parameters

Printing a Configuration Page

Reference
For more information, see P.109 “Interpreting the Configuration Page”.

A Press {{{{Menu}}}}.

“Menu” appears on the panel display.

B Press {{{{TTTT}}}} or {{{{UUUU}}}} to display “List/Test Print” menu.

  Menu:

   List/Test Print

Menu Description

Config. Page You can print the current configuration of the printer. See P.107 
“Printing a Configuration Page”. 

Menu List You can print the Menu List which shows the function menus of 
this printer.

PCL Config.Page You can print the current configuration of the PCL.

PS Font List You can print a list of the installed PS Fonts.

Hex Dump You can print the Hex Dump.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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C Press {{{{Enter #}}}}.

The following message appears on the panel display.

  List/Test Print:

   Config. Page

D Press {{{{Enter #}}}}.
The following message appears on the panel display.

  Printing...

   

In a short time, the printing a configuration page will start.

Important
❒ If you cannot complete printing a configuration page correctly, make sure

an error message appears on the panel display. For more information
about error messages, see P.59 “Error & Status Messages on the Operation
Panel”.

E Press {{{{Online}}}}.

“Ready” message appears on the panel display.

  Ready    

EnterForm Feed

Job Reset

On Line

Escape

Menu
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Interpreting the Configuration Page

System Reference

❖❖❖❖ Printer ID
Shows the serial number assigned to the board by its manufacturer.

❖❖❖❖ Firmware Version
Shows the version number of the printer firmware.

❖❖❖❖ Engine version
Shows the version number of the printer engine.

❖❖❖❖ Pages Printed
Shows the total number of pages printed by the printer to date.

❖❖❖❖ NCS Version
This item appears when the optional Network Interface Board is installed.

❖❖❖❖ Total Memory
Shows the total amount of memory (SDRAM) installed on the printer.

❖❖❖❖ Printer Language
Shows the version number of the printer driver language.

❖❖❖❖ Printer Hard Disk Drive
This item appears when the optional Hard Disk Drive is installed.

❖❖❖❖ Options
Show the optional trays that you installed.

Paper Input

Shows the settings made under the “Paper Input” menu.

Reference
For more information, see P.103 “Paper Input Menu”.

System

Shows the settings made under the “System” menu. 

Reference
For more information, see P.115 “System Menu”.
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PCL Menu

Shows the settings you made under the “PCL Menu”. 

Reference
For more information, see P.124 “PCL Menu”.

Host Interface

Shows the settings you made under the “Host Interface” menu. 
When DHCP is active on the network, the actual IP Address, Subnet Mask and
Gateway Address appear in parentheses on the configuration page.

Reference
For more information about “Host Interface” menu, see P.120 “Host Interface
Menu”.

Error Log

Shows the log of printer errors.
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Maintenance Menu

There are four menu items in the “Maintenance” menu.
• Image Density
• Registration
• HDD Format
• Menu Protect

Note
❒ This “HDD Format” appears only when the Hard Disk Drive is installed.

For more information, see “Installing the Hard Disk Drive Type 2600” in the
Setup Guide.

Maintenance Menu Parameters 

Menu Description

Image Density You can select the print image density.

-3 to 3

Reference
For more information, see P.95 “Adjusting the Image Density”.

Registration ❖❖❖❖ Prt. Test Sheet
You can print the registration test sheet.
Tray 1, Tray 2, Tray 3, Bypass Tray

Note
❒ Default : Tray 1

❒ Only the installed trays appear on the panel display.

❖❖❖❖ Adjustment
You can select the start position for printing on page.
Horiz. Tray 1, Horiz. Tray 2, Horiz. Tray 3, Horiz. Bypass, 
Horiz. :Dup.-Back, Vert. All Trays, Vert. Dup.-Back
-4 to 4

Note
❒ Default : Horiz.: Tray 1

❒ The registration value are not default.

❒ Only the installed trays appear on the panel display.

Reference
For more information, see P.96 “Adjusting the "Registration" 
of the Trays”.
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 Changing the Maintenance Menu

Protecting the menus

A Check if the On Line indicator is on. If not, press {{{{Online}}}} to enter the
"Ready" condition.

B Press {{{{Enter #}}}}, then {{{{Escape}}}}, and then {{{{Menu}}}}.

"Menu" appears on the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “Maintenance” menu, and then press {{{{Enter #}}}}.

The following message appears on the panel display.

  Maintenance:

   Image Density

HDD Format After installing the Hard Disk Drive, format it.

Reference
For more information about formatting the Hard Disk Drive, 
see "Installing the Hard Disk Drive Type 2600" in the Setup Guide.

Menu Protect This procedure lets you protect menu settings against accidental 
changes. It makes it impossible to change the menu settings you 
make with the normal procedure unless you perform the required 
key operation. In a network environment, protecting settings re-
stricts changes to menu settings to network administrators.

• Level 1

• Level 2

• Off

Note
❒ While the printer is Online, press {Enter #}, and then press {Es-

cape}, finally press {Menu}. You can access the "Menu Protect" 
menu on the panel display.

Menu Description

EnterForm Feed

Job Reset
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Escape

Menu
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D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Menu Protect”.

  Maintenance:

   Menu Protect

E Press {{{{Enter #}}}}.

The following message appears on the panel display.

  Menu Protect:

  *Off

F Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the levels desired, and then press {{{{Enter #}}}}. Wait
for two seconds.
“Menu” appears on the panel display.

G Press {{{{Online}}}}.

"Ready" message appears on the panel display.

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
113



Making Printer Settings with the Operation Panel

114

6

Removing Protect

A Check if the On Line indicator is on. If not, press {{{{Online}}}} to enter the
"Ready" condition.

B Press {{{{Enter #}}}}, then {{{{Escape}}}}, and then {{{{Menu}}}}.
“Menu” appears on the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Maintenance” menu, and then press {{{{Enter #}}}}.

The following message appears on the panel display.

  Maintenance:

   Image Density

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “Menu Protect”, and then press {{{{Enter #}}}}.

E Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Off”, and then press {{{{Enter #}}}}. Wait for two
seconds.
“Menu” appears on the panel display.

F Press {{{{Online}}}}.

“Ready” message appears on the panel display.
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System Menu

There are 13 menu items in the “System” menu.
• MisfeedRecovery
• Prt. Err Report
• Auto Continue
• Memory Overflow
• Duplex
• Output Tray
• Job Separation
• Energy Saver
• Memory Usage
• Unit Of Measure
• Edge Smoothing
• Resolution
• Toner Saving

System Parameters

Menu Description

MisfeedRecovery You can select whether Misfeed Recovery is enabled. When it is 
on, printing restarts after the misfed paper has been cleared.

• On

• Off

Note
❒ Default: On

Prt. Err Report You can select whether or not to have a error report printed when 
a printer error or memory error occurs.

• On

• Off

Note
❒ Default: Off

Auto Continue You can set whether Auto Continue is enabled. When it is on, 
printing continues after a system error occurs.

• On

• Off

Note
❒ Default: Off

❒ When it is on, and certain types of error occur, the current job might 
be canceled, and the machine automatically resumes the next job.
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Memory Overflow You can select whether the memory overflow error report should 
be printed.

• Not Print

• Error Report

Note
❒ Default: Not Print

Duplex You can select whether you want to print on both sides of each 
page.

• Off

• Short Edge Bind

• Long Edge Bind

Note
❒ Default: Off

❒ This menu appears only when the optional Duplex Unit is in-
stalled.

Output Tray You can select the default output tray. When you select "Auto 
Tray Sw.", the printer automatically changes to another output 
tray if the output tray become full. This function is available only 
when the Mailbox or the 1-bin Shift Sort Tray is installed.

Standard Tray, Mailbox Tray 1, Mailbox Tray 2, Mailbox Tray 3, 
Mailbox Tray 4, Upper Tray, Auto Tray Sw.

Note
❒ Default: Standard Tray

❒ Only the installed trays appear on the panel display.

Job Separation You can enable Job Separation.

• On

• Off

Note
❒ Default: Off

❒ This menu appears only when the optional 1-bin Shift Sort 
Tray is installed.

Energy Saver You can set how many minutes the printer wait before switching 
to Energy Saver mode. Energy Saver mode reduces electric power 
consumption.

5 minutes, 15 minutes, 30 minutes, 45 minutes, 60 minutes

Note
❒ Default: 30 minutes

❒ If there is an error in the printer, the printer will not turn into 
Energy Saver mode.

❒ When the printer switches to Energy Saver mode, the Power 
indicator turns off, while the Online indicator stays on.
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Memory Usage You can select the volume of memory to be used from "Font Pri-
ority" or "Frame Priority", according to the paper size, resolution 
or printer language.

• Font Priority
This setting uses memory for registering fonts.

• Frame Priority
This setting uses frame memory for high speed printing.

Note
❒ Default: Frame Priority

Reference
For more information, see P.139 “Memory Capacity and Paper 
Size”.

Unit Of Measure You can select "mm" or "inch" for the custom paper size.

Edge Smoothing You can set whether Edge Smoothing is enabled.

• On

• Off

Note
❒ Default: On

❒ If "Toner Saving" is "On", "Edge Smoothing" is ignored even if 
it is "On".

❒ "Edge Smoothing" is not effective when 1200 dpi resolution is 
selected. 

Resolution You can set the print resolution in dots per inch.

❖❖❖❖ PCL
300 dpi, 600 dpi

❖❖❖❖ PS
300 dpi, 600 dpi, 1200 dpi

Note
❒ Default: 600 dpi

Toner Saving You can select whether or not Toner Saving is enabled.

• On

• Off

Note
❒ Default: Off

❒ If "Toner Saving" is "On", "Edge Smoothing" is ignored even if 
it is "On".
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Changing the System Menu

A Press {{{{Menu}}}}.

“Menu” appears on the panel display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “System” menu.

  Menu:

   System

C Press {{{{Enter #}}}}.

The following message appears on the panel display.

  System:

   MisfeedRecovery

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Energy Saver”.

  System:

   Energy Saver

EnterForm Feed
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E Press {{{{Enter #}}}}.

The following message appears on the panel display.

  Energy Saver:

   *30 minutes

F Press {{{{UUUU}}}} or {{{{TTTT}}}} to select how many minutes the printer waits before
switching to Energy Saver mode.

G Press {{{{Enter #}}}}. Wait for two seconds.
“Menu” appears on the panel display.

H Press {{{{Online}}}}.

“Ready” message appears on the panel display.

  Ready

   

EnterForm Feed

Job Reset
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Menu

Power Error Data In
119



Making Printer Settings with the Operation Panel

120

6

Host Interface Menu

There are three menu items in the “Host Interface” menu.
• I/O Buffer
• I/O Timeout
• Network Setup

Note
❒ The “Network Setup” appears only when the optional Network Interface

Board is installed. For more information about the “Network Setup”, see “Con-
figuring the power for the Network with the Operation Panel” in the “Setup Guide”.

Host Interface Parameters 

Menu Description

I/O Buffer You can set the size of the I/O Buffer. Normally it is not necessary 
to change this setting.

16 KB, 32 KB, 64 KB, 128 KB, 256 KB, 512 KB

Note
❒ Default: 32 KB

I/O Timeout You can set how many seconds the printer should wait before 
ending a print job. If data from other port often appears in the 
middle of the print job, you should increase the timeout value.

10 seconds, 15 seconds, 20 seconds, 25 seconds, 60 seconds

Note
❒ Default: 15 seconds

Network Setup ❖❖❖❖ IP Address
You can set the IP Address.

Note
❒ Default: 011.022.033.044

Reference
See “Configuring the Printer for the Network with the Opera-
tion Panel” in the Setup Guide.

❖❖❖❖ Subnet Mask
You can set the Subnet Mask.

Note
❒ Default: All zero

Reference
See “Configuring the Printer for the Network with the Opera-
tion Panel” in the Setup Guide.
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Network Setup ❖❖❖❖ Gateway Address
You can set the Gateway Address.

Note
❒ Default: All zero

Reference
See “Configuring the Printer for the Network with the Opera-
tion Panel” in the Setup Guide.

❖❖❖❖ Access Control
You can set the Access Control Address.

Note
❒ Default: All zero

❖❖❖❖ Access Mask
You can set the Access Control Mask.

Note
❒ Default: All zero

❖❖❖❖ Network Boot
You can set how the Network Interface Board acquires TCP/
IP settings.

Note
❒ Default: None

Reference
See “Configuring the Printer for the Network with the Opera-
tion Panel” in the Setup Guide.

❖❖❖❖ Frame Type (NW)
You can set the Frame Type for NetWare.

Note
❒ Default: Auto

❖❖❖❖ Active Protocol
You can set the active protocol.
TCP/IP, NetWare, NetBEUI, AppleTalk

Note
❒ Default: All Active

Menu Description
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Changing the Host Interface Menu

A Press {{{{Menu}}}}.

“Menu” appears on the panel display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “Host Interface” menu.

  Menu:

   Host Interface

C Press {{{{Enter #}}}}.

The following message appears on the panel display.

  Host Interface:

   I/O Buffer

Network Setup ❖❖❖❖ Ethernet
You can select the speed of the network that the printer is connected to.
Auto, 10 Mbps., 100 Mbps.

Note
❒ Default: Auto

Reference
See  “Configuring the Printer for the Network with the Opera-
tion Panel” in the Setup Guide.

Menu Description
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D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “I/O Timeout”.

  Host Interface:

   I/O Timeout

E Press {{{{Enter #}}}}.

The following message appears on the panel display.

  I/O Timeout:

   *15 seconds

F Press {{{{UUUU}}}} or {{{{TTTT}}}} to select how many minutes the printer waits before ending a print job.

G Press {{{{Enter #}}}}. Wait for two seconds.

“Menu” appears on the panel display.

H Press {{{{Online}}}}.

“Ready” message appears on the panel display.

  Ready
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PCL Menu

There are seven menu items in the “PCL Menu” .
• Orientation
• Form Lines
• Font Source
• Font Number
• Point Size
• Font Pitch
• Symbol Set

PCL Parameters

Menu Description

Orientation You can set the page orientation.

• Portrait

• Landscape

Note
❒ Default: Portrait

Form Lines You can set the number of lines per page.

5-128

Note
❒ Default: 64 (Metric version), 60 (Inch version)

Font Source You can set the location of the default font.

• Internal

• Download

Note
❒ Default: Internal

❒ When you select "Download", you can select only fonts down-
loaded to printer RAM.

Font Number You can set the ID of the default font you want to use.

• 0 to 44 (for Internal)

• 1 to 44 (for Download source)

Note
❒ Default: Internal

❒ Default: 0
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Point Size You can set the point size you want to use for the default font.

4 to 999.75 by 0.25

Note
❒ Default: 12.00

❒ This setting is effective only for a variable-space font.

Font Pitch You can set the number of characters per inch you want to use for 
the default font.

0.44 to 99.99 by 0.01

Note
❒ Default: 10.00

❒ This setting is effective only for a fixed-space font.

Symbol Set You can specify the set of print characters for the default font. The 
available options are as follows.

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-
852, PC8-TK, Win L1, Win L2, Win L5, Desktop, PS Text, VN Intl, 
VN US, MS Publ, Math-8, PS Math, VN Math, Pifont, Legal, ISO 4, 
ISO 6, ISO 11, ISO 15, ISO 17, ISO 21, ISO 60, ISO 69, Win 3.0

Note
❒ Default: Roman-8
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Changing the PCL Menu

A Press {{{{Menu}}}}.

"Menu" appears on the panel display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "PCL Menu", and then press {{{{Enter #}}}}.

The following message appears on the panel display.

  PCL Menu:

   Orientation

C Press {{{{Enter #}}}}.

  Orientation:

   *Portrait

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the orientation desired, and then press {{{{Enter #}}}}.
Wait for two seconds.

“Menu” appears on the panel display.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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E Press {{{{Online}}}}.

"Ready" message appears on the panel display.

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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Language Menu

You can select the language you use. Available language as are follows.
English, French, German, Italian, Spanish, Dutch, Swedish, Norwegian, Danish,
Finnish, Portuguese, Czech, Polish, Hungarian

Note
❒ Default: English

Changing the Language Menu

You can change the language by the following procedures below.

A Press {{{{Menu}}}}.

”Menu” appears on the panel display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Language” menu.

  Menu:

   Language

C Press {{{{Enter #}}}}.

The following message appears on the panel display.

  Language:

  *English

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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D Press {{{{UUUU}}}} or {{{{TTTT}}}} until the language you want to select appears on the panel
display.

E Press {{{{Enter #}}}}. Wait for two seconds.

“Menu” appears on the panel display.

F Press {{{{Online}}}}.

"Ready" message appears on the panel display.

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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7. Appendix
Replacing Parts

The maintenance kit contains parts necessary for maintaining the printer. When
“Replace Maintenance Kit” appears on the panel display, install the replacement
parts included in the maintenance kit.

R WARNING:

R CAUTION:

Note
❒ If you dispose of the used parts yourself, dispose of them according to local

regulations.

• It is dangerous to handle the plug with wet hands. An electric shock 
might occur.

• The inside of the machine could be very hot. Do not touch the parts with a 
label indicating the “hot surface”. Otherwise, it could cause a personal burn.

• When you pull the plug out of the socket, grip the plug to avoid damaging 
the cord and causing a fire or an electric shock.

• Be sure to turn off the printer and wait for about an hour before replacing 
parts. Not waiting for the printer to cool down can result in a burn.
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MAINTENANCE KIT Type 2600

Checking the contents of the box

Check the contents of the box according to the following list. If one or more items
are missing, contact your sales or service representative.

Description Quantity

Friction pad for 
the paper tray 
(Tray 1)

1 pc ⇒ P.133 “Replacing the Friction 
Pad”.

Friction pad for 
the Paper Feed 
Unit (Tray 2, 3)

2 pcs

Paper feed roller 
for the paper 
tray (Tray 1)

1 pc ⇒ P.135 “Replacing the Paper 
Feed Rollers”.

Paper feed roller 
for the Paper 
Feed Unit (Tray 
2, 3)

2 pcs

Transfer roller 1 pc ⇒ P.136 “Replacing the Transfer 
Roller”.

Gloves 1 pair

Fusing Unit 1 pc ⇒ P.1 “This device may not 
cause harmful interference, and”.
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Preparing to replace the parts

You should the replace all the parts included in Maintenance Kit at the same
time. Be sure to replace them in the following order:

A Check the contents of the box for the following items:
• Friction pad for the paper tray (Tray 1)
• Friction pad for the Paper Feed Unit (Tray 2, 3)
• Paper feed roller for the paper tray (Tray 1)
• Paper feed roller for the Paper Feed Unit (Tray 2, 3)
• Transfer roller
• Fusing Unit
• Gloves

B Be sure to check the following points:

• The power switch is turned off.
• The power cord is unplugged from the wall outlet.
• The interface cable is unplugged from the printer.

Replacing the Friction Pad

Replace all friction pad of the tray.
There are two kinds of friction pads.
One is for the paper tray (Tray 1), and
the other are for the Paper Feed
Unit(s) (Tray 2, 3). The following pro-
cedure shows how to replacing fric-
tion pad of the paper tray (Tray1).

A If the optional Duplex Unit, the
Mailbox or the 1–bin Shift Sort
Tray are installed, uninstall them
from the printer.

B Lift the paper tray slightly then
pull it out until it stops.

C While lifting the front side of the
tray, pull it out of the printer.

ZCEY430J
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D Remove paper from the paper tray.
Place the tray upside down on a
flat surface.

E Use a sharp-pointed item like a
ball-point pen, to release the two
catches that lock the friction pad.

F Return the paper tray to its origi-
nal position, and remove the fric-
tion pad from the tray.

G Insert the new friction pad in the
paper tray.

Attach the center projection of the
new friction pad to the spring and
align the projection of both sides of
the friction pad to the holes of the
paper tray. Then push the friction
pad as shown in the illustration
until it clicks.

H Push the friction pad until it locks
securely.

I If your printer is equipped with
the optional Paper Feed Unit(s),
follow the same procedure when
replacing the friction pad.
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Replacing the Paper Feed 
Rollers

Replace all feed rollers including the
printer and the optional Paper Feed
Unit(s). The following procedure
shows how to replacing the paper
feed rollers of the printer.

R CAUTION:

A Move the printer to the edge of a
sturdy and stable table or desk.

Important
❒ Do not put the printer on an un-

stable or tilted surface.

Note
❒ If the printer is equipped with

the optional Paper Feed Unit,
do not move the printer and the
unit together, they are not se-
curely attached.

B Slide the green lock lever to the
right (AAAA), remove the paper feed
roller (BBBB).

C While sliding the green lock lever to
the right (AAAA), set the new roller (BBBB).
After that, return the green lock le-
ver to its original position (CCCC).

Note
❒ Confirm that the green lock le-

ver secures the roller correctly
by checking if the new roller ro-
tates smoothly.

D If the printer is equipped with the
optional Paper Feed Unit(s), fol-
low the same procedure when re-
placing the paper feed roller.
If you installed two Paper Feed
Units, also replace both paper feed
rollers.

E Leave the paper tray pulled out
and go to P.136 “Replacing the
Transfer Roller”.

• When lifting the machine, use 
the inset grips on both sides. 
Otherwise the printer could 
break or cause injury if dropped.
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Replacing the Transfer Roller

A Open the front cover by pushing
the front cover release button.

B Pull the toner cartridge out of the
printer, while lifting the front
side.

C To avoid making your hands
dirty with toner from the transfer
roller. Wear the gloves included
in the maintenance kit.

D Hold the lock levers (“$$$$” parts),
and pull them.

E Hold the green parts of the roller
on both sides, and remove the
roller from the printer as shown
in the illustration.

F When inserting the new transfer
roller,  the gear  of the roller
should be positioned on the left.
Push down the green parts of
both sides of the printer until it
clicks as shown in the illustration.

Note
❒ When the transfer roller is set,

the transfer roller cover will re-
turn to its original position au-
tomatically.

ZCEM???J
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G Holding the grips of the toner car-
tridge, insert it into the printer
until it stops.

H Push down the toner cartridge to
insert it in its appropriate posi-
tion.

I Close the front cover.

J Take the gloves off and go to P.1
“This device may not cause harm-
ful interference, and”.

Replacing the Fusing Unit

R CAUTION:

A If the rear cover is attached to the
printer, remove it.

A Open the rear cover by push-
ing the two knobs.

B Remove the rear cover in a hor-
izontal direction.

• The fusing unit becomes very 
hot. When installing the new fus-
ing unit, turn off the printer and 
wait about an hour. After that, in-
stall the new fusing unit. Not 
waiting for the unit to cool down 
can result in a burn.
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B Lift the lock levers of the fusing
unit as shown in the illustration.

C Pull the fusing unit out.

D Replace the new fusing unit into
the printer.

E Push the lock levers of the fusing
unit down until it clicks.

F Insert the rear cover to the inside
grooves on both sides of the print-
er in a horizontal direction.

G Close the rear cover.

H Print a configuration page to con-
firm that the printer works properly.

Reference
For more information about
printing the configuration page,
see “List/Test Print Menu” in the
Printer Reference is provided as
a PDF file on the CD-ROM la-
beled “Operating Instructions”.

ZCEX222J
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Memory Capacity and Paper Size

The following tables show the typical memory requirements of the RPCS printer
language. Memory requirements depend on your print data and printing envi-
ronment,  such as the "Memory Priority" setting or total memory size that the
printer has available. The print mode also effects whether the print job will
equally completed.

Setting of the “Frame Priority”

❍ means that the print job is supported by simplex and duplex printing.
❍* means it might be impossible to print images complex data with duplex
printing. Even with simple date, the number of pages printed with duplex print-
ing might be limited.
$ means that the print job is supported by simplex printing.
-- means that the print job is not printed.

Paper Size
Memory 

Capacity

Resolution (dpi)

400 x 400 600 x 600 1200 x 1200

B5
32MB ❍ ❍ ❍

96MB ❍ ❍ ❍

A4 (210 × 297)

Letter (81/2"×11")

32MB ❍ ❍ ❍

96MB ❍ ❍ ❍

B4
32MB ❍ ❍ ❍

96MB ❍ ❍ ❍

A3

(11" × 17")

32MB ❍ ❍ ❍*

96MB ❍ ❍ ❍

Custom Size 
(Max.)

(127 x 1,260 mm)

32MB $ $ --

96MB $ $ --
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Setting of the “Font Priority”

❍ means that the print job is supported by simplex and duplex printing.
❍* means it might be impossible to print images complex data with duplex
printing. Even with simple date, the number of pages printed with duplex print-
ing might be limited.
$ means that the print job is supported by simplex printing.
$* means it might be impossible to print images complex data with printing.
Even with simple data, the number of pages printed with printing might be lim-
ited.
-- means that the print job is not printed.

Paper Size
Memory 

Capacity

Resolution (dpi)

400 x 400 600 x 600 1200 x 1200

B5
32MB ❍ ❍ ❍

96MB ❍ ❍ ❍

A4 (210 × 297)

Letter (81/2"×11")

32MB ❍ ❍ ❍*

96MB ❍ ❍ ❍

B4
32MB ❍ ❍ ❍*

96MB ❍ ❍ ❍

A3

(11" × 17")

32MB ❍ ❍ $*

96MB ❍ ❍ ❍

Custom Size 
(Max.)

(127 x 1,260 mm)

32MB $ $ --

96MB $ $ --
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Moving and Transporting the Printer

R CAUTION:

Repack the printer in its original
packing materials for transporting.

Important
❒ Be sure to disconnect all cables from

the printer before transporting it.
❒ The printer is a precision piece of

machinery. Take care to avoid
damage during shipment.

Moving the Printer

R CAUTION:

Moving the printer in the short distance

A Be sure to check the following points:

• The power switch is turned off.
• The power cord is unplugged

from the wall outlet.
• The interface cable is unplugged

from the printer.

B If you installed external options,
remove them.

Removing the Mailbox or the 1-
bin Shift Sort Tray

The following procedure shows how
to remove the Mailbox as an example.
A Pull all the upper trays out.

B While pushing the lock but-
tons (AAAA), pull the Mailbox out
(BBBB).

• When lifting the machine, use the 
inset grips on both sides. Other-
wise the printer could break or 
cause injury if dropped.

• When you move the printer, re-
member to unplug the power 
cord from the wall outlet to avoid 
a fire or an electric shock.

• When you pull out the plug from 
the socket, grip the plug to avoid 
damaging the cord and causing a 
fire or an electric shock.

• The machine weight is about 
18kg.

• When lifting the machine, use the 
inset grips on both sides. Other-
wise the printer could break or 
cause injury if dropped.

• Before moving the machine, un-
plug the power cord from the out-
let. If the cord is unplugged 
abruptly, it could become dam-
aged. Damaged plugs or cords 
can cause an electrical or fire 
hazard.
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Removing the Duplex Unit

A Push down the lever on right
side of the Duplex Unit (AAAA)
and pull it out until it stops
(BBBB).

B Push the under board levers
(AAAA) and pull the Duplex Unit
out of the printer (BBBB).

C Be sure to close the bypass tray
and the front cover.

D Lift the printer and move it to the
place where you want to install it.

R CAUTION:

Important
❒ Be sure to move the printer hori-

zontally. Moving the printer facing
up on down may cause the toner to
scatter.

❒ If the Paper Feed Unit(s) is in-
stalled, detach and move the print-
er separately. Never move the
printer with the Paper Feed Unit(s)
attached.

• When lifting the machine, use 
the inset grips on both sides. 
Otherwise the printer could 
break or cause injury if 
dropped.

ZCEH221J
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Specifications

Mainframe

❖❖❖❖ Configuration:
Desktop

❖❖❖❖ Print Process:
Laser beam scanning & Electrophotographic printing
Dual component toner development

❖❖❖❖ Printing Speed:
Maximum 26 pages per minute (A4L, 81/2" × 11"L)

❖❖❖❖ Parallel Interface: 
Interface
Standard 36–pin printer cable and a parallel port on the host computer
IEEE 1284 I/F (Compatible, ECP, Nibble)
• Do not use a cable more than 2.5 meters (8.2 feet) long.

❖❖❖❖ Resolution:
1,200 × 1,200 dpi (PCL 6, RPCS, PS)
600 × 600 dpi (PCL 6, PCL 5e, RPCS, PS)

❖❖❖❖ Printer Language:
PCL 6 (XL) , PCL 5e, RPCS, Adobe PostScript®3

❖❖❖❖ Fonts:
PCL 6, PCL 5e
Agfa Font Manager 35 Intellifonts, 10 TrueType fonts, and 1 Bitmap font
Font Manager available, plus 31 additional fonts.
PostScript
136 fonts (Type 2:24, Type 14:112)

❖❖❖❖ Paper size:
⇒ P.25 “Paper and Other Media Supported by This Printer”.

❖❖❖❖ Paper Weight:
⇒ P.25 “Paper and Other Media Supported by This Printer”.

❖❖❖❖ Power Source:
See the inside front cover of this manual
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❖❖❖❖ Power Consumption:

❖❖❖❖ Noise Emission *1 :
Sound Power Level

Sound Pressure level *2 

*1 The preceding measurements made in accordance with ISO7779 are actual values.
*2 Measured at the position of a bystander.

❖❖❖❖ Dimensions: *1 

*1 Measurement conditions: With paper tray, bypass tray and output tray extension
closed.

❖❖❖❖ Weight:
Approximately 18 kg (39.7 lb) (toner cartridge and power cord included)

❖❖❖❖ Warm-up Time:
Less than 19 seconds (23°C, 73F)

Maximum 870 W or less

Printing 610 W or less

Energy Saver 17 W or less

Mainframe only

During Printing 64 dB (A)

Stand-by 40 dB (A) 

Mainframe only

During Printing 58 dB (A)

Width Depth Height

Printer only (tray not 
extended)

468 mm (18.4") 410 mm (16.1") 305 mm (12.0")

Printer only (tray ex-
tended)

468 mm (18.4") 555 mm (21.9") 305 mm (12.0")

With one optional 
feed unit

468 mm (18.4") 500 mm (19.7") 435 mm (17.1")

With two optional 
feed units

468 mm (18.4") 500 mm (19.7") 565 mm (22.2")



Specifications

7

❖❖❖❖ Paper Capacity:

*1 Paper weight: 60–105 g/m2 (16–28lb)
*2 You can load up to 10 envelopes (55 – 157 g/m2, 14 – 42 lb) at the same time.
*3 To use the Envelope Feeder Unit, the optional Paper Feed Unit is required. The

paper tray of the feed unit can be replaced with the Envelope Feeder Unit.
*4 For more information about envelopes, see P.34 “Types of Paper and Other Media”.

❖❖❖❖ Paper Output Capacity:
250 sheets (80 g/m2, 20 lb)

❖❖❖❖ Memory:
Standard 32MB, up to 96MB (with the optional Memory Unit)

❖❖❖❖ Network (Type 1 printer require the optional Network Interface Board):
Topology: Ethernet (10BaseT/100BaseTX)
Protocol: TCP/IP, NetBEUI, IPX/SPX, AppleTalk

❖❖❖❖ Optional Equipment:
Common for Type 1 printer and Type 2 printer
• Paper Feed Unit Type 2600
• Envelope Feeder Type 2600
• 1-bin Shift Sort Tray Type 2600
• CS380 (Mailbox)
• AD410 (Duplex Unit)
• Memory Unit TypeB 64MB
• Hard Disk Drive Type 2600
• 1394 Interface Unit Type 2600
Unique for Type 1 printer
• Network Interface Board Type 2600

Standard paper tray 250 sheets *1 

Bypass tray *2 100 sheets *1 

Optional Paper Feed Unit × 2 500 sheets × 2 *1 

Optional Envelope Feeder *3 60 envelopes *4 
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Options

Paper Feed Unit Type 2600

❖❖❖❖ Dimensions (W××××D××××H):
468 × 500 × 130 mm (18.4" × 19.7" × 5.1")
(without pins on the unit)

❖❖❖❖ Paper Weight:
60 – 105 g/m2 (16 – 28 lb)

❖❖❖❖ Paper Size:
⇒ P.25 “Paper and Other Media Supported by This Printer”.

Envelope Feeder Type 2600

❖❖❖❖ Dimensions (W××××D××××H):
468 × 500 × 130 mm (18.4" × 19.7" × 5.1")

❖❖❖❖ Paper Weight:
72 – 90 g/m2 (19 – 24 lb)

❖❖❖❖ Paper Size:
⇒ P.25 “Paper and Other Media Supported by This Printer”.

AD410 (Duplex Unit)

❖❖❖❖ Dimensions (W××××D××××H):
419 × 115 × 257 mm (16.5" × 4.5" × 10.1")

❖❖❖❖ Paper Size:
⇒ P.25 “Paper and Other Media Supported by This Printer”.

❖❖❖❖ Paper Weight:
64 – 105g/m2 (17 – 28lb)

❖❖❖❖ Weight: 
6kg (13.2lb)
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1-bin Shift Sort Tray Type 2600

❖❖❖❖ Dimensions (W ×××× D ×××× H): 
465 × 395 × 160mm (18.3" × 15.6" × 6.3") 

❖❖❖❖ Paper Size: 
⇒ P.25 “Paper and Other Media Supported by This Printer”.

❖❖❖❖ Paper Weight:
60 – 105g/m2 (16 – 28lb)

❖❖❖❖ Stack Capacity:
250 sheets / bin (80g/m2)

❖❖❖❖ Weight: 
3.5kg (7.7lb)

CS380 (Mailbox)

❖❖❖❖ Dimensions (W ×××× D ×××× H): 
465 × 395 × 285mm (18.3" × 15.6" × 11.2") 

❖❖❖❖ Paper Size: 
⇒ P.25 “Paper and Other Media Supported by This Printer”.

❖❖❖❖ Paper Weight:
60 – 105g/m2 (16 – 28lb)

❖❖❖❖ Stack Capacity:
50 sheets / bin (80g/m2)

❖❖❖❖ Weight: 
5.5kg (12.1lb)

Hard Disk Drive Type 2600

❖❖❖❖ Storage Capacity (Formatted):
6 GB
You can install PostScript fonts with this optional Hard Disk Drive. With
Macintosh, types of fonts supported are PostScript Type 1 and PostScript
Type 2. To download them, use PS Utility for Mac.
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Memory Unit TypeB 64MB

❖❖❖❖ Module Type:
SO-DIMM (Small Outline Dual-in-line Memory Module)

❖❖❖❖ Memory Type:
SDRAM (Synchronous Dynamic RAM)

❖❖❖❖ Number of Pins
144 pins

Network Interface Board Type 2600

❖❖❖❖ Topology:
Ethernet (10BaseT/100BaseTX)

❖❖❖❖ Protocols:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

❖❖❖❖ Interface Connector:
RJ45

❖❖❖❖ Required Cable:
STP (Shielded Twisted-Pair) cable
Category / Type5 or better

1394 Interface Unit Type 2600

❖❖❖❖ Interface Connector:
IEEE 1394 (6 pin × 2)

❖❖❖❖ Required cable:
1394 interafce cable (6 pin x 4 pin, 6 pin x 6 pin)

Important
❒ You cannot plug devices together so as to create loops.
❒ Do not use a cable more than 4.5 meters long.

❖❖❖❖ Connectable number of device in a bus
Maximum 63

❖❖❖❖ Allowed cable hops in a bus
Maximum 16

❖❖❖❖ Power supply
Non power supply
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Important
❒ In Windows 2000, the 1394 Interface Unit can only be used with Service Pack

1 or later. If the Service Pack is not installed, the connectable number of device
in a 1394 bus is only one, and the client cannot access the 1394 Interface Unit
without using an account has the Administrators permission.

❒ The optional 1394 Interface Unit is not supported by Windows 95/98/Me. If
the "plug and play" function starts, click [Cancel] in the [New Hardware Found]
or [Device Driver Wizard] dialog box.

❒ Do not plug or unplug the 1394 interface cable while installing the printer
driver.

❒ Do not turn off or on the device while installing the printer driver.
❒ When the 1394 Interface Unit is installed, uninstall the printer driver after the

1394 interface cable is unplugged.

Note
❒ The 1394 Interface Unit could not receive data from more than one PC at the

same rime. In this case, an error message appears. The printer can accept data
sent from other PCs, after the first print job has finished.

❒ The bidirectional transmissions are not supported by the 1394 Interface Unit.
❒ When the 1394 Interface Unit is installed successfully, the printer icon auto-

matically changes from "Use Printer Offline" to "Ready", according to the 1394
interface cable plug.
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Consumables

R CAUTION:

❖❖❖❖ Toner Cartridge

*1 A4, 5% test chart

Note
❒ The actual number of printed pages you get from a particular toner car-

tridge depends on the type and size of paper you are using, the contents of
your print images, and printing environment conditions. All this means
that a toner cartridge might require replacement sooner than the normal
life described above.

❒ The number of printable pages that can be expected from the starter toner
cartridge included in the printer is about 6,000 pages (A4, 5% chart).

❖❖❖❖ Maintenance Kit
MAINTENANCE KIT Type 2600
It is required to change the maintenance kit after every 90,000 pages have
been printed. However, it may be necessary to change the parts earlier de-
pending on their operating period.

• Our products are engineered to meet the highest standards of quality and 
functionality. When purchasing expendable supplies, we recommend using 
only those specified by an authorized dealer.

Printable number of pages per cartridge *1 1

RICOH LP TONER CARTRIDGE Type 100 
BLACK

20,000 pages
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Energy Saver,   115
Envelope Feeder Type 2600,   146
envelopes,   35
envelopes, loading,   44
error,   59
Error indicator,   76
Escape key,   101

F

Font Number,   124
Font Pitch,   124
fonts,   143
Font Source,   124
Form Lines,   124
friction pad,   133
friction pad, cleaning,   91
fusing unit,   137

H

Hard Disk Drive Type 2600,   147
HDD Format,   111
Hex Dump,   107
Host Interface,   101, 120

I

Image density,   111
I/O Buffer,   120
I/O Timeout,   120

J

Job Separation,   115

L

Language,   101, 128
List/Test Print,   101, 107
List/Test Print Parameters,   107
Locked Print,   53, 101

M

Macintosh
uninstall, PostScript,   24

Maintenance,   101, 111
MAINTENANCE KIT Type 2600,   132
media,   25
memory,   139, 145
Memory Overflow,   115
Memory Unit TypeB 64MB,   148
Memory Usage,   115
menu, accessing,   101
menu, changing,   128
Menu Chart,   99
Menu key,   101
Menu List,   107
Menu Protect,   111
messages,   59
misfeed,   81
MisfeedRecovery,   115

N

Network Interface Board,   145, 148
Network Interface Board Operating 

Instructions,   v
Network Setup,   120
NIB,   145
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OHP transparencies,   34
Online indicator,   76
On Line key,   102
Online key,   76
options,   145, 146
Orientation,   124
Output Tray,   115

P

panel display, messages,   59
paper,   25
paper feed roller,   135
paper feed roller, cleaning,   92
Paper Feed Unit Type 2600,   146
Paper Input,   101, 103
paper, loading,   38
paper, sizes, types,   25
Paper type,   103
PCL,   124
PCL 5e

Windows 2000, uninstalling,   19
Windows 95/98/Me, uninstalling,   19
Windows NT 4.0, uninstalling,   20

PCL 6
Windows 2000, uninstalling,   19
Windows 95/98/Me, uninstalling,   19
Windows NT 4.0, uninstalling,   20

PCL Config.Page,   107
PCL Menu,   101
plain paper,   34
Point Size,   124
PostScript

Macintosh, uninstall,   24
Windows 2000, uninstalling,   23
Windows 95/98/Me, uninstalling,   23
Windows NT 4.0, uninstalling,   24

Printer Reference,   v
Prt. Err Report,   115
PS Font List,   107

Q

Quick Installation Guide,   v

R

Registration,   111
registration roller, cleaning,   94
Resolution,   115
RPCS

Windows 2000, uninstalling,   21
Windows 95/98/Me, uninstalling,   21
Windows NT 4.0, uninstalling,   22

S

Sample Print,   49, 101
SDRAM,   145, 148
Setup Guide,   v
specifications,   143
Symbol Set,   124
System,   101, 115

T

toner cartridge, replacing,   88
Toner Saving,   115
transfer roller,   136
Tray Locking,   103
Tray Paper Size,   103
Tray Priority,   103
troubleshooting,   59

U

Unit Of Measure,   115

W

Warning,   ii
Windows 2000

canceling a job,   15
PCL 5e, uninstalling,   19
PCL 6, uninstalling,   19
PostScript, uninstalling,   23
printer properties, PCL,   2
printer properties, PostScript,   10
printer properties, RPCS,   6
RPCS, uninstalling,   21

Windows 95/98/Me
canceling a job,   14
PCL 5e, uninstalling,   19
PCL 6, uninstalling,   19
PostScript, uninstalling,   23
printer properties, PCL,   1
printer properties, PostScript,   9
printer properties, RPCS,   5
RPCS, uninstalling,   21
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canceling a job,   16
document defaults, PCL,   4
document defaults, PostScript,   12
document defaults, RPCS,   8
PCL 5e, uninstalling,   20
PCL 6, uninstalling,   20
PostScript, uninstalling,   24
printer properties, PCL,   3
printer properties, PostScript,   11
printer properties, RPCS,   7
RPCS, uninstalling,   22
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Note to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Warning
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution (in case of 100BaseTX environment):
Properly shielded and grounded cables (STP) and connectors must be used for connections to host
computer (and/or peripheral) in order to meet FCC emission limits.

Declaration of Conformity
Product Name: Laser Printer
Model Number: RICOH LASER AP2600
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Properly shielded cables must be used for connections to host computer (and/or peripheral)
in order to meet FCC emission limits.
Network interface cable with ferrite core must be used for RF interference suppression.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

In accordance with IEC 60417, this machine uses the following symbols for the main power switch: 
aaaa means POWER ON.
bbbb means POWER OFF.
Copyright © 2000 Ricoh Co., Ltd.
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Network Interface Board

Operating Instructions
Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.



Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the “Printer Reference” before using this machine. It contains im-
portant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Note

The names of the applications do not appear in the following pages. Confirm which applications you
will be using before reading this manual.

Software Version Conventions Used in this Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh are registered trademarks of Apple Computer,
Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape, Netscape Navigator are registered trademarks of Netscape Communications Corporation.

Novell, NetWare, NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Note

The proper names of the Windows operating systems are as follows:

• Microsoft® Windows® 95 operating system

• Microsoft® Windows® 98 operating system

• Microsoft® Windows® 2000 Professional

• Microsoft® Windows® 2000 Server

• Microsoft® Windows NT® Server operating system Version 4.0

• Microsoft® Windows NT® Workstation operating system Version 4.0

• Microsoft® Windows® Millenium edition (Windows Me)

Descriptions in this manual Application

PRINTER MANAGER FOR ADMINISTRA-
TOR

Aficio Manager for Admin

Net Vision for Admin

PRINTER MANAGER FOR CLIENT Aficio Manager for Client

Net Vision for Client



Manuals for This Printer

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this printer, all users should read and
follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide  
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

❖❖❖❖ Printer Reference
Provides information about using the printer and its options. This manual
provided as a PDF file on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Network Interface Board Operating Instructions (this manual)
Provides information about setting up and using the printer in a network en-
vironment. This manual provided as a PDF file on the CD-ROM labeled “Op-
erating Instructions”.

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features for the PostScript 3 printer driver. This
manual provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions”.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

Note
❒ There are two CD-ROMs that come with this printer. One is labeled "Operat-

ing Instructions" and the other is "Drivers and Utilities".
i
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.
Keys on the computer's keyboard.



Introduction

This manual contains detailed instructions on configuring the printer as a net-
work printer. Read the section appropriate to your network environment for
how to configure the printer correctly.

Important
❒ The procedures written in this manual assume that you are a network administrator.

If you are not, be sure to consult your network administrator before configuration.

Reference
For more information about physically installing the Network Interface
Board and cabling, see the "Setup Guide" that comes with the printer.
For more information about configuring the Network Interface Board with
the operation panel, see the "Setup Guide" that comes with the printer.

❖❖❖❖ Features
• Support for 100BASE-TX and 10BASE-T
• The Network Interface Board is compatible with NetWare (IPX/SPX, TCP/

IP), Windows NT (TCP/IP, NetBEUI, IPP *1 ), Windows 2000 (TCP/IP, Net-
BEUI, IPP *1 ), Windows 95/98/Me (TCP/IP, NetBEUI, IPP *1 ), UNIX (TCP/
IP) and Macintosh (AppleTalk) protocols. This allows you to use the printer
in a network that uses different protocols and operating systems.

• A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

• The Network Interface Board can connect the printer to the network with-
out requiring its own power supply because the Network Interface Board
is installed inside the printer.

*1 IPP (Internet Printing Protocol) is a protocol for printing via the Internet.

NetWare (Server)

Windows NT (Server)
Windows 2000,

Windows 95/98/Me

Macintosh

         NetWare
          (Client)

Windows NT

Windows 2000

UNIX
iii
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Setting Up the Printer on a Network

Windows 95/98/Me

For how to set up the printer as a network printer in a Windows 95/98/Me en-
vironment, see P.1 “Windows 95/98/Me Configuration”. There are two methods for
using the printer as a network printer.

Windows 2000

For how to set up the printer as a network printer in a Windows 2000 environ-
ment, see P.15 “Windows 2000 Configuration”. There are two methods for using
the printer as a network printer.

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

Windows 95/98/Me

TCP/IP
NetBEUI
IPP

Windows 95/98/Me

❖Printing Without Using a Print Server ❖Printing With a Windows 2000 or
   Windows NT Print Server

Windows 2000

TCP/IP
NetBEUI
IPP

Windows 2000

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

❖Printing Without Using a Print Server ❖Printing With a Windows 2000 or
   Windows NT Print Server



Windows NT 4.0

For how to set up the printer as a network printer in a Windows NT 4.0 environ-
ment, see P.31 “Windows NT 4.0 Configuration”. There are two methods for using
the printer as a network printer.

Windows NT 4.0Windows NT 4.0

TCP/IP
NetBEUI
IPP
LPR

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

❖Printing Without Using a Print Server ❖Printing With a Windows 2000 or
   Windows NT Print Server
v
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NetWare

For how to set up the printer as a network printer in a NetWare environment,
see P.49 “NetWare Configuration”. The Network Interface Board allows you to
use the printer as either a print server or a remote printer.
For more information about setting up the clients, see the following pages.
• Windows 95/98/Me ⇒ P.68 “Windows 95/98/Me”
• Windows 2000 ⇒ P.69 “Windows 2000”

• Windows NT 4.0 ⇒ P.70 “Windows NT 4.0”

Configuring the printer as a print server

A dedicated NetWare print server is not required because the printer can be con-
figured as a print server.

The actual procedures for configuring the printer differ depending on the ver-
sion of NetWare.
• NetWare 3.x ⇒ P.55 “Setting Up as a Print Server”

• NetWare 4.x, 5 ⇒ P.61 “Setting Up as a Print Server”

NetWare
File Server

Print Server

Windows 95/98/Me Windows 2000 Windows NT 4.0



Configuring the printer as a remote printer

If a dedicated NetWare print server is being used, the printer should be config-
ured as a remote printer.

The actual procedures for configuring the printer differ depending on the ver-
sion of NetWare.
• NetWare 3.x ⇒ P.57 “Setting Up as a Remote Printer”

• NetWare 4.x, 5 ⇒ P.65 “Setting Up as a Remote Printer”

Macintosh

For how to set up the printer as a network printer in a Macintosh environment,
see P.71 “Macintosh Configuration”.

NetWare
Print Server

NetWare
File Server

Remote Printer

Windows 95/98/Me Windows 2000 Windows NT 4.0

AppleTalk

Macintosh
vii
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UNIX

For how to setup the printer as a network printer in a UNIX environment, see
UNIX Supplement provided as a PDF file on the CD-ROM labeled "Operating
Instructions".

TCP/IP

UNIX
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1. Windows 95/98/Me
Configuration
Configuring Windows 95/98/Me

Printing Without Using a Print Server

The following procedure describes how to configure Windows 95/98/Me to use
the printer on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows NT Server, Windows NT Workstation, or NetWare based print
server.

Printing with a Windows 2000 or Windows NT Print Server

See P.13 “Setting up a Client Computer” for how to configure Windows 95/98/Me
with a Windows 2000 or Windows NT print server.

Consult your network administrator about which of the three protocols are appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Decide on the protocol to use

         TCP/IP

4.  Install the software and set the printer driver port

"Using PortNavi" "Using Multidirect Print"

PortNavi

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI
   for Printing"

Multidirect Print

If using TCP/IP ... I f  using IPP or NetBEUI . . .

indicates topics explained in this document

IPP NetBEUI
1
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Configuring Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.
• Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)
• Assign an IP address and make other settings required for using the TCP/IP protocol.

Reference
For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.
If DHCP is used to assign IP addresses, see P.97 “When Using DHCP”.

Note
❒ After setting the IP address, use the ping command to confirm that it has been

set correctly.
A Click [Start], point to [Programs], and then click [MS-DOS Prompt].
B Type the following. (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message appears.
Request timed out.

Configuring a Windows 95/98/Me computer

Follow these steps to configure a Windows 95/98/Me computer to use the TCP/
IP protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “TCP/
IP” is listed in the [The following network components are installed:] box on the
[Configuration] tab.

Note
❒ If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab

and install it. For more information about installing the TCP/IP protocol,
see Windows 95/98/Me Help.

B Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Confirm with the network administrator that the settings are correct.



Configuring Protocols
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Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.
• Confirm that the NetBEUI protocol is set to be active. (The factory default is

active.)

Reference
For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “Net-
BEUI” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

Note
❒ If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

❒ If “NetBEUI ->Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.

B Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and click [Properties].

C Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
click [OK].

D Click [OK] to close the [Network] dialog box.

E When the message to restart appears, click [Yes].
3
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Using PortNavi

PortNavi is a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

❖❖❖❖ PortNavi features
• Send a print job directly to the network printers without using a print server.
• Notification when a printing error occurs.
• Print documents using other printers in the printer group when the speci-

fied printer is busy (Recovery Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing.
• Printer models
• Installed options (e.g. Paper Tray)
• Size and orientation of paper in each paper tray
• Total memory
• Installed fonts (including the downloaded fonts)

• Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Parallel Printing.
• Printer models
• Installed options (e.g. Paper Tray)
• Size and orientation of paper in each paper tray
• Total memory
• Installed fonts (including the downloaded fonts)

Limitation
❒ To use PortNavi you must install PRINTER MANAGER FOR CLIENT and

use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

❒ For more information about installing PRINTER MANAGER FOR CLIENT,
see the “Setup Guide” that comes with the printer.

Note
❒ If you use the Multidirect Print port for printing, the port is switched auto-

matically to the PortNavi port.
❒ Be sure to close all applications before beginning the installation process. In-

stalling PortNavi may require the computer to be restarted.
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Installing PortNavi

Follow the procedure below to install PortNavi.

A Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the”Setup Guide”
that comes with the printer.

B Insert the CD-ROM into the CD-ROM drive.

Note
❒ If the installer starts automatically, you can use it to install PortNavi. Fol-

low the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note
❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”

when the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After installation is complete, configure the printer port with PortNavi. ⇒ P.7
“Setting Up the Printer Driver”

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].
5
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

A From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

B Click the [Details] tab and confirm that the PortNavi port is shown in the
[Print to the following port] box.
Remember the port name because this port should be deleted later.

C From the [Print to the following port] box, select [FILE].

D Click [Apply].

The port which is currently in use is changed.

E Click [Delete Port].

F Click the PortNavi port name as confirmed in step BBBB, then click [OK]. 

The port is deleted.

G Click [OK] to close the printer properties.

Uninstalling PortNavi

Preparation
Before uninstalling PortNavi, make sure that:
• The PortNavi settings dialog box is closed.
• No printer is using the PortNavi port as a printer port.

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B On the [Install/Uninstall] tab, click [PortNavi], and click [Add/Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of PortNavi.

D After a confirmation message, click [Yes].

E Confirm the [Remove Shared Files?] dialog box.

F When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

Preparation
The target printer must be turned on before starting the installation process.

A Install the printer driver of the printer you want to use.

B From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

C Click the [Details] tab and click [Add Port].

D Click [Other], click [PortNavi] from the list and then click [OK].

The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer. 
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

E Click the model name of the printer, and then click [OK].

Note
❒ If you want to select any printer which is not shown here, click [IP Address]

and input the IP address of the printer.

F Confirm that the PortNavi port name is shown in the [Print to the following
port] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".
The configuration is now complete. 
When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.
7
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure for
Notice, Parallel Printing and Recovery Printing.

Reference
For more information about these settings, see PortNavi Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Details] tab and click [Port Settings]. 

The PortNavi settings dialog box appears.
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Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the “Setup
Guide” that comes with the printer.

Preparation
Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted.

A Close all the applications that are currently running.

B Insert the CD-ROM into the CD-ROM drive.

Note
❒ If the installer starts automatically, you can use it to install Multidirect

Print. Follow the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\MDP\DISK1\SETUP.EXE” (do not
include the quotation marks), and then click [Finish].

Note
❒ An example would be “D:\NETWORK\MDP\DISK1\SETUP.EXE” when

the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you use, and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.
After installation is complete, configure the printer port with Multidirect
Print. ⇒ P.10 “Setting Up the Printer Driver”

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].
9
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Uninstalling Multidirect Print

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B On the [Install/Uninstall] tab, click [Multidirect Print], and click [Add/Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of Multidirect Print.

D When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected. 

Preparation
The target printer must be turned on before starting the installation process.

A Install the printer drivers.
If the printer drivers have already been installed, you can proceed to the next
step.

Reference
For more information about installing the printer drivers, see the "Setup
Guide" that comes with the printer.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

B From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

C Click the [Details] tab, and then click [Add Port].

D In the [Add Port] box, click [Other], click [Multidirect Print], and then click [OK].
The [Select Printer] dialog box appears, and the printers which can be printed
to by TCP/IP are displayed.

Limitation
❒ If PRINTER MANAGER FOR CLIENT is not installed on the computer,

printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the "Setup Guide" that
comes with the printer.
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E Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For exam-
ple, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Sim-
ilarly, when “192.168.0.20” is already used, “192.168.0.2” cannot be used. 

NetBEUI

A Click [NetBEUI].

A list of printers that can be printed to by the NetBEUI protocol appears.
B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
configuration page. For more information about the printing of config-
uration page, see the "Printer Reference" that comes with the printer.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].
The IPP setting dialog box appears.

B In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-
dress of the printer.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.
If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these settings, see Multidirect Print Help.
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F Click [OK].

G Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and click [OK].

This completes the settings.
To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow these steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

A From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Details] tab, and then click [Port Settings].

The [Port Settings] dialog box appears.
• For the TCP/IP protocol, you can configure Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see Multidirect Print Help.
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Setting up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.
To print from Windows 95/98/Me, you must install the printer driver and
change the printer port to the print server.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

A Install the printer driver as a local printer.

Reference
For more information about installing the printer driver, see the "Setup
Guide" that comes with the printer.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

B Click [Start], point to [Settings], and then click [Printers].

C Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

D Click the [Details] tab, and click [Add Port].

E Click [Network], and click [Browse].

Windows 2000 or 
Windows NT Print Server

Windows 95/98/Me
13
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F On the network tree, double-click the name of the computer used as the
print server.

The printers attached to the network are displayed.

G Click the name of the printer you want to use, and click [OK].

H Click [OK].

I Confirm that the port name is displayed in the [Print to the following port] box,
and click [OK].



2. Windows 2000
Configuration
Configuring Windows 2000

Printing Without Using a Print Server

The following procedure describes how to configure Windows 2000 to use the
printer on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

Consult your network administrator about which of the three protocols are appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Decide on the protocol to use

         TCP/IP

4.  Install the software and set the printer driver port

"Using PortNavi" "Using Multidirect Print"

PortNavi

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI
   for Printing"

Multidirect Print

If using TCP/IP ... I f  using IPP or NetBEUI . . .

indicates topics explained in this document

IPP NetBEUI
15
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Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.
For more information about Standard TCP/IP port settings, see Windows 2000
Help.

Printing with a LPR Port

See P.28 “Configuring LPR Port Printing” for how to configure a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See P.29 “Setting up a Client Computer” for how to configure Windows 2000 with
a Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.
• Confirm that the TCP/IP protocol is set to be active. (The factory default is ac-

tive.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.
If DHCP is used to assign IP addresses, see P.97 “When Using DHCP”.

Note
❒ After setting the IP address, use the ping command to confirm that it has been

set correctly.
A Click [Start], point to [Programs], point to [Accessories] and then click [Com-

mand Prompt].
B Type the following. (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message appears.
Request timed out.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP
protocol.

A Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

B Click [Local Area Connection]. On the [File] menu, click [Properties].
17



Windows 2000 Configuration

18

2

C Confirm that “Internet Protocol (TCP/TP)” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

Note
❒ If the check box of TCP/IP protocol is not selected, select the box.
❒ If the TCP/IP protocol is not installed, click [Install] on the [General] tab and

install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

D Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.
Confirm with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.
• Confirm that the NetBEUI protocol is set to be active. (The factory default is

active.)

Reference
For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

A Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

B Click [Local Area Connection]. On the [File] menu, click [Properties].

C Confirm that “NetBEUI Protocol” is selected in the [Components checked are
used by this connection:] box on the [General] tab.

Note
❒ If the check box of the NetBEUI protocol is not selected, select the box.
❒ If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.
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Using PortNavi

PortNavi is a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

❖❖❖❖ PortNavi features
• Send a print job directly to the network printers without using a print server.
• Notification when a printing error occurs.
• Print documents using other printers in the printer group when the speci-

fied printer is busy (Recovery Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing.
• Printer models
• Installed options (e.g. Paper Tray)
• Size and orientation of paper in each paper tray
• Total memory
• Installed fonts (including the downloaded fonts)

• Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Parallel Printing.
• Printer models
• Installed options (e.g. Paper Tray)
• Size and orientation of paper in each paper tray
• Total memory
• Installed fonts (including the downloaded fonts)

Limitation
❒ To use PortNavi you must install PRINTER MANAGER FOR CLIENT and

use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

❒ For more information about installing PRINTER MANAGER FOR CLIENT,
see the “Setup Guide” that comes with the printer.

Note
❒ If you use the Multidirect Print port for printing, the port is switched auto-

matically to the PortNavi port.
❒ Be sure to close all applications before beginning the installation process. In-

stalling PortNavi may require the computer to be restarted.
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Installing PortNavi

Follow the procedure below to install PortNavi.

A Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the”Setup Guide”
that comes with the printer.

B Insert the CD-ROM into the CD-ROM drive.

Note
❒ If the installer starts automatically, you can use it to install PortNavi. Fol-

low the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D Click [Add New Programs], and then click [CD or Floppy].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Open] box, followed by
“:\NETWORK\PORTNAVI\DISK1\SETUP.EXE” (do not include the
quotation marks), and then click [Finish].

Note
❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”

when the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you use, and then
click [OK].

H After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After installation is complete, configure the printer port with PortNavi. ⇒
P.22 “Setting Up the Printer Driver”

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

A From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

B Click the [Ports] tab and confirm that the PortNavi port is shown in the [Print
to the following port(s)] box.
Remember the port name because this port should be deleted later.

C Click the [FILE] check box in the [Port] column.

D Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

E Open the Printer Properties of the same printer.

F Click to select the [Ports] tab.

G At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the PortNavi port name as confirmed in step BBBB. 

H Click [Delete Port].

I When the confirmation message appears, click [Yes].

The port is deleted.

J Click [Close] to close the Printer Properties.

Uninstalling PortNavi

Preparation
Before uninstalling PortNavi, make sure that:
• The port settings dialog box is closed.
• No printer is using the PortNavi port as a printer port.

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B Click the [Change or Remove Programs] tab, click [PortNavi], and click [Change/
Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of PortNavi.
21
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D After a confirmation message appears, click [Yes].

E Confirm the [Remove Shared File?] dialog box.

F When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

Preparation
The target printer must be turned on before starting the installation process.

A Install the printer driver of the printer you want to use.

B From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

C Click the [Ports] tab and click [Add Port].

D Click [PortNavi] in the [Available port types:] box, and then click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed. 
The displayed items are as follows: 
Model Name: The model name of the printer.
Name: The name of Network Interface Board.
Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.

E Click the model name of the printer, and then click [OK].

Note
❒ If you want to select any printer which is not shown here, click [IP Address]

and input the IP address of the printer.

F Confirm that the PortNavi port name is shown in the [Print to the following
port(s)] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".
The configuration is now complete. 
When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure No-
tice, Parallel Printing and Recovery Printing.

Reference
For more information about these settings, see PortNavi Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Ports] tab and click [Configure Port]. 

The PortNavi settings dialog box appears.
23
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Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the “Setup
Guide” that comes with the printer.

Preparation
Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted. 

A Close all the applications that are currently running.

B Insert the CD-ROM into the CD-ROM drive.

Note
❒ If the installer starts automatically, you can use it to install Multidirect

Print. Follow the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D Click [Add New Programs], and then click [CD or Floppy].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Open] box, followed by
“:\NETWORK\MDP\DISK1\SETUP.EXE” (do not include the quotation
marks), and then click [Finish].

Note
❒ An example would be “D:\NETWORK\MDP\DISK1\SETUP.EXE” when

the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you use, and then
click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.
After installation is complete, configure the printer port with Multidirect Print. ⇒
P.25 “Setting Up the Printer Driver”

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].
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Uninstalling Multidirect Print

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B Click [Change or Remove Programs], click [Multidirect Print], and click [Change/
Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of Multidirect Print.

D When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected. 

Preparation
The target printer must be turned on before starting the installation process.

A Install the printer drivers.

If the printer drivers have already been installed, you can proceed to the next
step.

Reference
For more information about installing the printer drivers, see the "Setup
Guide" that comes with the printer.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

B From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Ports] tab, and click [Add Port].

D In the [Available Printer Ports] box, click [Multidirect Print] , and then click [New
Port].

The [Add Port] dialog box appears, and the printers which can be printed to by
TCP/IP are displayed.

Limitation
❒ If PRINTER MANAGER FOR CLIENT is not installed on the computer,

printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the "Setup Guide" that
comes with the printer.
25
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E Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
configuration page. For information about the printing of configuration
page, see the "Setup Guide" that comes with the printer.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.
B In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-

dress of the printer.

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these setting, see Multidirect Print Help.

F Click [OK].
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G Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and click [Close].

This completes the settings.
To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow the steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

A From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears
• For TCP/IP protocol, you can configure Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see Multidirect Print Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

Note
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocol, see P.17 “Configuring TCP/IP and
IPP for Printing”.

A Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C In the [Available port types:] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-

stalled.

D Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd:] box.

E Type “lp” into the [Name of printer or print queue on that server box:], and click
[OK].

F Click [Close].

G Confirm that the port name is displayed in the [Print to the following port(s)]
box and the check mark is inside the check box, and then click [OK].
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Setting up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.
To print from Windows 2000, you must install the printer driver and change the
printer port to the print server.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

C Click [Next >].

D Click [Network printer], and click [Next >].

E In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.

Windows 2000

Windows 2000 or 
Windows NT Print Server
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F Click the printer you want to use, and click [Next >].

Note
❒ If the printer driver is not installed in the print server, a message appears.

If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

❒ There is a Windows 2000 printer driver on the CD-ROM that comes with
the printer.

G Select whether to use this printer as the default printer, and click [Next >].

H After installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.



3. Windows NT 4.0
Configuration
Configuring Windows NT 4.0

Printing Without Using a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
printer on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

Consult your network administrator about which of the three protocols are appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Decide on the protocol to use

         TCP/IP

4.  Install the software and set the printer driver port

"Using PortNavi" "Using Multidirect Print"

PortNavi

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI
   for Printing"

Multidirect Print

If using TCP/IP ... I f  using IPP or NetBEUI . . .

indicates topics explained in this document

IPP NetBEUI
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Printing with a LPR Port

See P.45 “Configuring LPR Port Printing” for how to configure a LPR port in Win-
dows NT 4.0.

Printing with a Windows 2000 or Windows NT Print Server

See P.46 “Setting up a Client Computer” for how to configure Windows NT 4.0
with a Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.
• Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.
If DHCP is used to assign IP addresses, see P.97 “When Using DHCP”.

Note
❒ After setting the IP address, use the ping command to confirm that it has been

set correctly.
A Click [Start], point to [Programs], and then click [Command Prompt].
B Type the following. (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message appears.
Request timed out.

Configuring a Windows NT computer

Follow these steps to configure a Windows NT computer to use the TCP/IP protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “TCP/
IP Protocol” is listed in the [Network protocols] box on the [Protocols] tab.

Note
❒ If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab and

install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.

B Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Confirm with the network administrator that the settings are correct.
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C Click the [Services] tab, and confirm that “Microsoft TCP/IP Printing” is in-
stalled.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services ]
tab, and install it. For more information about installing and configuring net-
work services, see Windows NT Help.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.
• Confirm that the NetBEUI protocol is set to be active. (The factory default is

active.)

Reference
For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and change the
LAN adapter number (Lana Number).

A Open [Control Panel] and double-click the [Network] icon. Confirm that “Net-
BEUI Protocol” is listed in the [Network Protocols] box on the [Protocols] tab.

Note
❒ If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab,

and install it. For more information about installing the NetBEUI protocol,
see Windows NT Help.

B Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Network Services] box , and click [Properties].

C Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and click [Edit].

D Type “0” as the Lana Number.

Note
❒ If the other protocol's Lana Number is configured with “0”, you must

change the Lana Number a number other than “0”.

E Click [OK].
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F Click [Close], and close the [Network] dialog box.

G After confirming the message to restart, click [Yes].

Note
❒ After you change the Lana Number, you must restart the computer.
35
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Using PortNavi

PortNavi is a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

❖❖❖❖ PortNavi features
• Send a print job directly to the network printers without using a print server.
• Notification when a printing error occurs.
• Print documents using other printers in the printer group when the speci-

fied printer is busy (Recovery Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing.
• Printer models
• Installed options (e.g. Paper Tray)
• Size and orientation of paper in each paper tray
• Total memory
• Installed fonts (including the downloaded fonts)

• Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Parallel Printing.
• Printer models
• Installed options (e.g. Paper Tray)
• Size and orientation of paper in each paper tray
• Total memory
• Installed fonts (including the downloaded fonts)

Limitation
❒ To use PortNavi you must install PRINTER MANAGER FOR CLIENT and

use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

❒ For more information about installing PRINTER MANAGER FOR CLIENT,
see the “Setup Guide” that comes with the printer.

❒ On a computer that is used as a print server, do not use the features such as
Parallel Printing, Recovery Printing and Notify. For more information about
turning off these features, see PortNavi Help.
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Note
❒ If you use the Multidirect Print port for printing, the port is switched auto-

matically to the PortNavi port.
❒ Be sure to close all applications before beginning the installation process. In-

stalling PortNavi may require the computer to be restarted.

Installing PortNavi

Follow the procedure below to install PortNavi.

A Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the”Setup Guide”
that comes with the printer.

B Insert the CD-ROM into the CD-ROM drive.

Note
❒ If the installer starts automatically, you can use it to install PortNavi. Fol-

low the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note
❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”

when the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.
After installation is complete, configure the printer port with PortNavi. ⇒
P.39 “Setting Up the Printer Driver”

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

A From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

B Click the [Details] tab and confirm that the PortNavi port is shown in the
[Print to the following port] box.
Remember the port name because this port should be deleted later.

C From the [Print to the following port] box, select [FILE].

D Click [Apply].

The port which is currently in use is changed.

E Click [Delete Port].

F Click the PortNavi port name as confirmed in step BBBB, then click [OK]. 

The port is deleted.

G Click [OK] to close the printer properties.

Uninstalling PortNavi

Preparation
Before uninstalling PortNavi, make sure that:
• The port settings dialog box is closed.
• No printer is using the PortNavi port as a printer port.

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B On the [Install/Uninstall] tab, click [PortNavi], and click [Add/Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of PortNavi.

D After a confirmation message appears, click [Yes].

E Confirm the [Remove Shared File?] dialog box.

F When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

Preparation
The target printer must be turned on before starting the installation process.

A Install the printer driver of the printer you want to use.

B From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

C Click the [Details] tab and click [Add Port].

D Click [Other], click [PortNavi] from the list and then click [OK].

The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer. 
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

E Click the model name of the printer, and then click [OK].

Note
❒ If you want to select any printer which is not shown here, click [IP Address]

and input the IP address of the printer.

F Confirm that the PortNavi port name is shown in the [Print to the following
port] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".
The configuration is now complete. 
When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.
39



Windows NT 4.0 Configuration

40

3

Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure No-
tice, Parallel Printing and Recovery Printing.

Reference
For more information about these settings, see PortNavi Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Details] tab and click [Port Settings]. 

The PortNavi settings dialog box appears.
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Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the “Setup
Guide” that comes with the printer.

Preparation
Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted.

A Close all the applications that are currently running.

B Insert the CD-ROM into the CD-ROM drive.

Note
❒ If the installer starts automatically, you can use it to install Multidirect

Print. Follow the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\MDP\DISK1\SETUP.EXE” (do not
include the quotation marks), and then click [Finish].

Note
❒ An example would be “D:\NETWORK\MDP\DISK1\SETUP.EXE” when

the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.
After installation is complete, configure the printer port with Multidirect Print. ⇒
P.42 “Setting Up the Printer Driver”

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].

41
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Uninstalling Multidirect Print

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B On the [Install/Uninstall] tab, click [Multidirect Print], and click [Add/Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of Multidirect Print.

D When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected. 

Preparation
The target printer must be turned on before starting the installation process.

A Install the printer drivers.
If the printer drivers have already been installed, you can proceed to the next
step.

Reference
For more information about installing the printer drivers, see the "Setup
Guide" that comes with the printer.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

B From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Ports] tab, and click [Add Port].

D In the [Available Printer Ports] box, click [Multidirect Print] , and then click [New
Port].

The [Select Printer] dialog box appears, and the printers which can be printed
to by TCP/IP are displayed.

Limitation
❒ If PRINTER MANAGER FOR CLIENT is not installed on the computer,

printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the "Setup Guide" that
comes with the printer.
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E Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
configuration page. For information about the printing of configuration
page, see the "Setup Guide" that comes with the printer.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.
B In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-

dress of the printer.

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these setting, see Multidirect Print Help.

F Click [OK].
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G Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and click [OK].

This completes the settings.
To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow the steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

A From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Ports] tab, and then click [Port Configuration].

The [Port Settings] dialog box appears
• For TCP/IP protocol, you can configure Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see Multidirect Print Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

Note
❒ The following procedure assumes that the printer drivers have already been

installed. This is the procedure to change the printer port to LPR.
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocol, see P.33 “Configuring TCP/IP and
IPP for Printing”.

A Click [Start], point to [Settings], and then click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Ports] tab, and then click [Add Port].

D In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been

installed.

E Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd] box.

F Type “lp” into the [Name of printer or print queue on that server] box, and click
[OK].

G Click [Close].

H Confirm that the port name is displayed in the [Print to the following port(s)]
box and the check mark is inside the check box, and then click [OK].
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Setting up a Client Computer

This section describes the procedures for setting up a client in a network that uses
Windows 2000, Windows NT Server or Windows NT Workstation as a print server.
To print from Windows NT 4.0, you must install the printer driver and change
the printer port to the print server.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

C Click [Network printer server], and click [Next >].

D In the [Shared Printers] box, double-click the name of the computer used as a
print server.

The printers attached to the network are displayed.

E Click the printer you want to use, and click [OK].

Note
❒ If the printer driver is not installed in the print server, a message appears.

If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

❒ There is a Windows NT printer driver on the CD-ROM that comes with the
printer.

Windows NT 4.0

Windows 2000 or 
Windows NT Print Server
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F Select whether to use this printer as the default printer, and click [Next >].

G After installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.
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4. NetWare Configuration
This chapter describes how to configure the printer to use as a print server or a
remote printer in a NetWare environment.

Note
❒ NetWare must be set to active using the operation panel of the printer. For

more information about how to set it, see the "Setup Guide" that comes with
the printer.

Installing the NIB Setup Tool

A utility called the NIB Setup Tool is provided to configure the printer to work
in a network environment. This section describes how to install PRINTER MAN-
AGER FOR ADMINISTRATOR, and how to run the NIB Setup Tool.

Limitation
❒ The NIB Setup Tool is supported to work with the following operating sys-

tems.
• Microsoft Windows 95/98/Me
• Microsoft Windows 2000
• Microsoft Windows NT 4.0

Installing PRINTER MANAGER FOR ADMINISTRATOR

Follow these steps to install PRINTER MANAGER FOR ADMINISTRATOR.

Preparation
You should install PRINTER MANAGER FOR ADMINISTRATOR on the
computer. If you install PRINTER MANAGER FOR ADMINISTRATOR from
a file server or run it via the network, PRINTER MANAGER FOR ADMINIS-
TRATOR might not work correctly.
Be sure to close all applications before starting the installation procedure.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the installer starts automatically, follow the instructions on the screen.
If not, go to step C.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].
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E Click [Next >].

F In the [command line for installation program] box, type the name of the CD-ROM
drive followed by “:\NETWORK\PRINTMAN\ADMIN\DISK1\SETUP.EXE”
(do not include the quotation marks) and then click [Finish].

Note
❒ An example would be “D:\NETWORK\PRINTMAN\ADMIN\DISK1\SETUP.EXE”

when the CD-ROM drive name is “D”.

G From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

I The [Software License Agreement] dialog box appears. 

After reading through all of the contents by clicking [PageDown], click [Yes] to
agree with the License Agreement.

J Select a folder to install PRINTER MANAGER FOR ADMINISTRATOR
in, and then click [Next >].

If you want to change the displayed folder, click [Browse] to select another
one.
The installation program starts.
When a confirmation dialog box appears, the installation program is com-
plete.

Running the NIB Setup Tool

A Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [PRINT-
ER MANAGER FOR ADMINISTRATOR] program folder.
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Quick Setup Using the NIB Setup Tool 
Wizard

Using the NIB Setup Tool, you can easily set up a NetWare printing environment. 

Reference
For more information about installing the NIB Setup Tool, see P.49 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.
When you configure the Network Interface Board for the first time, use the Wiz-
ard method.
If you want to use the Property Sheet method, see P.54 “NetWare 3.x - Advanced
Settings” or P.60 “NetWare 4.x, 5 - Advanced Settings”.

Note
❒ This section assumes that NetWare is functional and that the necessary envi-

ronment for NetWare Print Services is available.
❒ If you configure the Network Interface Board in a NetWare environment us-

ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.
• Windows 95/98/Me in NDS mode configuration
• Windows NT 4.0 in NDS mode configuration
• Windows NT 4.0 in Bindery mode configuration
• Windows 2000 in NDS mode configuration
• Windows 2000 in Bindery mode configuration

A Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

B Run the NIB Setup Tool.

Reference
⇒ P.50 “Running the NIB Setup Tool”

C Click [Wizard] and click [OK].

The [Network board list] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click to select the IPX address of the Network Interface Board you are con-
figuring, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

print a network configuration page to confirm the MAC address (Network
address).
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F Confirm that the MAC address and IPX address are correct, and click [Finish].

G Type the print server name into the [Device Name] box, and click [Next >].
The default setting is “RDP_” followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

H In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

I Click [Next >].
A dialog box for configuring the NetWare environment appears.

J Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

K If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

L If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among those
listed in the [Browse] dialog boxes.
As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

M Click [Next >].

N Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1”
and that for Print Queue Name is “Print Server Name” followed by “_Q”
(quotation marks are not included). You can change them if necessary.

O If you have selected NDS mode, type the volume of the print queue into the
[Queue Volume] box. 

Clicking [Browse], you can select one of those shown in the [Browse] dialog box.
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P Click [Next >].

A dialog box to confirm the printing environment appears.

Q After confirming the environment, click [Next >].

If you want to change the settings, click [< Back] and make the settings again.
Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

R After a confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the printer differ depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 3.x environment.

Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. ⇒ P.51 “Quick Setup Using the NIB Setup Tool Wizard”

Note
❒ This section assumes NetWare is functional and that the necessary environ-

ment for the NetWare Print Service is available.

Install the NIB Setup Tool

Print Server Remote Printer

Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Turn the power
off and on

Start the print server
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Setting Up as a Print Server

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run the NIB Setup Tool.

Reference
⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see a network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.

I Click the [NetWare] tab, and make the following settings.
A Select [Bindery].

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

C Click [OK] to close the property sheet.

D After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K Type “PCONSOLE” from the command prompt.

F:> PCONSOLE
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L Create a print queue as follows.

Note
❒ If you use a currently defined print queue, go to step M.
A From the [Available Options] menu, select [Print Queue Information] and press

the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key and type a print queue name.
C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

M Create a printer as follows.

A From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key and type a print
server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important
❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].

D From the [Print Server Configuration] menu, select [Printer Configuration].
E Select the printer which is indicated as “Not Installed”.

F If you want to change the name of the printer, type a new name.

A name "Printer x" is assigned to the printer. “x” stands for the number of
the selected printer.

G As Type, select [Remote Other/Unkown].
The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to the [Print Server Configuration] menu.

N Assign print queues to the created printer as follows.
A From the [Print Server Configuration] menu, select [Queues Serviced By Printer].

B Select the printer created in step MMMM.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note
❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, confirm that the queues are as-
signed.

O Press the {{{{ESC}}}} key until “Exit?” appears, and select [Yes] to exit PCONSOLE.
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P Turn the printer power off and on.

Note
❒ To confirm that the printer is configured correctly, type as follows from the

command prompt.
F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
an attached user.

Setting Up as a Remote Printer

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run the NIB Setup Tool.

Reference
⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].
The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see a network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].
The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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I Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name] box, type the name of the print server.
B In the [File Server Name] box, type the name of the file server in which a

print server is to be created.
Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

C In the [Print Server Operation Mode] group, click [As Remote Printer].

D In the [Remote Printer No.] box, type the printer number.

Important
❒ Use the same printer number as that to be created in the printer server.

E Click [OK] to close the property sheet.
F After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

L Create a print queue as follows.

Note
❒ If you use a currently defined print queue, go to step L.
A From the [Available Options] menu, select [Print Queue Information] and press

the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key and type a print queue name.

C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

M Create a printer as follows.

A From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key and type a print
server name.

If you use an currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important
❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].

D From the [Print Server Configuration] menu, select [Printer Configuration].
E Select the printer which is indicated as “Not Installed”.

Important
❒ Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step I-D).
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F If you change the name of the printer, type a new name.

A name "Printer x" is assigned to the printer. x stands for the number of the
selected printer.

G As type, select [Remote Parallel, LPT1].
The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to [Print Server Configuration Menu].

N Assign print queues to the created printer as follows.
A From [Print Server Configuration Menu], select [Queues Serviced By Printer].

B Select the printer created in step LLLL.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note
❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, confirm that the queues are as-
signed.

O Press the {{{{ESC}}}} key until “Exit?” appears, and select [Yes] to exit PCONSOLE.

P Start the print server by typing the following from the console of the Net-
Ware Server.

 If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name

Note
❒ If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5 - Advanced Settings

The actual procedures for configuring the printer differ depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5 environment.

❖❖❖❖ To use NetWare 5
• You cannot use the NDPS (Novell Distributed Print Services) mode.
• If you use Pure IP, configure the printer to use the TCP/IP protocol. For

more information about how to make the settings, see the “Setup Guide”
that comes with the printer.

Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. ⇒ P.51 “Quick Setup Using the NIB Setup Tool Wizard”

Note
❒ This section assumes NetWare is functional and that the necessary environ-

ment for the NetWare Print Service is available.
❒ You should install the client software released from Novell on the Windows

before running the NIB Setup Tool for configuring in NDS mode or using
Windows NT 4.0.

Install the NIB Setup Tool

Print Server Remote Printer

Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Turn the power
off and on

Start the print server
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Setting Up as a Print Server

Important
❒ You can set up the print server using the NDS or Bindery mode in NetWare

4.x, 5. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. ⇒ P.51 “Quick Setup Using the NIB
Setup Tool Wizard”.

Note
❒ If you use Pure IP in NetWare 5, follow the procedure on P.63 “Using Pure IP

in the NetWare 5 environment”.

A Log on to the file server as an Admin or an Admin equivalent.

B Run the NIB Setup Tool.

Reference
⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].
The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see a network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].
The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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I Click the [NetWare] tab, and make the following settings.

A Select [NDS].
B Type into the [Tree:] box the name of the NDS tree in which the print

server is created, and type the context into the [Context:] box.
Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

C Click [OK] to close the property sheet.
D After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K From Windows, run NWAdmin.

Reference
For more information about NWAdmin, see the documentation that comes
with the NetWare.

L Create a print queue as follows.
A Select the container object the print queue is located in among those in

the directory tree, and click [Create] on the [Object] menu.
B In the [Class of new object] box, click “Print Queue”, and click [OK].

C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue Volume] box, click the [Browse] button.
E In the [Available objects] box, click the volume in which the print queue is

created, and click [OK].
F After confirming the settings, click [Create].

M Create a printer as follows.

A Select the container object the printer is located in, and click [Create] on
the [Object] menu.

B In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5, click “Printer (Non NDPS)”.

C In the [Printer name] box, type the name of the printer.
D Click [Define additional properties] to check a box, and click [Create].



NetWare 4.x, 5 - Advanced Settings

4

N Assign print queues to the created printer as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.
B In the [Available objects] box, click the queue created in step LLLL, and click

[OK].
C Click [Configuration], and in the [Printer type] box, select [Parallel] using the

drop-down menu, and then click [Communication]. 
D Click [Manual load] in the [Communication type] group, and click [OK].

E After confirming the settings, click [OK].

O Create a print server as follows.
A Select the context specified using the NIB Setup Tool (step IIII-AAAA), and on

the [Object] menu, click [Create].
B In the [Class of new object] box, click “Print Server”, and click [OK]. When

you are using NetWare 5, click “Print Server (Non NDPS)”.
C In the [Print Server name] box, type the name of the print server.

Important
❒ Use the same name as that specified using the NIB Setup Tool. (Step H)

D Click [Define additional properties] to check a box, and click [Create].

P Assign the printer to the created print server as follows.
A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the printer created in step MMMM, and click
[OK].

C After confirming the settings, click [OK].

Q Turn the printer power off and on.

Note
❒ If the printer works as configured, the name of the print server appears as

an attached user.

Using Pure IP in the NetWare 5 environment

A Log on to the file server as an Admin or an Admin equivalent.

B Run the NIB Setup Tool.

Reference
⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Network board list] dialog box appears.
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D Click [TCP/IP protocol].

E Click the IP address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see a network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IP address are correct, and click [Finish].

The [NIB Setup Tool] window appears.

G Click [Configure].
The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name:] box.

I Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name:] box, type the name of the print server.
B In the [File Server Name:] box, type the name of the file server in which a

print server is to be created.
Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

C In the [NDS Context:] box, type the context of the print server.
Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse Context] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

D In the [Print Server Operation Mode] group, click [As Print Server].

E Click [OK] to close the property sheet.

F After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

After this step, go to step K on P.61 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

A Log on to the file server as an Admin or an Admin equivalent.

B Run the NIB Setup Tool.

Reference
⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring, see a

network configuration page to confirm the MAC address (Network Address).

F Confirm that the MAC address and IPX address are correct, and click [Finish].

The [NIB Setup Tool] window appears.

G Click [Configure].
The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device Name] box.

I Click the [NetWare] tab, and make the following settings.
A In the [Print Server Name] box, type the name of the print server.

B In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

C In the [NDS Context] box, type the context in which the print server is to be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.
As an context, object names are typed from a lower level object and divid-
ed by a period. For example, if you want to create a print server into NET
under DS, type “NET.DS”.
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D In the [Print Server Operation Mode] group, click [As Remote Printer].

E In the [Remote Printer No.] box, type the number of the printer.

Important
❒ Use the same number as that of the printer to be created in the print

server.
F Click [OK] to close the property sheet.
G After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K From Windows, run NW Admin.

Reference
For more information about NWAdmin, see the documentation that comes
with the NetWare.

L Create a print queue as follows.
A Select the container object the print queue is located in among those in

the directory tree, and click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and click [OK].
C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue Volume] box, click [Browse] button.

E In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

F After confirming the settings, click [Create].

M Create a printer as follows.

A Select the container object the printer is located in, and click [Create] in
the [Object] menu.

B In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5, click “Printer (Non NDPS)”.

C In the [Printer name] box, type the name of the printer.

D Click [Define additional properties] to check a box, and click [Create].

N Assign print queues to the created printer as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step LLLL, and click
[OK].

C Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication]. 

D Click [Manual load] in the [Communication type] group, and click [OK].
E After confirming the settings, click [OK].
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O Create a print server as follows.

A Select the context specified using the NIB Setup Tool (Step IIII-AAAA), and on
the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5, click “Print Sever (Non NDPS)”.

C In the [Print Server name] box, type the name of the print server.

Important
❒ Use the same name as that specified using the NIB Setup Tool. (Step H).

D Click [Define additional properties] to check a box, and click [Create].

P Assign the printer to the created print server as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.
B In the [Available objects] box, click the queue created in the step MMMM, and

click [OK].
C In the [Printers] group, click the printer assigned in step BBBB , and click

[Printer Number].
D Type the printer number and click [OK].

Important
❒ Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step I-E).
E After confirming the settings, click [OK].

Q Start the print server by typing the following from the console of the Net-
Ware Server.
If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Note
❒ This section assumes that the client has NetWare client applications installed

and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client. 

Preparation
Log on to the NetWare file server before starting the following procedure.

A Install the printer driver you want to use as “Local printer”.

Reference
For more information about installing the printer driver, see the "Setup
Guide" that comes with the printer.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

B Click [Start], point to [Settings], and then click [Printers].

C In the [Printers] window, click the icon of the printer you want to use. 

D On the [File] menu, click [Properties].

E Click the [Details] tab, and click [Add Port].

F Click [Network] and click [Browse].

G On the network tree, double-click the name of the file server.

The queues are displayed.

H Click the queue you want to print, and click [OK].

I Click [OK].

In the [Print to the following port] box, a network path to the printer appears.

J Click [OK] to close the Printer Properties, and again, open it.
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K Click the [Printer Settings] tab.

L Click to clear the [Form feed] and [Enable banner] check boxes.

Note
❒ You should not check these boxes because they should be specified using

the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
A Click the [PostScript] tab. 

B Click [Advanced].

C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

M Click [OK] to close the Printer Properties.

Windows 2000

Follow the procedure to set up a Windows 2000 client.

Preparation
Log on to the NetWare file server before starting the following procedure.

A Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.
The printers dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM into the CD-ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the "Setup Guide" that comes with the printer.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.
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Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

Preparation
Log on to the NetWare file server before starting the following procedure.

A Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.
The [Printers] dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM into the CD-ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the "Setup Guide" that comes with the printer.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.



5. Macintosh Configuration
Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may differ depending on the
version of the Mac OS. The following procedure describes how to configure Mac
OS 8. If you are not using Mac OS 8, see the manual that comes with your version
of the Mac OS for more information.

Limitation
❒ To print from a Macintosh, use PostScript 3.

Changing to EtherTalk

Follow the procedure to configure a Macintosh computer to use EtherTalk.

Reference
For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

A Open [Control Panel], and double-click the [AppleTalk] icon.

B From the [Connect via:] pop-up menu, select “Ethernet”.

C If you change zones, select a name from the [Current zone:] pop-up menu.

D Close the [AppleTalk] control panels.

E Restart the Macintosh.

Change to EtherTalk

Basic Procedure

Configure the printer

Change the printer name

Change the zone
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Configuring the Printer

Use the operation panel to activate the EtherTalk protocol. (The factory default
is active.)

Reference
For more information about configuration, see the "Setup Guide" that comes
with the printer.

Changing the Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printer1” and “printer2”. 
To change the printer name in the Macintosh EtherTalk environment, use Print-
er Utility for Mac included on the CD-ROM labeled "Drivers and Utilities".

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
Printer Utility for Mac included on the CD-ROM labeled "Drivers and Utilities".

Reference
For more information about using Printer Utilities for Mac, see PostScript 3
Operating Instructions Supplement provided as a PDF file on the CD-ROM
labeled "Operating Instructions".



6. Appendix
Configuring the Network Interface Board 
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
a printer to function as a network printer. You can use a Web Browser to view
the printer status and configure the Network Interface Board.

❖❖❖❖ Configuring the printer
This requires the TCP/IP protocol to be installed. After the printer has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

Reference
For more information about configuring the printer to use the TCP/IP pro-
tocol, see the "Setup Guide" that comes with the printer.

❖❖❖❖ Operating system browser requirements

Limitation
❒ Sometimes after clicking [Back] , the previous page may not appear. In this

case, click [Refresh] or [Reload] .
❒ The text on the screen may disappear or be aligned incorrectly if the font

size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

OS Browser

Windows 95/98/Me

Microsoft Internet Explorer 3.02/4.0/5.0

Netscape Navigator 3.0/4.0

Windows NT 4.0

Windows 2000

Mac OS 7.6.1 ∼ 9.0

Solaris 2.5 ∼ 2.7
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Going to the Top Page

After launching the Web Browser, type the IP address of the printer. See the ex-
ample below. This example is for the English version.
http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

Note
❒ If a DNS server is used on the network, you can type the host name as an URL.

For example, http://webmonitor.netprinter.com/. In order to do this, you
must the register the IP address and host name of the Network Interface
Board with the DNS server. Consult the network administrator for informa-
tion about how to do this.

❒ If the network uses proxy servers, the browser may run slowly.

1. Header Buttons
You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

Important
❒ It costs to use the browser to access

a website.

Note
❒ Help is stored on the CD-ROM in

HTML format.

2. Menu Buttons
Buttons to configure the Network Inter-
face Board and confirm the status of the
printer.

Note
❒ When you click [Configuration], a dia-

log box appears requesting the user
name and password. Type only the
password in this dialog box. The fac-
tory default password is “password”.

❒ The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status
Displays the name and comments of the
Network Interface Board, and the printer
status.

1
2

3
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----Linking the address (URL) to the [Help] button
You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.
A Copy the Help files on the CD-ROM to the desired location. The Help files are

located in folders labeled with abbreviated language names. For example, En-
glish Help files are in the [EN] folder. Be sure to copy the entire [EN] folder to
the new location.

B Using a Web Browser, navigate to the Top Page and click [Network config].
C Type your password, (it is not necessary to type a user name) and click [OK].
D Type the path to the Help files in the [Help URL] box.

If you copied the Help files to "C:\HELP\EN", type "file://C:/HELP/". For
example if you copied the files to a web server and the index URL is "http://
a.b.c.d/HELP/EN/index.html", type "http://a.b.c.d/HELP/".

E Click [Apply].
When a warning message appears, select to continue configuration.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board using telnet.

Note
❒ You should specify a password so that only the network administrator, or a

person having network administrator privileges, can use remote maintenance. 

Using telnet

The following is a sample procedure in using telnet.

Limitation
❒ Only one person at a time can be logged on to do remote maintenance.

A Using the IP address or host name of the printer, start telnet.
% telnet IP_address

Note
❒ In order to use the host name instead of the IP address, you must write it

to the /etc/hosts file.

B Type the password.

Note
❒ The factory default is “password”.

C Type a command.

Reference
 For more information about telnet commands, see P.77 “Commands List”.

D Exit telnet.
msh> logout

When the configuration is changed, a confirmation message requests whether
or not the changes should be saved.

E Type “yes” to save the changes, and press the {{{{ENTER}}}} key.

If you do not want to save the changes, type “no”and press the {ENTER} key.
If you want to make additional changes, type “return” at the command line,
and press the {ENTER} key.

Note
❒ If the “Can not write NVRAM information” message appears, the changes

are not saved. Repeat the steps above.
❒ The Network Interface Board is reset automatically when the settings are changed.
❒ When the Network Interface Board is reset, the active print job which has

already been sent to the printer will finish printing. However, jobs that
have not been sent yet will be canceled.
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Commands List

This is a list of commands that can be used via remote maintenance.

Note
❒ Type “help” to see a list of commands that can be used.

msh> help

❒ Type “help command_name” to display information about the syntax of that
command.
msh> help command_name

TCP/IP address

Use the ifconfig command to configure TCP/IP for the printer (IP address, sub-
net mask, broadcast address, default gateway address).

❖❖❖❖ Reference
msh> ifconfig

❖❖❖❖ Configuration
msh> ifconfig nsf0 parameter address

The following is an example for configuring an IP address of 192.168.15.16.
msh> ifconfig nsf0 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0.
msh> ifconfig nsf0 netmask 255.255.255.0

Note
❒ This affects the configuration of the Network Interface Board of the IP ad-

dress that is used.
❒ To type an address using hexadecimal, prefix it by “0x”.

Parameter Meaning

(no parameter) IP address

netmask subnet mask

gateway default gateway address

broadcast broadcast address
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----Address

❖❖❖❖ Subnet Mask
A number used to mathematically “mask” or hide the IP address on the network by
eliminating those parts of the address that are alike for all the machines on the network.

❖❖❖❖ Default Gateway Address
A gateway is a connection or interchange point that connects two networks.
A gateway address is for the router or host computer used as a gateway.

Note
❒ To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control.

❖❖❖❖ Reference
msh> access

❖❖❖❖ Configuration
msh> access parameter address

Note
❒ The Access Control Address and the Access Control Mask are used to limit access

to the computer used for printing by denying access to users based on their IP ad-
dress. If it is not necessary to limit access, set the Access Control Mask to “0.0.0.0”.

❒ When the Access Control Address matches the masked result of the IP ad-
dress computer attempting to print, print jobs from that IP address will be ac-
cepted by the Network Interface Board.

❒ For example, if you assign 192.168.15.16 as the Access Control Address of the
Network Interface Board, the IP addresses that can print are as follows. XXX
means any number from 1 to 254 is acceptable.

Parameter Meaning

control Access Control Address

mask Access Control Mask

Access Control Mask IP addresses that can access the 
printer

  0.  0.  0.  0 XXX.XXX.XXX.XXX

255.  0.  0.  0 192.XXX.XXX.XXX

255.255.  0.  0 192.168.XXX.XXX

255.255.255.  0 192.168. 15.XXX

255.255.255.255 192.168. 15. 16
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Network Boot

Use the set command to configure the boot method.
msh> set parameter {on | off}

 “on” means active and “off” means inactive.

Note
❒ When you use DHCP, the server also needs to be configured.
❒ DHCP takes precedence over all other settings.

Protocol

Use the set command to allow/prevent remote access for each protocol.
msh> set protocol {up | down}

Note
❒ If you prohibit remote access using TCP/IP and then log out, you cannot use

remote access. If this was a mistake, you can use the printer operation panel
to allow access by TCP/IP.

❒ When you prevent access via TCP/IP, you are also prevented from using lpr,
ftp, rsh, diprint, web, snmp and ipp.

Parameter Meaning

dhcp DHCP (Dynamic Host Configuration 
Protocol)

Protocol

appletalk

tcpip

netware

netbeui

lpr

ftp

rsh

diprint

web

snmp

ipp

“up” means active and “down” means 
inactive.
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Printer status

The following commands can be used to get information about the current status
of the printer.
msh> command

Note
❒ More information about any print job is displayed when the ID number is

added after the prnlog command.

Reference
For more information about the meaning of the data returned with these com-
mands, see P.88 “Configuring the Network Interface Board”.

Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.
msh> show [-p]

Note
❒ Add “-p” to the show command to have the information displayed one screen

at a time.

Reference
For more information about the meaning of the data returned with this com-
mand, see P.88 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the printer's system
log. 
msh> syslog

Reference
For more information about the displayed information, see P.91 “System Log
Information”.

Command Information that is displayed

status Status of printer.

Information about the print jobs.

info Information about the paper tray, output tray, 
printer language of printer.

prnlog [ID] Lists the last 16 print jobs.
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SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

Note
❒ You can configure from ten SNMP access settings numbered 1–10.
❒ Default access settings 1 and 2 are as follows.

❖❖❖❖ Display
Shows the SNMP information and available protocols.
msh> snmp ?
msh> snmp [-p] [registered_number]

Note
❒ If the -p option is added, you can view the settings one by one.
❒ Omitting the number displays all access settings.

❖❖❖❖ Community name configuration
You can set the community name of the Network Interface Board.
msh> snmp number name community_name

Note
❒ The community name must consist of 15 characters or less.

❖❖❖❖ Access type configuration
You can select the access type from those listed below.
msh> snmp number type access_type

Number 1 2

Community name public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only

trap off

read-write

trap off

Access type Type of access which is permitted

read Read only

write Read and write

trap User is notified of trap messages.

no All access is denied.
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❖❖❖❖ Protocol configuration
You should use the following command to set the protocols to active or inac-
tive. If you set a protocol to inactive, all access settings set to use that protocol
are disabled.
msh> snmp {ip | ipx} {on | off}

•  “on” means active and “off” means inactive

To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.
msh> snmp number active {ip | ipx} {on | off}

❖❖❖❖ Access configuration
You can configure an address of a host depending on the protocols used. 
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.

Command syntax:
msh> snmp number {ip | ipx} address

Note
❒ To specify the TCP/IP protocol, type ip followed by a space and then the

IP address.
❒ To specify the IPX/SPX protocol, type ipx followed by a space and then the

IPX address followed by a decimal and then the MAC address of the Net-
work Interface Board.

The following is an example of how to configure registration number 3 with
the IP address 192.168.15.16.
msh> snmp 3 ip 192.168.15.16
The following is an example of how to configure registration number 3 with
the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.
msh> snmp 3 ipx 7390A448:000074625C65
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IPP

Use the ipp command to configure the IPP settings.

❖❖❖❖ Viewing setting
The following command displays the current IPP settings.
msh >ipp
Example output:
timeout=900(sec)
auth basic

• The "timeout" setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection
could be made.

• The "auth" setting indicates the user authorization mode.

❖❖❖❖ IPP timeout configuration 
Specify how many seconds to wait before canceling a print job if it has been
interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.
msh>ipp timeout {30 -65535}

❖❖❖❖ IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The
factory default is "off" .
ipp auth {basic|digest|off}

• "basic" and "digest" are user authorization setting.
• "off" removes a user's authorization.

Note
❒ If you select "basic" or "digest", see next section “Entry the IPP User Autho-

rization” for how to configure the user name. Up to ten user names are
available.

❖❖❖❖ Configuring IPP user authorization
Use the following command:
ipp user
The following message appears.
Input user number (1 to 10):
Type the number, user name and password.
IPP user name:user1
IPP password:*******
After configuring the settings, the following message appears.
User configuration changed.
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SMB

Use the smb command to configure or delete the computer name or workgroup
name for NetBEUI.
msh >smb parameter

ROUTE

Use the route command to control the routing table.
This command allows you to configure and display routing information. You
can change the network configuration from remote PC using this command.

Note
❒ The maximum number of routing tables are 16.

*1 IP address

Parameter Settings

smb comp Your computer name consisting of up to 13 characters

smb group Workgroup name consisting of up to 15 characters

smb comment Comment consisting of up to 31 characters

smb clear comp Clears complete name

smb clear group Clears Workgroup name

smb clear comment Clears comment

Parameter Topics of setting

route add {host | net} desti-
nation *1  gateway *1 

Adds a host/network route to "destination", and a gateway ad-
dress to "gateway" in the table. Host becomes the default setting.

route delete {host | net} 
destination *1 

Deletes a host/network route from the table. Host becomes the 
default setting.

route get {destination *1 } Displays only route information corresponding to a specified 
destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des-
tination *1  on/off

You can turn the specified destination on or off. Host becomes 
the default setting.

route flush Deletes all routing information.
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SLP

Use this command to configure SLP settings.
You can search the NetWare server using SLP in the PureIP environment of
NetWare5. To use the slp command, you can configure the value of TTL which
can be used by SLP multi-cast-packet.

Note
❒ The default value of TTL is "1". A search is executed only within a local seg-

ment. If the router does not support multi-cast, the settings are not available
even if the TTL value is increased.

❒ The acceptable TTL value is 1 - 255.
msh> slp ttl ttl_{1 -255}

Changing the password

Use the passwd command to change the remote maintenance password.

Important
❒ Be sure not to forget or lose the password.

Note
❒ The default factory password is “password”.

A Type “passwd”.

msh> passwd

B Type the current password.
Old password:

C Type the new password.

New password:

Note
❒ The password must consist of 3 to 8 alphanumeric characters and symbols.

Upper and lower case characters are considered unique. For example, R is
different from r.

❒ The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

D Type the new password once again.
Retype new password:
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SNMP

The Network Interface Board functions as a SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.
The factory default community names are “public” and “admin”. You can get
MIB information using these community names.

Reference
For more information about configuring the community name, see P.81 “SN-
MP” in “Remote Maintenance by telnet”.

Limitation
❒ The kinds of supported MIBs differ depending on the printer.

❖❖❖❖ Supported MIBs
• MIB-II
• PrinterMIB
• HostResourceMIB
• RicohPrivateMIB
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Understanding the Displayed Information 

This section describes how to read status information returned by the Network
Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.
• telnet : Use the status command. ⇒ P.80 “Printer status”

Print Log Information

This is a record of the most recent ten jobs that have been printed.
This log can be displayed with the following commands.
• telnet : Use the prnlog command. ⇒ P.80 “Printer status”

Item name Meaning

Rank Status of print job.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is "0 bytes".

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Bytes The number of bytes that us received.

Request The request of the print request.

Time The time when the print request was received

User ID User id that is to be configured in the printer driver.

JobName The name of the document for printing.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed and confirmed using the
commands below.
• telnet : Use the show command. ⇒ P.80 “Network Interface Board configuration

settings information”

Item name Meaning

Common

Mode

Protocol Up/Down

AppleTalk

TCP/IP

NetWare

NetBEUI

Ethernet interface

NVRAM version

Device name

Comment

Location

Contact

Soft switch

 

 

Up means active, Down means inactive.

 

 

 

 

 

Internal version number.

AppleTalk

Mode

Net

Object

Type

Zone

 

AppleTalk protocol in selection.

Network number.

Macintosh printer name.

The type of printer.

Name of the zone that the printer belongs to.
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TCP/IP

Mode

ftp

lpr

rsh

diprint

web

telnet

download

snmp

ipp

EncapType

Network boot

Address

Netmask

Broadcast

Gateway

AccessCtrl

AccessMask

Time server

Home page URL

Home page link name

Help page URL

SNMP protocol

 

Up means active, Down means inactive. 

 

 

 

 

 

 

 

 

 

Frame type.

Network boot.

IP address.

Subnet mask.

Broadcast address.

Default gateway address.

Access control address.

Access control mask.

 

URL of homepage.

URL name of homepage.

URL of help page.

Protocol used with SNMP.

NetWare

EncapType

RPRINTER number

Print server name

File server name

Context name

Switch

Mode

NDS/Bindery

Packet negotiation

Print job timeout

 

Frame type.

Remote printer number.

Print server name.

Name of the connect file server.

Context of print server.

 

Active mode.

(this value is fixed)

 

Time of the job timeout.

Item name Meaning
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NetBEUI

Switch

Mode

Direct print

Notification

Workgroup name

Computer name

Comment

Share name[1]

 

 

(this value is fixed)

(this value is fixed)

Notification of print job completion.

Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

Shell mode Mode of remote maintenance tool.

Item name Meaning



Message List

6

Message List

This is a list of messages written to the printer's system log. The system log can
be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.
• UNIX : Use the syslog paremeter of rsh, rcp or ftp command. ⇒“Printer Sta-

tus”in UNIX Supplement manual provided as a PDF file included on the CD-
ROM labeled Operating Instructions.

• telnet : Use the syslog command. ⇒ P.80 “System log information”

Message Description and Solutions

Access to NetWare server “file server name” 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect.

(In print server mode) Cannnot log in to the 
file server. Confirm that the print server is re-
sistered on the file server. If a password is 
specified for the print server, delete it.

add_sess: community<community name> al-
ready defined.

The same community name already exists. 
Use another community name.

add_sess: session<community name> not de-
fined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>, 
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_ipx: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_ipx: session_ipx<community name> 
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM <IP ad-
dress>, <password>

An anonymous login has been made with a 
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk) An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer=“file server name” Attached to the file server as a nearest server.

Attach to print queue “print queue name” (In print server mode) Attached to the print 
queue name.
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Cannot create service connection (In remote printer mode) Cannot establish a 
connection with the file server. The number of 
file server users may exceed the maximum 
number that the file server can handle.

Cannot find rprinter (“print server name”/
”printer number”)

The printer having the number displayed on 
the print server does not exist. Confirm the 
number of the printer registered to the print 
server.

Change IP address from DHCP Server. The IP address changes when DHCP LEASE is 
renewed. To always assign the same IP ad-
dress, set a static IP address  to the DHCP serv-
er.

child process exec error! (process name) Failed to start the network service. Turn the 
printer off and then on. If this does not work, 
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from 
the DHCP server.

connection from <IP address> Logged on from the host <IP address>.

Could not attach to FileServer<error number> (In remote printer mode) Cannot attach to the 
file server. For some reason, the file server re-
fuses the connection. Check the file server con-
figuration.

Could not attach to PServer<print server> (In remote pritner mode) Cannot attach to the 
print server. For some reason, the print server 
refuses the connection. Check the print server 
configuration.

Current Interface Speed:xxxMbps The speed of the network (10 Mbps or 100 
Mbps).

Current IP address <current IP address> The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address The current IPX address.

DHCP lease time expired. DHCP lease time has expired. The printer tries 
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCP server not found. The DHCP server cnnot be found. Make sure 
the DHCP server is running on the network.

dhcpcd start. A dhcpcd (DHCP client service) has started.

diprinted started Direct print service has started.

Duplicate IP=(IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address 
must be unique. Check the address of the de-
vice indicated in The same IP address is used. 
An IP address must be unique. Check the ad-
dress of the device indicated in <MAC ad-
dress>.

Message Description and Solutions
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Established SPX Connection with PServ-
er,(RPSocket=(socket number>), con-
nID=<connection ID>

(In remote printer mode) A connection with 
the print server has been established.

Exit pserver (In print server mode) Exits the print server 
because the necessary print server settings 
have not been made.

Frametype=“frame type name” The "frame type name" is configured to be 
used on NetWare.

httpd start. An httpd has started.

inetd start. An inetd has started.

ipp disable. Printing with ipp is disabled.

ipp enable Printing with ipp is enabled.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time that was received from 
the DHCP server is in seconds. The renewal 
time is also in seconds.

Login to fileserver “file server name” 
(“NDS|BINDERY”) 

(In print server mode) Logged in to the file 
server with NDS or BINDERY mode.

multid start. Data transmission service for multiprotocols 
has started.

nbstart start. (NetBEUI) The service for NetWare protocol stack setting 
has started.

NBT Registration Broadcast(<NetBIOS 
name>)

Use a  local broadcast to map <NetBIOS 
name> with the IP address.

nptd start. A nbtd (NetBIOS over TCP/IP Daemon) has 
started. (Available only in DHCP mode)

NetBEUI Computer Name=“computer name” The NetBEUI Computer Name is defined as 
"computer name".

nmsd start. (NetBEUI) A nmsd (Name Server Daemon) has started.

npriter start. (NetWare) (In remote printer mode) NetWare service has 
started in remote printer mode.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file “file name” (In print server mode) The specified log file 
has been opened.

papd start. AppleTalk print service has started.

phy release file open failed. Replacing the Network Interface Board is re-
quired. Contact your sales or service represen-
tatives.

Print queue “print queue name” cannot be ser-
viced by printer 0, “print server name”

(In print server mode) The print queue name 
cannot be serviced. Make sure that print queue 
volume exists on the specified file server.

Message Description and Solutions
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Print server <print server name> has no print-
er.

(In print server mode) The printer object is not 
assigned to the print server <print server 
name>. Using NWAdmin, assign the printer 
object, and then restart the printer device. 

Print session full Cannot accept the print session.

Printer “printer name” has no queue (In print server mode) The print queue is not 
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then re-
start it.

pserver start. (NetWare) (In print server mode) NetWare service has 
started.

Required computer name (<Computer 
name>) is duplicated name

The same computer name is detected on the 
network. The start job determines the comput-
er name by adding the computer name to the 
suffix (0,1....). Configure a new computer 
name that is unique.

Required file server (“file server name”) not 
found

Cannot find the required file server.

restarted. LPD has started.

sap enable, saptype=<SAP type>, sap-
name=<sap name>

The SAP function has started. The SAP (SAP 
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name> A <NDS context name> has been set. 

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUI) An smbd (SMB (Server Message Block) ser-
vice) has started.

Snmp over ip is ready. Communication over TCP/IP with SNMP is 
available.

Snmp over ipx is ready. Communication over IPX with SNMP is avail-
able.

snmpd start. SNMP sevice has started.

The print server received error “error num-
ber” during attempt to log in to the net-
work.Access to the network was denied.Verify 
that the print server name and password are 
correct.

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without 
specifying a password.

Message Description and Solutions
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Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the printer.

Configuring the router

Filter the packets so that they do not pass over the dial up router.

Note
❒ The MAC address of the printer doing the filtering is printed on the printer

configuration page. For more information about printing a configuration
page, see the "Setup Guide" that comes with the printer.

❒ For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

A Following the setup method in this manual, configure the file server.

B Set the frame type for a NetWare environment.

Reference
For more information about selecting a frame type, see the "Setup Guide"
that comes with the printer.

Configuring the printer without NetWare

A While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

Reference
For more information about selecting a protocol, see the "Setup Guide" that
comes with the printer.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Operating Instruc-
tion Supplement provided as a PDF file on the CD-ROM labeled "Operating In-
structions".

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not print properly. If you want to change the form feed setting, al-
ways configure it on Windows.
• With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-

tings] tab in the printer properties dialog box.
• With Windows 2000, clear the [Form feed] check box on the [Neware Settings]

tab in the printer properties dialog box.
• With Windows NT 4.0, clear the [Form feed] check box on the [Neware Settings]

tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows. 
• With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer

Settings] tab in the printer properties dialog box.
• With Windows 2000, clear the [Enable banner] check box on the [Neware Set-

tings] tab in the printer properties dialog box.
• With Windows NT 4.0, clear the [Enable banner] check box on the [Neware Set-

tings] tab in the printer properties dialog box.

Printing after resetting the printer

After resetting the remote printer, it will be cut off from the print server for about
30-40 seconds before connecting again. Due to the NetWare specification, print
jobs may be accepted, but they will not be printed during this interval.
When using the printer as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print. 
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When Using DHCP

Note the following points when using DHCP (Dynamic Host Configuration Pro-
tocol).

Supported systems

Windows NT Server 4.0 can be configured as a DHCP server.

Configure the printer with a reserved IP address

To always assign the same IP address, configure a reserved IP address using the
DHCP server.

Note
❒ When multiple DHCP servers are used, reserve the same address with each

DHCP server. The Network Interface Board needs to receive information
from the DHCP server that it contacts.

Follow these steps to configure the printer with a reserved IP address.

A Start the DHCP manager.

B Select the scope that will be used, and on the [Scope] menu, click [Reserva-
tion].

C Type the IP address into [IP Address].

D Type the MAC address of the Network Interface Board into [Unique Identifi-
er].

Note
❒ Do not use hyphens to separate the numbers.
❒ If you do not know the MAC address, it can be found on the configuration

page printed by the printer.

E Type a name and comment into the [Client Name] box and the [Client Comment]
box.

Note
❒ For more information about client names, see P.98 “Additional information”.

F Click [Add].
An IP address is reserved.

G Click [Close] to close the dialog box.
97



Appendix

98

6

Additional information

• When you click [Active Lease] on the [Scope] menu of DHCP manager, a list of
client leases appears. When the reserved IP address is not active, the name of
the reservation is the name entered in the Client Name field of the Add Re-
served Clients dialog box. When the reserved IP address becomes active, the
client name changes to the printer name configured by the Network Interface
Board. Only the first 13 letters of the printer name appear here. When you use
the printer with Multidirect Print, use the host name of the printer as the [Cli-
ent Properties] Client Properties dialog box.

• When the DHCP server does not assign an IP address, the Network Interface
Board uses 11.22.33.44 as a temporary IP address. You can confirm the print-
er's IP address on the network configuration page.

• Because 11.22.33.44 is a special IP address, you cannot print using this address.
• When using the DHCP relay agent in a network environment that uses a dial

up router to connect to the Network Interface Board, an increase in commu-
nication fees can occur.

When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, con-
firm that the TCP/IP environment is correctly configured in your computer.

When Using IPP with Multidirect Print

When using IPP with Multidirect Print, note the following:
• The network printer can only receive one print job from Multidirect Print at a

time. While the network printer is printing a job, another user cannot access
the network printer until it completes the job. In this case, Multidirect Print
tries to access the network printer until the retry interval expires.

• If Multidirect Print cannot access the network printer and times out, Multidi-
rect Print stops sending the print job. In this case, you should cancel the paused
status from the print queue window. Multidirect Print will resume access the
network printer. You can delete the print job from the print queue window, but
canceling a print job that has been printed by the network printer might cause
that the next print job sent from another user not to be printed correctly.

• If a print job that is sent from Multidirect Print is interrupted and the network
printer cancels the job because something went wrong, launch the print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

• If various users send print jobs using Multidirect Print to network printers,
the printing order might not be the order in which the jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the PortNavi port name.
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Specifications

LAN interface 100BASE-TX, 10BASE-T

Frame type EthernetII, IEEE802.2, IEEE802.3, SNAP

Protocol • TCP/IP
Windows 95
Windows 98
Windows 2000
Windows NT 4.0

• IPX/SPX
NetWare 3.12, 3.2, 4.1, 4.11, 5, IntranetWare

• NetBEUI
Windows 95
Windows 98
Windows 2000
Windows NT 4.0

• IPP
Windows 95
Windows 98
Windows 2000
Windows NT 4.0

• AppleTalk
Mac OS 7.6.1 or later

SNMP MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB
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Note to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Warning
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution:
Properly shielded and grounded cables (STP) and connectors must be used for connections to host
computer (and/or peripheral) in order to meet FCC emission limits.
STP with ferrite core must be used for RF interference suppression.

Declaration of Conformity

Product Name: Network Interface Board
Model Number: Type 2600
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Declaration of Conformity
“The Product complies with the requirements of the EMC Directive 89/336/EEC and the Low Voltage
Directive 73/23/EEC.”

Warning

Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.
Copyright © 2000
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     PostScript 3

Operating Instructions

Supplement
Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.



Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the printer.

Please read the Safety Information in the Setup Guide or Printer Reference as a PDF file included on
the CD-ROM labeled “Operating Instructions” before using this printer. It contains important information
related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Trademarks

Microsoft® and Windows® are registered trademarks of Microsoft Corporation in the United States and/
or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Appletalk, Apple, Macintosh is a registered trademark of Apple Computer, Incorporated.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Notes:

Some illustrations might be slightly different from your machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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1. PostScript 3
Installable Options

The following options are available.

❖❖❖❖ Paper Feed Unit
500 sheets

❖❖❖❖ Output Paper Device
• AD410 (Duplex Unit )
• 1–bin Shift Sort Tray
• CS380 (Mailbox)

❖❖❖❖ Memory Unit
• Hard Disk Drive Type 2600
• Memory Unit TypeB 64MB (SDRAM)

Setting Up Options

To use the installed options correctly, you have to set up the printer driver. If the
options are not recognized, you cannot use them even though they are physical-
ly installed on the printer. The method of setting up the printer driver may differ
depending on the operating system.

❖❖❖❖ Windows
You can set up any of the options with the following tabs.

Note
❒ You should access the printer driver from Windows to set up options. You

cannot set up options when accessing the printer driver from an applica-
tion.

Operating System Tab Name

Windows 95/98/Me [Device Options] tab

Windows 2000 [Device Settings] tab in the Printer Properties.

Windows NT 4.0 [Device Settings] tab
1
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Limitation
❒ If your system is Windows 2000, changing the printer driver setting re-

quires Manage Printers permission. Members of the Administrators, and
Power Users groups have Manage Printers permission by default. When
you change the settings of the printer driver, log on under Manage Printers
permission.

❒ If your system is Windows NT 4.0, changing the printer driver setting re-
quires Full Control access permission. Members of the Administrators,
Server Operators, Print Operators, and Power Users groups have Full Con-
trol permission by default. When you change the settings of the printer
driver, log on under Full Control permission.

❒ If you use Adobe Page Maker 6.0 or 6.5 with Windows 95/98/Me, Win-
dows 2000 or Windows NT 4.0, you have to set up options in Adobe Page-
Maker's print dialog box.

❖❖❖❖ Macintosh
You can set up all of the options in the [Chooser] dialog box.
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Printing a Document

This section describes how to print a document using printer specific functions.

❖❖❖❖ Paper Source
The following table shows the tabs or menus where you can select this func-
tion.

❖❖❖❖ Destination Tray
The following table shows the tabs or menus where you can select this func-
tion.

❖❖❖❖ Duplex Printing
Use this function to select duplex printing.

Limitation
❒ To use this function, the Duplex Unit must be installed on the printer.
The following table shows the tabs or menus where you can select this func-
tion.

Windows 95/98/Me [Paper] tab

Windows 2000 [Paper/Quality] tab in the Printing Preferences Properties

Windows NT 4.0 [Page Setup] tab

Macintosh [General] in the print dialog box

Windows 95/98/Me [Destination] on the [Paper] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] 
tab in the Printing Preferences Properties

Windows NT 4.0 [Printer features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box

Windows 95/98/Me [Duplex] on the [Device Options] tab

Windows 2000 [Print on Both Sides (Duplex)] on the [Layout] tab in the 
Printing Preferences Properties

Windows NT 4.0 [Page Setup] tab

Macintosh [Print on Both Sides] on [Layout] in the print dialog box
3
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❖❖❖❖ Collate
Use this function to enable collation. With this feature, the printer can effi-
ciently print collated sets of multiple-page documents.

Limitation
❒ To use this function, the Hard Disk Drive must be installed on the printer.
The following table shows the tabs or menus where you can select this function.

❖❖❖❖ Edge Smoothing
Use this function to improve the print quality of text and graphics when
printing. Indentations in curved lines are automatically smoothed to produce
a cleaner appearance. 

Limitation
❒ When Edge Smoothing is selected, Toner Saving is not enabled.
The following table shows the tabs or menus where you can select this function.

❖❖❖❖ Toner Saver
Use this function to reduce the amount of toner used when printing.

Limitation
❒ When Toner Saving is selected, Edge Smoothing is not enabled.

Note
❒ While this will increase the life of the toner, the output will appear slightly

lighter.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Collate] on the [Device Options] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] 
tab in the Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Ad-
vanced...] tab

Macintosh [Printer Specific Options] in the print dialog box

Windows 95/98/Me [Edge Smoothing] on the [Device Options] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] 
tab in the Printing Preferences Properties

Windows NT 4.0 [Printer features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box

Windows 95/98/Me [Toner Saver] on the [Device Options] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] 
tab in the Printing Preferences Properties

Windows NT 4.0 [Printer features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box
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❖❖❖❖ Sample Print
Use this function to print only one printing of a multiple print job.
The other printings are saved in the machine. The saved job can be printed
from the machine's operation panel. You can also delete the saved job.

Limitation
❒ To use this function, the Hard Disk Drive must be installed on the printer.

Note
❒ The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0–9) char-

acters.
❒ Entering the “User ID” helps you to distinguish the print job from others.
The following table shows the tabs or menus where you can select this func-
tion.

❖❖❖❖ Locked Print
Use this function to save document data in the machine memory with the
password, and then edit and print them as you want.

Limitation
❒ To use this function, the Hard Disk Drive must be installed on the printer.

Note
❒ The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0–9) char-

acters. The “Password” must be four digits.
The following table shows the tabs or menus where you can select this func-
tion.

Windows 95/98/Me [Job Type] on the [Job/Log] tab

Windows 2000 [Job Type] on the [Job/Log] tab

Windows NT 4.0 [Job Type] on the [Job/Log] tab

Macintosh [Job Log] in the print dialog box

Windows 95/98/Me [Job Type] on the [Job/Log] tab

Windows 2000 [Job Type] on the [Job/Log] tab

Windows NT 4.0 [Job Type] on the [Job/Log] tab

Macintosh [Job Log] in the print dialog box
5
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Toner Saver, Edge Smoothing

Follow the procedures below to print a document using “Toner Saver” or “Edge
Smoothing”.

Windows 95/98/Me

A From an application, select the menu command to print. 

The print dialog box appears.

B Open the Printer Properties.

C Click to select the [Device Options] tab.

D Select the function you want to use.

E Click [Apply] to apply the settings you made.

F After making all of the settings you want, click [OK] to close the Printer
Properties.

G Start printing from the application's print dialog box.

Windows 2000

A From an application, select the menu command to print.
The print dialog box appears.

B Open the Printer Properties.

C Click to select the [Layout] tab.

D Click [Advanced...].

The [Advanced Options] appears.

E Click to select the function you want to use and select the appropriate set-
ting.

F After making all of the settings you want, click [OK] to close the Printer
Properties.

G Start printing from the application's print dialog box.
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Windows NT 4.0

A From an application, select the menu command to print.
The print dialog box appears.

B Open the Printer Properties.

C Click the [Advanced] tab.

D From [Document Options], select the function you want to use.

E Click [OK] to apply the settings you made.

F After making all of the settings you want, click [OK] to close the Printer
Properties.

G Start printing from the application's print dialog box.

Macintosh

A From an application, select the menu command to print.

The print dialog box appears.

B Use the list box to select [Printer Specific Options].

C Use the list box to select the appropriate setting.

D After making all of the settings you want, click [OK].
7
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Sample Print

Follow the procedures below to print a document using the “Sample Print”
function.

Windows 95/98/Me

Note
❒ If the application has a collate option, make sure that it is not selected before

sending a print job. By default, sample print jobs are automatically collated
by the printer driver. If a collate option is selected from the application print
dialog box, more printings than intended may be printed.

A From an application, select the menu command to print.

The print dialog box appears.

B Open the Printer Properties.

C Click to select the [Job/Log] tab.

D Select [Sample Print] in the [Setup].

E Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. 

Note
❒ This is used to identify the user associated with a job.
❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-

acters.

F Click [OK].

G Click [OK] to close the Printer Properties.

H Start printing from the application's print dialog box.

The Sample Print job is sent to the machine and one printing set is printed.

I Check the print job to confirm that the settings are all right.

If the settings are fine, go to step J to print the remaining print job.
If not, you can delete the saved job. ⇒ P.12 “Deleting a Sample Print file” 

J On the machine's operation panel, press {{{{Menu}}}}.

K Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

  Menu:

   Sample Print
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L Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Sample Print:

  08:56 ABCD1234

M Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

N Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Qty:  1(1-999)

  Press #To Print

O Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press
{{{{Enter qqqq}}}} to print the file.

The following message appears on the panel display.

  Printing...

 

Windows 2000, Windows NT 4.0

Note
❒ If the application has a collate option, make sure that it is not selected before

sending a print job. By default, sample print jobs are automatically collated
by the printer driver. If a collate option is selected from the application print
dialog box, more printings than intended may be printed.

A From an application, select the menu command to print.

The print dialog box appears.

B Open the Printer Properties.

C Click to select the [Job/Log] tab.

D Select [Sample Print] in the [Print Job].

E Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. 

Note
❒ This is used to identify the user associated with a job.
❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-

acters.
9
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F Click [OK] to close the Printer Properties.

G Start printing from the application's print dialog box.
The Sample Print job is sent to the machine and one printing set is printed.

H Check the print job to confirm that the settings are all right.

If the settings are fine, go to step I to print the remaining print job.
If not, you can delete the saved job. ⇒ P.12 “Deleting a Sample Print file” 

I On the machine's operation panel, press {{{{Menu}}}}.

J Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

  Menu:

   Sample Print

K Press {{{{Enter qqqq}}}}.
The following message appears on the panel display.

  Sample Print:

  08:56 ABCD1234

L Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

M Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.
The following message appears on the panel display.

  Qty:  1(1-999)

  Press #To Print

N Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press
{{{{Enter qqqq}}}} to print the file.
The following message appears on the panel display.

  Printing...

 



Printing a Document

1

Macintosh

A From an application, select the menu command to print.
The print dialog box appears.

B Click to select the [Job Log].

C Select [Sample Print] and select the appropriate setting.

D Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. 

Note
❒ This is used to identify the user associated with a job.
❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-

acters.

E After making all of the settings you want, click [Print].
The Sample Print job is sent to the machine and one printing set is printed.

F Check the print job to confirm that the settings are all right.

If the settings are fine, go to step G to print the remaining print job.
If not, you can delete the saved job. ⇒ P.12 “Deleting a Sample Print file” 

G On the machine's operation panel, press {{{{Menu}}}}.

H Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

  Menu:

   Sample Print

I Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Sample Print:

  08:56 ABCD1234

J Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

K Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.
The following message appears on the panel display.

  Qty:  1(1-999)

  Press #To Print
11
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L Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press
{{{{Enter qqqq}}}} to print the file.

The following message appears on the panel display.

  Printing...

 

Deleting a Sample Print file

If the printed document is not what you expected, you can delete the sample
print file.

A Press {{{{Menu}}}}.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Sample Print", and then press {{{{Enter qqqq}}}}.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to delete, and then press {{{{Enter qqqq}}}}.

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Delete File”, and then press {{{{Enter qqqq}}}}.
The following message appears on the panel display.

  08:56 ABCD1234

  Press # To Del.

E Press {{{{Enter qqqq}}}} to delete the file.

The following message appears on the panel display.

  Deleted
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1

Locked Print

Follow the procedures below to print a document using the “Locked Print” function.

Windows 95/98/Me

A From an application, select the menu command to print.

The print dialog box appears.

B Open the Printer Properties.

C Click to select the [Job/Log] tab.

D Select [Locked Print] in [Job Type].

E Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. Then enter a password in [Password], up to four
digits. 

Note
❒ This is used to identify the user associated with a job.
❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-

acters. The “Password” must be four digits.

F Click [OK].

G Click [OK] to apply the settings you made.

H After making all of the settings you want, click [OK] to close the Printer
Properties.

The document file is saved in the printer.
If you want to print this document, go to step I to print the remaining print job.
If not, you can delete the saved job. ⇒ P.17 “Deleting a Locked Print file” 

I On the machine's operation panel, press {{{{Menu}}}}.

J Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

  Menu:

   Locked Print

K Press {{{{Enter qqqq}}}}.
The following message appears on the panel display.

  Locked Print:

  08:56  ABCD1234
13
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L Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Password:

  [0---]

M Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

N Press {{{{Enter qqqq}}}}.

The pointer ( k ) moves to the next entry field automatically.

O Repeat steps NNNN and OOOO to set the password.
Check if the pointer ( k ) is at the rightmost position, and then press {Enter q}
to register the password you selected.

P Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Qty:  1(1-999)

  Press # To Print 

Q Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press
{{{{Enter qqqq}}}} to print the file.

The following message appears on the panel display.

  Printing...

 

Windows 2000, Windows NT 4.0

A From an application, select the menu command to print.

The print dialog box appears.

B Open the Printer Properties.

C Click to select the [Job/Log] tab.

D Select [Locked Print] in [Print Job].

E Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric
(a-z, A-Z, 0-9) characters. Then enter a password in [Password], up to four digits. 

Note
❒ This is used to identify the user associated with a job.
❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-

acters. The “Password” must be four digits.
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F Click [OK] to apply the settings you made.

G After making all of the settings you want, click [OK] to close the Printer
Properties.

The document file is saved in the printer.
If you want to print this document, go to step H to print the remaining print job.
If not, you can delete the saved job. ⇒ P.17 “Deleting a Locked Print file” 

H On the machine's operation panel, press {{{{Menu}}}}.

I Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

  Menu:

   Locked Print

J Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Locked Print:

  08:56  ABCD1234

K Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.
The following message appears on the panel display.

  Password:

  [0---]

L Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

M Press {{{{Enter qqqq}}}}.

The pointer ( k ) moves to the next entry field automatically.

N Repeat steps LLLL and MMMM to set the password.

Check if the pointer ( k ) is at the rightmost position, and then press {Enter q}
to register the password you selected.

O Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Qty:  1(1-999)

  Press # To Print 
15
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P Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press
{{{{Enter qqqq}}}} to print the file.

The following message appears in the panel display.

  Printing...

 

Macintosh

A From an application, select the menu command to print.
The print dialog box appears.

B Click to select the [Job Log].

C Select [Locked Print] and select the appropriate setting.

D Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. Then enter a password in [Password], up to four
digits. 

Note
❒ This is used to identify the user associated with a job.
❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-

acters. The “Password” must be four digits.

E After making all of the settings you want, click [Print].
The Sample Print job is sent to the machine and one printing set is printed.

F Check the print job to confirm that the settings are all right.

If the settings are fine, go to step G to print the remaining print job.
If not, you can delete the saved job. ⇒ P.17 “Deleting a Locked Print file” 

G On the machine's operation panel, press {{{{Menu}}}}.

H Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

  Menu:

   Locked Print

I Press {{{{Enter qqqq}}}}.
The following message appears on the panel display.

  Locked Print:

  08:56  ABCD1234
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J Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Password:

  [0---]

K Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

L Press {{{{Enter qqqq}}}}.

The pointer ( k ) moves to the next entry field automatically.

M Repeat steps KKKK and LLLL to set the password.
Check if the pointer ( k ) is at the rightmost position, and then press {Enter q}
to register the password you selected.

N Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Qty:  1(1-999)

  Press # To Print 

O Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press
{{{{Enter qqqq}}}} to print the file.

The following message appears on the panel display.

  Printing...

 

Deleting a Locked Print file

If the printed document is not what you expected, you can delete the Locked
print file.

A Press {{{{Menu}}}}.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Locked Print", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to delete, and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Password:

  [0---]
17



PostScript 3

18

1

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

E Press {{{{Enter qqqq}}}}.
The pointer ( k ) moves to the next entry field automatically.

F Repeat steps DDDD and EEEE to set the password.

Check if the pointer ( k ) is at the rightmost position, and then press {Enter q}
to register the password you selected.

G Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Delete File", and then press {{{{Enter qqqq}}}}.
The following message appears on the panel display.

  08:56 ABCD1234

  Press # To Del.

H Press {{{{Enter qqqq}}}} to delete the file.

The following message appears on the panel display.

  Deleted
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Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of
printer and so on.

Note
❒ Printer Utility for Mac is included on the CD-ROM labeled “Drivers and Util-

ities”.
❒ Printer Utility for Mac requires Mac OS 7.6.1 or later.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

A Start the Macintosh.

B Insert the CD-ROM into the CD-ROM drive.

The icon of the CD-ROM appears.

C Double-click the icon of hard disk to open it.

D Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

E Double-click the [PS Utility] folder of the CD-ROM, and then drag the [Printer
Utility for Mac] file and drop it into the Macintosh hard disk.

F Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed.

Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Important
❒ Before starting Printer Utility for Mac, confirm that the printer is selected with

[Chooser] on the Apple menu.

A Double-click the icon of Printer Utility for Mac.
The Printer Utility for Mac dialog appears.

B Click [OK].

Printer Utility for Mac will take a few seconds to start.

Reference
For more information, see "Printer Utility for Mac Functions". 
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

❖❖❖❖ File menu
• [Download PS Fonts]

Download fonts (PostScript Type 1) to the printer. See P.21 “Downloading
PS Fonts”.

• [Display Printer's Fonts]
Display and delete the fonts in printer memory and the printer's hard disk
drive. See P.22 “Displaying Printer's Fonts”.

• [Initialize Printer's Disk]
Initialize the printer's hard disk drive. See P.23 “Initializing the Printer
Disk”.

• [Page Setup]
Set up the paper size to print “Printer Font Catalog” and “Printer Font
Sample”. See P.23 “Page Setup”.

• [Print Font Catalog]
Print the names of available fonts. See P.23 “Printing Font Catalog”.

• [Print Font Sample]
Print a sample of fonts. See P.24 “Printing Font Sample”.

• [Rename Printer]
Change the printer's name when viewed via Appletalk. See P.24 “Renam-
ing the Printer”.

• [Restart Printer]
Restart the printer. See P.25 “Restarting the Printer”.

❖❖❖❖ Utility menu
• [Download PostScript File]

Download a PostScript File. See P.25 “Downloading PostScript Files”.
• [Select Zone]

Change the zone the printer belongs to via Appletalk. See P.25 “Selecting
the Zone”.

• [Display Printer Status]
Display the status of the printer. See P.26 “Displaying the Printer Status”.

• [Launch Dialogue Console]
Create and edit a PostScript file, and download it to the printer. See P.26
“Launching the Dialogue Console”.
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Downloading PS Fonts

Important
❒ The following procedures to download the fonts assume that you are a sys-

tem administrator. If you are not, be sure to consult your system administra-
tor.

❒ Resetting the printer cause the fonts to be deleted from printer.
❒ Confirm that Macintosh and the printer are connected with Appletalk envi-

ronment.

Note
❒ Some fonts which cannot be downloaded.
❒ Before downloading, read the documentation of the fonts you want to use.

A Select [Download PS Fonts...] on the [File] menu.

B Click [Add to list].

The dialog box to select fonts appears.

C Click to select the desired font files, and then click [Open].
The list of selectable font name appears.

D After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

Note
❒ If Hard Disk Drive Type 2600 is installed in the printer, you can select

[Printer's Disk].

E Click [Download].
The fonts begin to download, and the download status is shown.

Important
❒ During the download, do not turn off the power switch, operate the panel

or open or close the cover.

F When the completion message appears, and click [OK].

G Click [Cancel].
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Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts
in the printer's memory and hard disk drive can be displayed.

A Select [Display Printer's Fonts...] on the [File] menu.
The dialog box appears.

B Select [Printer's memory] or [Printer's disk].

C Click [OK].

Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

A Select [Display Printer's fonts] on the [File] menu.

The dialog box appears.

B Select the [Printer's memory] or [Printer's disk].

C Select the fonts you want to delete.

Limitation
❒ You cannot delete the fonts displayed in Italic.

D Click [Delete].

The confirmation message appears.

E Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

F Click [Continue] and then click [OK].

G Click [OK].
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Initializing the Printer Disk

To initialize the printer's hard disk, delete all the fonts downloaded to the print-
er's hard disk drive. Before initializing, be sure to confirm the fonts on the hard
disk drive.

Important
❒ To initialize the printer's hard disk drive from operation panel, delete all of

the data on the printer's hard disk drive. Before initializing, be sure to confirm
the data on the hard disk drive.

A Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears.

Note
❒ To cancel initialization, click [Cancel].

B Click [Execute].

Initializing starts.

Important
❒ Do not turn off the power switch until initializing is completed, otherwise

the hard disk drive must be damaged.

C When the completion message appears, click [OK].

Page Setup

You can set the paper size on which print “Print Fonts Catalogue” and “Prints
fonts Sample”.

A Select [Page Setup...] on the [File] menu.

B Choose the paper size.

Printing Font Catalog

Print the names of fonts available on the printer.

Note
❒ The paper selected under [Page Setup] is used.

A Select [Print Fonts Catalogue] on the [File] menu.

B Click [Print].
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Printing Font Sample

You can print samples of fonts that downloaded on hard disk drive and the
memory.

Note
❒ Print by using the paper selected on [Page Setup].

A Select [Print Fonts Sample...] on the [File] menu.

B Click [Print].

Renaming the Printer

You can change the printer's name displayed under Appletalk. If you connect
several printers on the network, assign different names so you can identify them.
If several printers have the same name, a digit appears next to the printer name
in the [Chooser].

A Select [Rename Printer...] on the [File] menu.

B Type a new name in the [New Name:] field. 

Limitation
❒ You can enter up to 31 digits and letters.
❒ Do not use symbols, for example “*”, “:”, “=”,”@”, “~”.

C Click [Rename].

The printer name is changed.

D Press [OK].

E Select [Chooser] on the Apple menu.

F Click the icon of [AdobePS].

G Click to select the printer name renamed in step BBBB and then close [Chooser].

Note
❒ If there are several Appletalk zone, select the zone the printer belongs to.
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Restarting the Printer

You can restart the printer. The fonts in printer's memory must be deleted.

A Select [Restart Printer] on the [File] menu.

B Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

Note
❒ If the printer restarts, all the printer settings return to their defaults. For

how to set each function, see the Printer Reference provided as a PDF file
which is included in the CD-ROM labeled “Operating Instructions”.

Downloading PostScript Files

You can download a PostScript file for printing.

A Select [Download PostScript File...] on the [Utility] menu.

B Select the file name to print and click the file name, and then click [Open].

C Type the log file name, and then click [Save].

The selected file is printed.

Note
❒ Errors are recorded in the log file.

Selecting the Zone

You can change the zone the printer belongs under Appletalk.

Important
❒ Confirm that the printer and a Macintosh are connected in an Appletalk en-

vironment.

A Select [Select Zone...] on the [Utility] menu.

The zone the printer belongs and available zone list appear.

B Select the zone that you want to switch the printer and then click [Change].
A confirmation message appears.

C Click [Continue].

A confirmation message appears.

D Press [OK].

E Select [Chooser] on the Apple menu.
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F Click the [AdobePS] icon.

G Select the zone changed in step BBBB on the [Appletalk zone:].

H Click to select the printer you want to use on the [Select a PostScript Printer:].

I Close [Chooser].

Displaying the Printer Status

You can display and confirm the current status of the printer.

A Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

B Confirm the current status of the printer.

You can confirm the memory capacity, the VM space, the hard disk drive sta-
tus and available space on the hard disk drive. You can also confirm the zone
the printer belongs to.

C Click [OK].

Launching the Dialogue Console

You can create and edit PostScript file for printing, and download it to the printer.

Important
❒ “Launch Dialogue Console” is recommended for user with a grasp of PostScript.
❒ Do not download any file other than PostScript files to the printer.
❒ “Launch Dialogue Console” must be used at your own responsibility.

A Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen, and then Dialogue Console menu bar appears.

B Type is the PostScript command in the editor screen.

Note
❒ To edit a PostScript file, select [Open] on the [File] menu to open it.
❒ You can search or replace a character string by using the [Search] menu.

C After editing the PostScript file, select [Download Top Window] on the [Con-
sole] menu to start printing.
The PostScript file is sent to the printer.

Note
❒ The [Reply from Printer] opens, depending on the PostScript file you sent.

D Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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UNIX Supplement
Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.



Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the “Operating Instructions” before using this machine. It contains
important information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Trademarks

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun, SunOS, Solaris are trademarks or registered trademarks of Sun Microsystems, Inc. in the United
States and other countries.

HP-UX is a registered trademark of Hewlett-Packard Company.

LINUX is a trademark of Linus Torvalds.

RED HAT is a registered trademark of Red Hat, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.



Manuals for This Printer

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this printer, all users should read and
follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide 
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

❖❖❖❖ Printer Reference
Provides information about using the printer and its options. This manual
provided as a PDF file on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Network Interface Board Operating Instructions
Provides information about setting up and using the printer in a network en-
vironment. This manual provided as a PDF file on the CD-ROM labeled “Op-
erating Instructions”.

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features for the PostScript 3 printer driver. This
manual provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions”.

❖❖❖❖ UNIX Supplement (this manual)
Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

Note
❒ There are two CD-ROMs that come with this printer. One is labeled "Operat-

ing Instructions" and the other is "Drivers and Utilities".
i
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.
Keys on the computer's keyboard.
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1. UNIX Configuration
This section explains how to set up a network printer and check the print status
using UNIX.

Limitation
❒ To print from a UNIX workstation, use the file that the printer supports.

Using the Installation Shell Script

The installation shell script helps with the setup process. The installation shell
script automates some of the tasks in configuring /etc/hosts, /etc/printcap, and
in creating the spool directory for BSD UNIX, and in running lpadmin command
for System V UNIX.

Preparation
The installation shell script can be used on the following three kinds of the
workstations. Do not use this installation shell script with other types of
workstations.
• Solaris 2.5.1, 2.6, 7, 8
• HP-UX 8.x, 9.x, 10.x, 11.0
• Red Hat Linux 6.2
When you use NIS (Network Information Service) or DNS, you should con-
figure the server before running this installation shell script.
For more information about the configuration utility of your OS, see the man-
ual that came with the utility.

Assigning the IP Address

Preparation
Configure the printer to use the TCP/IP protocol. 
• Confirm that the TCP/IP protocol on the printer is set to be active. (The fac-

tory default is active.) 
• Assign an IP address to the printer and configure the other settings re-

quired for using the TCP/IP protocol.

Reference
For more information about how to make above settings, see the Setup Guide
that comes with the printer.
1
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Confirming the IP address

Follow the procedure below to confirm that the IP address has been configured
correctly.
• Following procedure uses sample IP address: 192.168.15.16.

A Enter the following:

# ping 192.168.15.16

If the address has been configured correctly, the following message appears.
192.168.15.16 is alive

If the address has been configured incorrectly, the following message ap-
pears.
no answer from 192.168.15.16

Note
❒ When you use NIS, the IP address and host name are written to /etc/hosts

on the master server. When you use DNS, the information is written to a
data file on the name server. After writing the host name and IP address to
the file, confirm the configuration by pinging the host name.
# ping host_name

❒ If the host name is registered with an IP address, the server can access the
printer using its host name instead of its IP address.

Executing the Installation Shell Script

After having configured the printer IP address, follow the procedure below to
execute the installation shell script and set up the workstation printing environ-
ment.

Preparation
Before executing the installation shell script, the IP address, the host name
and the printer name must be required.
Following procedures use sample IP address: 192.168.15.16, sample host
name: nphost and sample printer name: np.

Note
❒ Use ftp to get the installation shell script from the printer.

A Log on to the workstation as root.

Note
❒ If you do not log on as root, the installation shell script will not run.
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B Get the installation shell script from the printer.

A Move to the directory you want to copy the installation shell script to.
B Use ftp to connect to the printer with the IP address that you just config-

ured.
# ftp 192.168.15.16
Connected to 192.168.15.16
220 printer FTP server ready.
name (192.168.15.16:root:)

C When a user name is requested, ignore and press the {{{{RETURN}}}} key.

331 Password required for root.
Password:

D When a password is requested, ignore and press the {{{{RETURN}}}} key.
230 User root logged in.
ftp>

E Type the following to get the installation shell script.

ftp> get install

F Close the ftp session.
ftp> bye
221 Goodbye.
#

C Run the installation shell script.
# sh ./install

Note
❒ Insert a period and slash before the current directory.

D Enter a number to select the workstation OS that you are using.

Network printer install shell
 Copyright RICOH CO.,LTD. 1994-2000
 Select your workstation OS type.
  1. SunOS 4.x.x
  2. Solaris 2.x, Solaris 7-8 (SunOS5.x)
  3. HP-UX 8.x,9.x,10.x,11.x
  4. UnixWare
  5. Linux
  6. other
Enter <1-6>:
2

Note
❒ SunOS and UnixWare appear on the screen, but they are not supported.

Use Solaris, HP-UX or Linux.
❒ If you select “6”, the installation shell script exits.
3
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E Enter the IP address of the printer.

Enter Printer host IP address <xxx.xxx.xxx.xxx> [re-
turn=skip]:
192.168.15.16

Note
❒ The IP address will be added to the /etc/hosts file.
❒ If the host name of the printer has already been configured, ignore and

press the {RETURN} key. Nothing is added to the /etc/hosts file.

F Enter the host name of the printer.

Enter Printer host name : nphost

Note
❒ The host name will be added to the /etc/hosts file.
❒ If no IP address was entered in step E, nothing is added to the /etc/hosts file.

G Configure the printer name.

Enter logical printer name [default nphost_prn]

If you want to use the default name, press the {RETURN} key. If you want to
change this name, enter a new name.

Note
❒ The host name entered in step F followed by “_prn” appears in “default”.

H Set the print option.
Enter remote printer name [default lp]:

• Press the {RETURN} key, print with PCL or PostScript is enabled.
• If you want to set the device option, enter the option parameter.

Enter remote printer name [default lp]:duplex=on
For more information about device option, see P.15 “Specifying the Device Option”.

• If you enter “text”, text printing is enabled.
If you enter “text”, printing with PCL and PostScript is unavailable.
Enter remote printer name [default lp]:filetype=text

Limitation
❒ You can enter up to 11 characters for HP-UX 11.0, 256 for Solaris 8, and 51

for Red Hat Linux 6.2.
❒ Solaris 2.6 or more cannot accept (,). And you must use (_) instead of (=).

So you can set the only one print option.
Setup with the installation shell script is finished. If you enter the IP address
in step E, the following message appear.
hosts file is modified
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I Make a test print to confirm that the settings are correct.

# lpr -Pnp file_name

# lp -d np file_name

For more information about lpr and lp, see P.10 “Printing Method”.

Deleting the printer

To print using the lp or lpr command, the option specified when the Installation
Shell Script is executed is used. Change the option in accordance with the work-
station you are using.

❖❖❖❖ BSD UNIX workstation, Linux
Delete the printer entry from /etc/printcap, then execute the installation
shell script again. Select options during the setup process.
Or, search the printer entry from /etc/printcap, change its rp capability to op-
tion setting.

❖❖❖❖ Solaris, HP-UX
Delete the printer entry, and then execute the installation shell script again.
Select options during the setup process. To delete the printer entry, follow the
procedure below.
A Stop the scheduler.

# /usr/sbin/lpshut

B Delete the printer.
# /usr/sbin/lpadmin -x printer_name

C Restart the scheduler.
# /usr/lib/lpsched
5
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Setup

The printing environment is set up automatically when the installation shell
script is executed.
This section describes the set up contents when the installation shell script is ex-
ecuted under Red Hat Linux, Solaris and HP-UX.

Linux

❖❖❖❖ Adding the IP address and host name to the /etc/hosts file
The following line is added to the /etc/hosts file.
192.168.15.16  nphost  # Network Printer

• 192.168.15.16 is the IP address, nphost is the host name, from # to the end
of the line is a comment.

Note
❒ The /etc/hosts file contains a list of the IP addresses and their host names

of all of the hosts communicating on the network. Each entry is delimited
with a space or a tab, and each line is separated with a return.

❒ If you do not use NIS or DNS, you must manually enter the IP address and
host name of each workstation using the network printer in the /etc/hosts file.

❖❖❖❖ Adding an entry to the /etc/printcap file
The following entry is added to the /etc/printcap file.
This is the configuration for printing with the lpr command. In order to use
the lpr command to print, you need to edit the /etc/hosts file, add an entry
for the network printer to the /etc/printcap file and create a spool directory.
np|Network Printer:\
      :rm=nphost:\
      :rp=lp:\
      :sd=/var/spool/lpd/npd:\
      :lf=/var/log/npd-errs:\
      :sh:\
      :mx#0:

Note
❒ The /etc/printcap file is used to register the name and attributes of a print-

er. You must make an entry for the network printer in the /etc/printcap
file of all workstations using the network printer.

❒ Each entry is separated with colons into several fields. The syntax is to be-
gin each entry with a colon, the entry, and then end the entry with a colon,
a back slash, and then a return.

❒ The first line of the field is the name of the printer. You use this name when
logging on to a network printer from a workstation. You can define several
different names by separating each name with the “|” character.



Using the Installation Shell Script

1

❒ The second, and the following lines, contain the printer's attributes. At-
tributes of the printer are represented by two character names referred to as
capabilities. For more information about capabilities, see the following table.

❖❖❖❖ Making the spool directory
Create a spool directory under /var/spool/lpd. The name of spool directory
should be the name of the printer followed by a “d”.

Note
❒ The spool directory is used to control the data used for a print job. For ex-

ample, when a print job is created, a temporary copy of the file data used
for printing is created in the spool directory. All workstations accessing the
network printer need to have a spool directory for the network printer.

❒ A spool directory should be made for every network printer entry listed in
the /etc/printcap file.

❒ The spool directory should normally be made under /var/spool/lpd and
the name should match that listed under the sd capability in /etc/print-
cap. Change the owner and group of the directory to daemon, and set its
permission to 775. The following examples show how to make a /var/
spool/lpd/npd spool directory.
# cd /var/spool/lpd
# mkdir np
# chown daemon np
# chgrp daemon np
# chmod 775 np

❖❖❖❖ Making the log file
Error messages are logged to a file created in the /var/log directory. The log
file name is the printer name followed by “d-errs”.

Capability Explanation Value Required for the Network 
Printer.

lp Device name of the printer Nothing.

rm Host name of the printer The host name that was registered 
with the /etc/hosts file.

rp Optional specification Select options for printing. For 
more information about available 
options, see P.15 “Specifying the 
Device Option”.

sd Path name of the spool directory. Path name of the spool directory 
that is to be created.

lf Path name of the log file. Path name of log file.

For example /var/log/lpd-errs.

mx Maximum file size which the di-
rectory can copy. When set to 0, the 
size is unlimited. If nothing is en-
tered, the size is set to 1024 k. 

Nothing or something suitable.
7
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Solaris

❖❖❖❖ Adding the IP address and host name to the /etc/hosts file
The following line is added to the /etc/hosts file.
192.168.15.16  nphost  # Network Printer

• 192.168.15.16 is the IP address, nphost is the host name, from # to the end
of the line is a comment.

Note
❒ The /etc/hosts file contains a list of the IP addresses and their host names

of all of the hosts communicating on the network. Each entry is delimited
with a space or a tab, and each line is separated with a return.

❒ If you do not use NIS or DNS, you must manually enter the IP address and host
name of each workstation using the network printer in the /etc/hosts file.

❖❖❖❖ Registering the printer
The installation shell script registers the printer as a remote printer.
A If your workstation is Solaris 2.5.1, register the print server and print client

to the print service.
# lpsystem -t bsd -R 0 -y ″″″″Network Printer″″″″ nphost

B Register the printer as a remote printer.
# lpadmin -p np -s nphost!option -T dump -I any

• np is the printer name, nphost is the host name. For more information
about option, see P.15 “Specifying the Device Option”.

C If your workstation is Solaris 2.5.1, set the print job enable to be accepted
by print queue.
/usr/lib/accept np

D If your workstation is Solaris 2.5.1, set the print job enable to print.
/usr/lib/enable np
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HP-UX

❖❖❖❖ Adding the IP address and host name to the /etc/hosts file
The following line is added to the /etc/hosts file.
192.168.15.16  np  # Network Printer

• 192.168.15.16 is the IP address, np is the host name, from # to the end of the
line is a comment.

Note
❒ The /etc/hosts file contains a list of the IP addresses and their host names

of all of the hosts communicating on the network. Each entry is delimited
with a space or a tab, and each line is separated with a return.

❒ If you do not use NIS or DNS, you must manually enter the IP address and host
name of each workstation using the network printer in the /etc/hosts file.

❖❖❖❖ Registering the printer
The installation shell script registers the printer as a remote printer following
the procedure below.
A Stop the scheduler.

/usr/lib/lpshut

B Register the printer.
/usr/lib/lpadmin -Pnp -v/dev/null -mrmodel

 -ormnphost -orpoption -ob3

• np is the printer name, nphost is the host name. 
For more information about option, see P.15 “Specifying the Device Op-
tion”.

C Set the printer so that the print job is listed in the print queue.
/usr/lib/accept np

D Set the printer to perform the print job.
/usr/lib/enable np

E Restart the scheduler.
/usr/lib/lpsched
9
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Printing Method

Printing with lpr, lp

Depending on the type of the workstation being used, execute one of the follow-
ing commands:

❖❖❖❖ BSD UNIX workstation
% lpr -Pprinter_name file_name [file_name...]
For example:
printer name is np, file names are file1 and file2
% lpr -Pnp file1 file2

❖❖❖❖ Solaris, HP-UX
% lp -d printer_name file_name [file_name...]
For example:
printer name is np, file names are file1 and file2
% lp -d np file1 file2

Note
❒ ”printer_name” is the name that was entered when executing the installation

shell script.
❒ You can use wild cards ( * or ? ) for the file name.
❒ The message “print session full” appears when the maximum number of

print requests has been reached *1 . You should try to print again when the
number of requests becomes less than five. You can confirm the number of
print requests using telnet. For more information about using telnet, see the
Network Interface Board Operating Instructions provided as a PDF file on the
CD-ROM labeled “Operating Instructions”.

*1 The maximum number of print session differ depending on printer's total memory
size. When the printer has standard memory (32MB), one print session is available.
When the printer has optional memory (total 96MB), the maximum number of print
session is five.
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Printing with rsh, rcp, ftp 

You can also print using the rsh, rcp and ftp commands.

Note
❒ Print using the format that the printer can support.
❒ The message “print session full” appears when the maximum number of

print requests has been reached *1 . You should try to print again when the
number of requests becomes less than five. You can confirm the number of
print requests using telnet. For more information about using telnet, see Net-
work Interface Board Operating Instructions provided as a PDF file on the
CD-ROM labeled “Operating Instructions”.

*1 The maximum number of print session differs depending on printer's total memory
size. When the printer has standard memory (32MB), one print session is available.
When the printer has optional memory (total 96MB), the maximum number of print
sessions available is five.

rsh

% rsh host_name print < file_name [file_name...]

For example:
host name is nphost, file names are file1 and file2
% rsh nphost print < file1 file2

Note
❒ ”host_name” is the name entered when executing the installation shell script.
❒ If you use a HP-UX, use the remsh command instead of rsh.

rcp

❖❖❖❖ To specify the file and print it
% rcp file_name [file_name...] host_name:
For example:
host name is nphost, file names are file1 and file2
% rcp file1 file2 nphost

❖❖❖❖ To print all of the files in a directory
% rcp -r directory_name host_name:
For example:
host name is nphost, directory name is directory1
% rcp -r directory1 nphost

Note
❒ ”host_name” is the name entered when executing the installation shell script.
❒ You can use wild cards ( * or ? ) for the file name.
11



UNIX Configuration

12

1

ftp

Depending on the number of files to be printed, use the put or mput commands.

Limitation
❒ File names cannot contain “=” or “,”.

❖❖❖❖ To print one file
ftp> put file_name

❖❖❖❖ To print several files
ftp> mput file_name [file_name...]

Note
❒ You can use wild cards ( * or ? ) for the file name with the mput command.

The following procedure shows an example of how to print a file using ftp. 

A Start ftp using the IP address or host name of the printer.
% ftp IP_address

Note
❒ ”host_name” is the name entered when executing the installation shell script.

B Enter the user name. Ignore the password, and then press the {{{{RETURN}}}}
key.

Name:
Password:

C Set the file transfer mode to binary.

ftp> bin

Note
❒ If the file transfer mode is not set to binary, the image might not be printed

correctly.

D Print the file.

Note
❒ For example, to print one file named file1:

ftp> put file1 

❒ For example, to print two files named file1 and file2:
ftp> mput file1 file2

E Exit ftp.

ftp> bye



Printer Status

1

Printer Status

You can use the following commands to have information and the printer status
displayed or copied to a file.
Use the lpq or lp command to display the status of the printer or information
about print jobs.
Use the rsh, rcp or ftp commands to get more detailed information from the
printer.

Viewing the Printer Status with lpq and lpstat

❖❖❖❖ BSD UNIX workstation, Linux
% lpq -Pprinter_name 
For example: Printer name is np
% lpq -Pnp 

❖❖❖❖ System V UNIX, Soralis, HP-UX
% lpstat -o printer_name 
For example: Printer name is np
% lpstat -o np 

Viewing the Printer Status with rsh and ftp

Use the rsh or ftp command to display the status of printer or information about
print jobs using specified parameters.
You can use these commands for BSD and System V UNIX.

Note
❒ If your workstation is HU-UX, use the remsh command instead of the rsh.
% rsh host_name parameter

 
% ftp host_name
User user_name
password:
ftp> get parameter -
13
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Note
❒ For the user name and password input nothing, and then press the {RETURN}

key.
Parameters that can be used with rsh, rcp and ftp:

Copying Information to a File

Use the rcp or ftp command to copy information about the specified parameters
to a file.
You can use these commands for BSD and System V UNIX.

Note
❒ The same parameters are used as those above.
% rcp host_name:parameter file_name

 
% ftp host_name
User: user_name
password:
ftp> get parameter file_name

Note
❒ For the user name and password input nothing, and then press the {RETURN}

key.

Parameter Information returned Reference

status
Status of the printer.

Information about print jobs.

Network Interface Board 
Operating Instructions 
provided as a PDF file on 
the CD-ROM labeled “Op-
erating Instructions”.

info
Information about the paper tray, output tray 
and printer language of the printer.

Printer Reference provid-
ed as a PDF file on the CD-
ROM labeled “Operating 
Instructions”.

prnlog Record of the last 16 jobs printed. Network Interface Board 
Operating Instructions 
provided as a PDF file on 
the CD-ROM labeled “Op-
erating Instructions”.

syslog
Record of messages about the Network Interface 
Board.
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Specifying the Device Option

With the following options, you can print with specific printer function.

Limitation
❒ The optional character strings that the printer can recognize are a maximum

of 512 bytes.
❒ The number of available characters used as options are limited, depending on

their operating systems.

Note
❒ Multiple options must be partitioned with a comma (,). Do not use space.
❒ When the printing file contains the PCL, PJL, PostScript command to control

the option, that command takes priority.
❒ Enter the option using the lp or lpr command, when the shell script is imple-

mented. The option settings you made here have been configured as a default
setting. You must create the other printer if you want to change the option set-
tings of the printer. For more information about changing the configured op-
tion, see P.5 “Deleting the printer”.

Printer Language

Select a printer language to print.
filetype=printer language

The following sample shows how to print on PostScript 3 (host name: nphost,
file name: file1).
• rsh

% rsh nphost print filetype=postscript < file1

• rcp
% rcp file1 nphost:filetype=postscript

• ftp
ftp> put file1 filetype=postscript

Printer Language Value

PCL5e pcl

PostScript 3 postscript or rps

Text text
15
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----Using the cd command with ftp
For printing with ftp, if the option is specified using the cd command, the option
is available whenever the put or mput command is used.
ftp> cd option

Note
❒ The pwd command shows the current option settings.

ftp> pwd

Input Tray

Select a default input tray.

Limitation
❒ Only the installed input trays are available.
tray=value of input tray

The following sample shows how to print from tray 2 (host name: nphost, file
name: file1).
• rsh

% rsh nphost print tray=tray2 < file1

• rcp
% rcp file1 nphost:tray=tray2

• ftp
ftp> put file1 tray=tray2

Input paper tray Value

Tray 1 tray1

Tray 2 tray2

Tray 3 tray3

Bypass Tray bypass

Auto Select all
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Paper Size

Select a paper size.

Limitation
❒ Only the loaded paper sizes are available.
paper=value of  paper size

The following sample shows how to print using A4 paper (host name: nphost,
file name: file1).
• rsh

% rsh nphost print paper=a4 < % rsh nphost print paper=a4

• rcp
% rcp file1 nphost:paper=a4

• ftp
ftp> put file1 paper=a4

Paper Size Value

A3 a3

A4 a4

A5 a5

A6 a6

B4 jisb4

B5 jisb5

B6 jisb6

11×17 ledger

81/2 × 11 letter

51/2 × 81/2 halfletter

81/2 × 14 legal

custom size custom
17
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Paper Type

Select a paper type.

Limitation
❒ Only the loaded paper types are available.
mediatype=value of paper type

The following sample shows how to print using recycled paper (host name:
nphost, file name: file1).
• rsh

% rsh nphost print mediatype=recycled < file1

• rcp
% rcp file1 nphost:mediatype=recycled

• ftp
% ftp> put file1 mediatype=recycled

Paper Type Value

Plain paper plain

Preprinted paper preprinted

Letterhead letterhead

OHP transparency transparency

Prepunched paper prepunched

Label labels

Bond paper bond

Recycled paper recycled

Color paper color

Cardstock cardstock

Special paper special

Thick paper thick
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Output Tray

Select an output tray.
outbin=value of output tray

Limitation
❒ Only the installed output trays are available.

Note
❒ The output tray value corresponds to the ID number of the output tray which

is obtained from the printer information (e.g. ls info command in ftp, info
command in telnet. For more information about telnet, see the Printer Refer-
ence provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions.).

❒ You can select an output tray using alphabet instead of the ID number of the
output tray. For more printer information, see the Printer Reference provided
as a PDF file on the CD-ROM labeled “Operating Instructions”.

*1 CS380 (Mailbox) has four output bin. The value of “optionaloutbin2”corresponds to
the lowest output bin. Selecting the bigger value, you can select the upper output bin.

The following sample shows how to print using output tray 2 (host name:
nphost, file name: file1).
• rsh

% rsh nphost print bin=2 < file1

• rcp
% rcp file1 nphost:bin=2

• ftp
ftp> put file1 bin=2

Output Tray Value

Standard Tray upper

1-bin Shift Sort Tray inner/optionaloutbin1

CS380 ( Mailbox) optionaloutbin2∼5 *1 
19
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Copies

Specify the number of copies.
copies=number of copies (1 to 999)

Limitation
❒ Do not specify “copies” and “qty *1 ” commands at the same time.
*1 “qty” is the function of collation.
The following sample shows how to print 10 copies (host name: nphost, file
name: file1).
• rsh

% rsh nphost print copies=10 < file1

• rcp
% rcp file1 nphost:copies=10

• ftp
ftp> put file1 copies=10

Collate

Specify the number of collate.
qty=number of collate (1 to 999)

Limitation
❒ Do not specify “qty” and “copies” commands at the same time.
❒ Optional memory unit or hard disk drive is required to use collate function.
The following sample shows how to print 10 copies using collate function (host
name: nphost, file name: file1).
• rsh

% rsh nphost print qty=10 < file1

• rcp
% rcp file1 nphost:qty=10

• ftp
ftp> put file1 qty=10



Specifying the Device Option

1

Duplex Print

Duplex printing is enabled.

Limitation
❒ AD410 (duplex unit) is required.
duplex=value of duplex printing

Reference
For more information about available paper size for duplex printing, see
Printer Reference provided as a PDF file on the CD-ROM labeled “Operating
Instructions”.

Binding

Select the binding direction of duplex printing.

Limitation
❒ AD410 (duplex unit) is required.

Note
❒ Before selecting the binding option, duplex option must be set to on.
❒ The print data and paper size effects whether the print job will completed.
binding=value of binding

The following sample shows how to set duplex printing and longedge binding
(host name: nphost, file name: file1).
• rsh

% rsh nphost print duplex=on,binding=longedge < file1

• rcp
% rcp file1 nphost:duplex=on,binding=longedge

• ftp
ftp> put file1 duplex=on,binding=longedge

Duplex Printing Value

Enable on

Disable off

Binding Direction Value

Longedge longedge

Shortedge shortedge
21



UNIX Configuration

22

1

Resolution

Select the resolution for printing.
resolution=resolution

The following sample shows how to print with 1200dpi (host name: nphost, file
name: file1).
• rsh

% rsh nphost print resolution=1200 < file1

• rcp
% rdp file1 nphost:resolution=1200

• ftp
ftp> put file1 resolution=1200

Resolution Value

600 dpi 600

1200 dpi 1200
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Please read the Safety Information in the Setup Guide or Printer Reference before using
this machine. It contains important information related to USER SAFETY and PREVENT-
ING MACHINE PROBLEMS.

QUICK INSTALLATION GUIDE
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Hold the toner cartridge as shown in the illus-
tration, and shake it side to side, about seven
to eight times.

Note
❒ If the toner cartridge is not shaken enough, toner

might not be evenly distributed in the cartridge. In
this case, print quality might be reduced.

Place the toner cartridge on a flat surface. Pull
out the tape inside the unit horizontally while
holding the cartridge with one hand as shown
in the illustration.

Important
❒ Be sure to remove the tape completely before installing

the toner cartridge. Otherwise, the printer might be
damaged.

❒ Be sure to pull the tape horizontally. Pulling it
upward or downward may cause the toner to scatter.

❒ Be careful not to make your cloths dirty with toner.

❒ After pulling the tape out of the cartridge, toner scatters
easily. Do not shake the cartridge.

Holding the grips of the toner cartridge, insert
it into the printer until it stops.

WHERE TO PUT THE PRINTER
The printer’s location should be carefully chosen
because environmental conditions greatly affect its
performance.

 Warning
• Confirm that the wall outlet is near the machine

and freely accessible, so that in event of an
emergency, it can be unplugged easily.

• Only connect the machine to the power source
described on this sheet.

• Avoid multi-wiring.
• Do not damage, break or make any modifica-

tions to the power cord. Do not place heavy ob-
jects on it, pull it hard or bend it more than nec-
essary. These actions could cause an electric
shock or fire.

 Caution
• Keep the machine away from humidity and dust.

A fire or an electric shock might occur.
• Place the machine on a strong and level sur-

face. Otherwise, the machine might fall and
cause personal injury.

• If you use the machine in a confined space, con-
firm that there is a continuous flow of air.

Optimum Environmental Conditions
Recommended temperature and humidity

32°C
54%

27°C 80%10°C 80%

32°C 15%10°C 15%

%RH

80

60

40

20

10 20 30 °C

15°C
70%

15°C
30%

25°C
30%

25°C
70%

50°F 80% 80.6°F 80%

77°F
70%

77°F
30%

89.6°F
54%

89.6°F 15%50°F 15%

59°F
30%

59°F
70%

80

60

40

20

50 80 9060 70

%RH

°F

 Possible operation range  Recommended range

The machine must be level within 5 mm, 0.2" both front to rear
and left to right.

Environments to Avoid

Important
❒ Locations exposed to direct sunlight or strong light

❒ Dusty areas

❒ Areas with corrosive gases

❒ Areas excessively cold, hot, or humid

❒ Locations near an air conditioner or humidifier

❒ Locations near other electronic equipment

❒ Locations where the printer might be subjected to
frequent strong vibration

Power Connection
Connect the power cord to a power source with the follow-
ing specifications:

❒ 220-240V, 50/60Hz, 4.5A or more

Space Required for Installing the Printer
Leave enough space around the printer. This space is neces-
sary to operate the printer. The recommended (or minimum)
space requirement is as follows:

A: more than 10 cm (4.0")

B: more than 10 cm (4.0")

C: more than 100 cm (40.0")

D: more than 10 cm (4.0")

INSTALLING  THE  TONER
CARTRIDGE

 Warning
• Do not incinerate spilled toner or used toner. Toner

dust might ignite when exposed to an open flame.
• Disposal can take place at our authorized dealer

or at appropriate collection sites.
• If you dispose of the used toner cartridge your-

self, dispose of them according to your local regu-
lations.

 Caution
• Do not eat or swallow toner.
• Keep toner (used or unused)  and the toner car-

tridge out of reach of children.
• Our products are engineered to meet the highest

standards of quality and functionality. When pur-
chasing expendable supplies, we recommend
using only those provided by an authorized dealer.

Important
❒ Do not expose the toner cartridge to a light for a

long time. If you do, the toner cartridge will be
damaged and the print quality might be reduced.

Open the front cover by pushing the front cover
release button.

Remove the fixing material inserted between
toner cartridge and the printer.

While lifting the front side of the toner cartridge,
pull it out of the printer.

Note
❒ Do not hold the toner cartridge upside down or

stand it vertically.
❒ Do not put the toner cartridge on an unstable

or tilted surface.

Push down the toner cartridge to settle it in the
appropriate position.

Close the front cover.

Important
❒ Do not close the front cover with force. If you

cannot close the cover easily, pull out the toner
cartridge from the printer and insert it again.
After that, close the front cover again.

<G058-8620>

UNPACKING THE PRINTER AND
CHECKING THE CONTENTS OF
THE BOX

Check the contents of the box according to
the following list. If one or some items are miss-
ing, please contact your sales or service rep-
resentative.

Important
❒ The interface cable is not included in the box. Make

sure that the interface cable you use, is appropriate
for your computer.

Quick Installation Guide (this sheet)

Setup Guide
CD-ROM
Power Cord
Printer (including a starter toner cartridge)
Additional Documentation

Remove the plastic bag. Lift the printer and move
it to the place where you want to install it.
When lifting the printer, use the inset grips on both sides of the printer.

Remove the three pieces of adhesive tape
from the printer as shown in the illustration.
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SELECTING THE PANEL
DISPLAY LANGUAGE
Select a language following the procedures
described.
The message for the selected language will
appear on the panel display.

Note
❒ The default setting is English.

❒ If you want to use the English panel display, the
following procedures are unnecessary.

Check that the power switch is turned on.

Press the Menu  ( ) key.

"Menu" appears on the panel display.

Press the  ▲ or ▼  key until the following mes-
sage appears on the panel display.

Menu:

 Language

Press the Enter  ( ) key.

Press the ▲  or ▼ key until the language you
want to select appears on the panel display.

Press the Enter  ( ) key.
The settings are applied and the ready message appears on the panel
display.

Slide the paper tray into the printer slightly until
it stops.

Important
❒ Confirm that the setting of the paper size dial

matches the size and feed direction of the paper
in the tray. Otherwise, the printer might be
damaged or a printing problem might occur.

❒ Do not slide the paper tray in and out with force.
If you do, the front and side paper guides will
move out of the place.

CONNECTING THE POWER
CORD

 Caution
• When you pull the plug out of the socket, grip

the plug to avoid damaging the cord and caus-
ing a fire or an electric shock.

• It is dangerous to handle the plug with wet
hands. An electric shock might occur.

Check that the power switch is turned off.

Securely insert the power cord plug into the
printer’s power socket.

Securely insert the power cord plug into the wall
socket.

INSTALLING THE PAPER
TRAY
The default setting of the paper size is A4 L
(long-edge feed).

For settings other than the default paper size,
see “Loading Paper and Other Media” in the
Printer Reference provided as a PDF file on
the CD-ROM labeled "Operating Instructions".
For more information about the paper sizes that
can be set in the paper tray, see “Paper and
Other Media Supported by this Printer” in the
Printer Reference provided as a PDF file on
the CD-ROM labeled "Operating Instructions".

Lift the paper tray slightly then pull it out
until it stops.

Note

❒ Do not touch the three white pins on the left
front side of the printer.

While lifting the front side of the tray, pull it
out of the printer.

Load paper into the paper tray with the
print side up.

Important
❒ Confirm that the top of the stack is not

higher than the limit mark inside the tray.

❒ Confirm that the paper fits under the rear
guide.

CONNECTING THE PRINTER TO
A COMPUTER

❖ Network connection
If your printer is installed with the Network
Interface Board, follow the procedures below.

Turn off the power switch.

Loop the network interface cable and attach
the ferrite core.

 Note
❒ The network interface cable loop should be about

15 cm(6")(a) from the end of the cable (on the
end closet to the printer). The ferrite core at the
end of the cable should be a ring type ferrite core.

Attach the network interface cable to the
jack on the board.

Connect the other end of the network interface
cable to the network.

Turn on the power switch.

❖ Parallel connection

Important
❒ The parallel interface cable is not provided with

the printer. Make sure that the interface cable
you use, is appropriate for your computer.

❒ The printer’s parallel connection is a standard
bi-directional interface. It requires a standard
36-pin parallel cable compliant with IEEE1284
and an available parallel port on your computer.

❒ To avoid electrical interference, use a shielded
cable.

Note

❒ Do not use a parallel cable more than 2.5 meters
(8.2 feet) long.

PRINTING A CONFIGURATION
PAGE
You can check if the printer works properly by
printing a configuration page.
However, you cannot check the connection
between the printer and the computer by printing
the configuration page.

Check that the power switch is turned on.

Press the Menu  ( ) key.
"Menu" appears on the panel display.

Press the  ▲  or ▼  key until the following mes-
sage appears on the panel display.

Menu:

 List/Test Print

Press the Enter  ( ) key.

The following message appears on the panel display.

List/Test Print:

 Config. Page

Press the Enter  ( ) key.
The test printing will start.

Important
❒ If you cannot complete the test printing correctly,

check if an error message appears on the panel
display. For more information about error
messages, see “Troubleshooting” in the Printer
Reference provided as a PDF file on the CD-ROM
labeled "Operating Instructions".

❒ After installing the new toner cartridge, the first
few pages might be printed with light density. If
density does not become darker, see
“Troubleshooting” in the Printer Reference
provided as a PDF file on the CD-ROM labeled
"Operating Instructions".

Turn off the power switch.

Turn the computer off.

Attach the interface cable to the interface con-
nector of the printer. Secure the cable with the
metal fittings as shown in the illustration.

Attach the other end of the interface cable to
the interface connector of the computer. Se-
cure the cable.

Important
❒ Rating voltage of the parallel interface connector

for the computer ; Max. DC5V.

SETTING UP FOR PRINTING
Printing requires installation of a printer driver
for the operating system.

Reference
❒ See “Printer Drivers for This Printer” in the

Setup Guide.

❒ If you want to install options, see “Installing
Options” in the Setup Guide.
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